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If you are new to Photoshop Elements, cataloguing your photos and digitally manipulating them may seem like a whole new world you have to conquer. Do not worry though, we will guide you through the basics and get you started on your way to becoming a skilled user of the software. We hope to have you importing, tagging, organising and editing your photos like a pro in no time at all. With that in mind, let's begin the journey and get you more familiar with how it all works. 
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STARTING WITH PHOTOSHOP ELEMENTS

What is Photoshop 

Elements? 

Let's take a moment to get to know a little more about the software and how it can help you with your day to day image editing. 

Adobe Photoshop Elements is a 

great option for those who want 

an extensive toolset that can take 

on most of their image editing needs, 

without the requirement of highly 

advanced features such as you would 

find in Photoshop CC. It is also a great 

choice for those who only need one-

click solutions to their image editing 

needs, or perhaps want to start to 

learn how to take on the more involved 

techniques and tools that Elements has 

to offer. Another big plus point in its 

favour is that it is one of the very few 

remaining Adobe products that can be 

purchased outright, without the need 

for subscription. 

There was a time when, in certain 

quarters, Elements was considered a 

dumbed-down version of Photoshop 

with a limited toolset, that was 

only meant for beginners with no 

aspirations to advance to the more 

technically advanced techniques seen 

in Photoshop. However, recent versions 

of Elements have shown that it is a 

worthy standalone alternative to using 

Photoshop. It is a focused image editor 

and cataloging application that is more 

than capable of taking on any image 

editing task you care to send its way. 

In its current form, Adobe Photoshop 

Elements is comprised of two main 

components. One is the image editing 

module of the software where you 

can touch up your photos or even 

manipulate and transform them beyond 

recognition. The Edit section is broken 

down into three sections. The first is 

the Quick Edit mode, then comes the 

Guided Mode section and finally there is 

the Expert mode. 

Each module has its own set of tools 

and preset options that can quickly get 

the job done. Quick Edit, as the name 

suggests, contains the basic editing 

8
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WHAT IS PHOTOSHOP ELEMENTS? 

The Adobe Photoshop Elements and Organiser interfaces are designed to be as intuitive as possible with plenty of options for beginners and experienced users alike. 

tools such as colour correction, cropping, 

quick selection, spot healing, sharpening and lighting fixes. You can also apply some one-click presets such as Smart Fix, Exposure  

and Lighting. 

The Guided module is also fairly self-

explanatory. Here you can make any number 

of popular image adjustments to your 

photos, with guided step-by-step tutorials, 

such as altering brightness and contrast, 

resizing photos, rotating and straightening 

your images and adding vignettes. It also 

has a number of specialised and fun options 

for restoring old photos, creating your own 

frames and replacing backgrounds. 

Finally comes the Expert mode. This has 

more of the feel of its big brother, Photoshop to it. It has a toolbar ranged down the left 

hand side of the workspace and on the right 

is the layers panel that behaves much in the 

same way as Photoshop's layers palette. Here 

you also have access to a number of photo 

colour presets such as Faded Photo, Glow 

and Monotone Color. There are also a number 

of filters for more artistic effects such as 

coloured pencils, watercolours, distortion 

effects and sketch filters. You can also add 

Bevels, Patterns, Strokes, Photographic 

Effects and much more by accessing the 

icons in the lower right of the taskbar at the bottom of your workspace. Expert mode 

is the most hands-on of the three modes 

you can employ and gives you access to 

all the tools, so you can apply all your own 

advanced edits to your photos. 

The second main component of the latest 

Adobe Photoshop Elements is the Elements 

2019 Organiser. At its heart, this is a 

cataloguing and photo organising program 

it detects a similar name being entered 

editing tools that will keep beginner and 

that lets you import, sort, tag and rate your as a tag, it will display those existing 

expert happy. 

photos. If you wish, you can create albums 

names similar enough as a match to be 

Over the page we'll begin to delve 

and use names, locations, date, time and GPS 

an option for tagging. 

deeper into the workspaces offered by 

data to sort them. The program can even 

The two components of Photoshop 

the Editor and Elements Organiser. It is 

employ face recognition to find and sort 

Elements and Elements Organiser 

best to consider the Editor module as your 

photos of people and tag them much as you 

are separate programs, which can be 

digital darkroom and design studio and to 

would in Facebook. Indeed, you can actually 

a bit of nuisance if you need to keep 

think of Elements Organiser as your library, 

import your list of Facebook friends as an 

switching between them but you have 

where you keep all your media items such 

aid to tagging the people in your photos. If 

at your disposal a set of powerful 

as photos and videos. 

9
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STARTING WITH PHOTOSHOP ELEMENTS

The Elements 

Home Screen

We start the journey by becoming more familiar with all the module environments you will be working with. 

1

When you open Adobe Photoshop 

Elements, you are presented with a 

Home screen. This simple screen is your 

gateway to the Photo Editor program or 

the Organiser. The third option available 

is to activate the Adobe Premiere 

Elements Video Editor, if you have 

purchased that as well. If not, it will ask 

if you want to download a trial version. 

You also have the option at the 

top of the Home screen to search for 

2

help on things you want to achieve in 

the programs or to click on any of the 

featured Try This guides and What's New 

items and Inspiration articles ranged 

across the screen. 

On the extreme top right of the page 

are buttons for Facebook and Twitter 

and a Help button that takes you to 

Adobe Customer Support. 

3

1

From the home page you can can search 

for things you need to learn more about. 

If you want to learn how to make a 

calendar for instance, type that in the 

search bar and it will show you links to 

help files that can tell you more. 

2

Ranged along the top of the home page 

are a number of clickable guides and 

inspirational media that gets you into the 

4

heart of what Photoshop Elements 2019 

is all about. There are several themes 

you can access. Try This are guided 

tutorials that help you create exciting 

media and art. What's New highlights all 

the step-by-step features that are new 

to this version. Inspiration is a collection 

of stories and articles to get you in a 

creative mood. 

10
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THE ELEMENTS HOME SCREEN

3

5

7

When you open the home page for the 

To the right of the home page are the 

Click this button to go to the Adobe 

first time, you will be prompted to add 

icons for Organiser, Photo Editor and 

Photoshop Elements Facebook page. 

media for Auto Creations to make a 

Video Editor. You can click on these to 

series of personalised creations, such as 

activate the relevant program. If you do 

8

slide shows that use your own photos 

not have the Adobe Premiere Elements 

and videos. 

video editor program for instance, it will 

When you click this button, it will take 

ask you if you want to try if for free with 

you to the Photoshop Elements Twitter 

the option to purchase later if you wish. 

feed where you can view, reply to, 

4

retweet and like tweets. 

Auto Creations are created with media 

6

(photos or videos) that you've imported. 

9

If you haven't imported any media yet, 

Any images you have been working on 

click Add media under Auto Creations on 

recently will be displayed here for quick 

If you need further assistance, you can 

the Home screen and relaunch the app. 

access. Click on the image you want 

click this button to be directed to the 

You can open and edit any Auto Creation 

to continue working on and it will be 

Adobe Customer Support webpage. 

and instantly share it with your family 

opened within the relevant program. 

and friends. 

7

8

9

For those who are in need of more guidance, or just some creative inspiration, go ahead and click on any of the featured guides and articles to explore more of the online world of features Adobe Photoshop Elements has to offer. 

5

6
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STARTING WITH PHOTOSHOP ELEMENTS

The Quick

Mode Workspace

For fast and simple edits, this is the mode to get you editing quickly, with one-click results for better photos. 

1

3

Although this mode is designed to 

2

be quick and simple to use, it is still a 

powerful method to rapidly improve 

7

your photos with easy one-click  

presets that give you instant feedback 

on how your image will look with the 

new adjustments applied. There are 

many filters to choose from and many 

ways you can adjust your image to  

4

make it perfect, so you can share it  

with the world. 

1

8

Although a number of file menu option 

will not be accessible, the main ones 

that you need will be available. All the 

Enhance options are there as well as the 

Filter Gallery presets. 

2

Here can you can exit the current mode 

and choose to enter the Guided or 

Expert modes. 

3

This is a simple button to specify a new 

project to work on. Click it to create a 

new document at the size you want. 

When you click OK, the document will be 

created and can be worked on in either 

Quick mode or Expert mode. 

4

The Quick mode toolbar has a core set 

of tools to get your image looking great 

with minimal effort. You can make quick 

selections to specific areas of the photo, 

5

crop it, straighten the horizon, whiten 

teeth and fix eyes as well as adding text 

and a number of varied filters, textures 

and adjustments. 

6

12
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THE QUICK MODE WORKSPACE

redo any steps you have performed on 

different view option, as two images that 

5

your image. You also have the option 

represent the before and after state of 

For every tool you activate in the toolbar, 

to rotate the image and activate the 

the photo. 

you have another panel called the Tool 

Elements Organiser if you need to. 

Options bar that gives you many more 

9

choices as to how that tool can be 

7

modified and controlled. There are also 

This slider lets you quickly zoom your 

additional tools that can be accessed in 

Clicking on this button reveals the View 

image from 1% all the way up to 3200%. 

the Tool Options bar. 

options. This is useful if you want to 

compare a before and after view of your 

10

currently active image, to see how much 

6

the image has changed from its original 

These two dropdown menus display 

The taskbar is situated at the bottom 

untouched state. 

options for creating slide shows, photo 

of the workspace and contains all the 

books, greetings cards, calendars, 

most frequently used actions, which are 

Facebook Covers and much more. You 

8

displayed as buttons. Click each one 

can also share your works of art on 

and you can see all the images you are 

The image you are working on is 

Facebook, Flickr and Twitter. 

working on at that time, display or hide 

displayed in this area. It will either be as 

the Toolbar Options bar and Undo or 

a single image or, if you have chosen a 

11

This panel changes content depending 

10

on what adjustment or effect you are 

using. If you are using the Adjustment 

tools, then they will be displayed in 

the right hand panel bar. Items such as 

9

Smart Fix, Exposure, Lighting and Colour 

will be available here and each can be 

clicked to reveal its available options. The 

Effects menu, Textures and Frames are 

also available to be accessed here. 

Don't forget to check out the Create and Share options. Whether you want to share your creation online and on social media or make prints of your photos or even calendars, click the buttons to explore further. 

11

13
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STARTING WITH PHOTOSHOP ELEMENTS

The Guided

Mode Workspace

This mode is great for accomplishing a variety of effects, with a handy guide for each one you use. 

1

4

6

Here can you can select which effect you 

This section has a number of effects 

More specialised image manipulation 

want to apply to your image. There are 

centred around monochrome. Black and 

effects are kept in this section of the 

six categories of effects to choose from. 

White, B&W Colour Pop, B&W Selection, Guided edit workspace. It contains 

High Key, Line Drawing and Low Key. 

Replace Background, Depth Of 

2

Field, Frame Creator, Orton Effect, 

5

Perfect Portrait, Recompose, Replace 

Contains the Basic effects Brightness 

Background, Restore Old Photo, 

and Contrast, Correct Skin Tone, Crop 

You can find a lot more creative edits 

Scratches And Blemishes, Text 

Photo, Levels, Lighten and Darken, Resize 

under this category. You have some 

and Border Overlay, Tilt-shift and 

Your Photo, Rotate and Straighten, 

diverse effects to try out such as Double 

Watercolour Effect. 

Sharpen and Vignette Effect. 

Exposure, Effects Collage, Meme Maker, 

Multi-photo Text, Old Fashioned Photo, 

7

Out of Bounds, Painterly, Partial Sketch, 

3

Photo Text, Picture Stack, Pop Art, 

The Photomerge section mainly 

This category contains Enhance Colour, 

Puzzle Effect, Reflection, Shape Overlay 

concentrates on blending two or more 

Lomo Camera Effect, Remove Colour 

Effect, Speed Effect, Speed Pan and 

photos or extracting and merging 

Cast and Saturated Film Effect. 

Zoom Burst Effect. 

subjects from one shot into another. 

1

2

3

4

5

6

7
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THE GUIDED MODE WORKSPACE

There's Photomerge Compose, 

12

18

Photomerge Exposure, Photomerge 

Faces, Photomerge Group Shot, 

Where appropriate, this menu button 

Once you have clicked Next, you can 

Photomerge Scene Cleaner and 

displays options on how to view 

choose to save your image or save it 

Photomerge Panorama. 

any currently active images that are 

under a new name and/or image format. 

contained in your Photo Bin. 

You can also elect to continue working 

on the image in either Expert or Quick 

8

mode. You can also choose Share to 

13

If you choose to select a new image from 

upload it to Facebook, Twitter or Flickr. 

the Open menu during a guided edit, you 

The taskbar is situated at the bottom of 

will be asked if you want to discard the 

the workspace and contains all the most 

19

current guide, in order to start a new one 

frequently used actions. 

with the image you are about to open. 

Simply returns you to the Guided 

category page. If you look in your 

14

Photo Bin, your image will have a small 

9

This is where the image you are working 

brush icon in its top right corner, which 

Click the Zoom Tool icon or press Z to 

on will be displayed. 

indicates it has edits applied. If you close 

activate the zoom tool. You can magnify 

the image and haven't saved it, you will 

the image up to 3200%. Wherever you 

be prompted to do so if you wish. 

15

click with the mouse, the image will be 

magnified and the point you clicked will 

This slider lets you quickly zoom your 

be placed in the centre of the workspace. 

image from 1% all the way up to 3200%. 

Press the Alt key on your keyboard to 

decrease the magnification factor. 

16

Whichever effect you choose to apply 

10

to your image, the steps required to 

Click the Hand Tool icon or press H to 

complete it are displayed as numbered 

18

be able to move your magnified image 

steps in the guidance panel on the 

around. With the Hand Tool active, click 

right of the active image area. You can 

and drag your photo to move it around 

follow the steps, clicking the appropriate 

within the active image area. 

buttons and altering parameters until 

you are ready to commit the changes. 

11

17

Clicking on this button reveals the View 

options. This is useful if you want to 

Click Next to commit the changes of the 

19

compare a before and after view of your 

guided edit you have just applied or click 

currently active image, to see how much 

Cancel to cancel the edit entirely and 

the image has changed. 

begin again. 

15

11

8

11

16

9

10

12

17

13

15
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STARTING WITH PHOTOSHOP ELEMENTS

The Expert

Mode Workspace

For those who have developed their skills to the point where they are comfortable getting more hands-on with their images. 

1

1

2

Most of the File menu options will be 

4

made available to you in this particular 

workspace, since all the tools and 

effects parameters are there to be used 

manually with little or no guidance from 

the program. 

2

Common to each workspace, click on 

the Open button to view any recently 

3

active images you have been working on 

or to create a new blank file ready to be 

worked on. 

3

This panel contains all the essential tools 

you are going to need for powerful and 

5

flexible image editing. It is broken down 

into View, Enhance, Draw, Modify and 

Colour sections. 

4

Each image that is open will be marked 

by a document tab to identify each 

image. It will display the filename of the 

photos currently open. 

5

This displays the current image you are 

working on. 

6

You can choose what information about 

your active document is displayed here. 

7

6

This panel is context sensitive and 

displays additional options and controls 

for each tool that you select from the 

tool panel. 

7

13

8

9

10 11 12

16
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THE EXPERT MODE WORKSPACE

8

11

14

The Photo Bin panel displays thumbnails 

If you have a number of documents 

One of the key aspects of more 

of all open photos currently being used 

open at one time, you can choose from a 

advanced image editing is to be able to 

by the program. 

number of layout options to display them 

work across multiple layers within your 

all at once within your active image area. 

active document. 

9

12

15

Clicking the Undo button allows you to 

step back through any actions you have 

Clicking on this button will open up the 

This will display all the effects options 

performed on your image. Redo allows 

Elements Organiser program where you 

currently installed. They range from 

you to step forward. 

can view and select images that you 

rubber stamp effects to pencil sketch 

have imported and catalogued. 

effects and colour tints, which can all be 

applied to your photos. 

10

13

Allows you to rotate your image in 45° 

16

steps either clockwise or anticlockwise. 

Click this button if you want to return to 

the Home screen. 

Ranging from artistic effects to brush 

strokes and distortion and pixelation 

options, clicking the Effects icon will 

display all the creative effects available 

to be applied to the image. 

20

17

There are a number of colour, texture 

and special effects that can be applied 

to any subject that is currently on a layer. 

They range from fibreglass textures to 

fire, chrome, bevelled edges and tints. 

21

18

These are background graphics that can 

be downloaded and used as backdrops 

in your compositions. 

19

A pop up menu where you can open 

more currently hidden panels. 

20

This panel allows you to add new layers, 

22

group selected layers, adjustment layers 

and masks. 

21

This is where layers are viewed and 

consists of the base background layer 

and any subsequent layer copies, brand 

new layers or layer adjustments. 

22

For each layer adjustment you add, you 

have the corresponding properties panel 

to control its effect. 

When you click on any of the Layers, Effects, Filters Styles and Graphics buttons, the main panel on the right of the screen will display the 14 15

corresponding panel for each one you choose. Our 16 17 18 19

example is currently displaying the Layers Panel. 

17
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STARTING WITH PHOTOSHOP ELEMENTS

The Expert 

Mode Toolbar

All the main editing tools you need in Expert mode are accessible from the toolbar on the left of the workspace. 

If you've used older versions of Elements 

or Photoshop, the main components 

of the toolbar will be familiar to you. 

There have been updates and additions 

to the tools available but most will be 

recognisable for what they are and you 

should be able to get to grips with the 

newest ones without too much issue. 

Although each tool has additional options 

displayed down in the Tools Options 

Panel, if you hold the Alt key and click on 

When you click on any of the Layers, Effects, a toolbar icon, you can cycle though all 

Filters, Styles and Graphics buttons, the main variants of that particular tool to get to 

panel on the right of the screen will display the one you want. Here is a breakdown ŏ

the corresponding panel for each one you 

of the toolset available in Adobe 

choose. Our example is currently displaying 

Photoshop Elements. 

the Layers Panel. 

The Tool Options bar 

appears at the bottom of the 

Photoshop Elements window 

and it displays the options for 

any selected tool in Expert and 

Quick mode

1  

Active Tool

The currently active tool is 

highlighted. 

2   Related Tools

Any related tools associated 

with the main tool, selected 

from the toolbar, will be 

displayed here. 

3   Additional Options

3

1

2

For any tool that you have 

selected and have active, there 

are a number of additional 

options that let you control 

various parameters relating to 

that particular tool. 

18

[image: Image 19]

THE EXPERT MODE TOOLBAR

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27

28

29

30

31

32

33

34

35

36

37

38

39

40

41

42

43

44

45

46

47

48

49

50

51

52

53

54

55

56

57

58

use targeted contrast effects on your 

39  Ellipse Shape (U)

photos and much more. 

40  Polygon Shape (U)

The tools found in the View Tools section 

41  Star Shape (U)

of the toolbar are designed for basic 

14 Eye 

(Y)

42  Line Shape (U)

magnification: zooming in and out of 

15  Spot Healing Brush (J)

43  Shape Select (U)

your photo and moving it around the 

16  Healing Brush (J)

44  Horizontal Type (T)

screen to view a portion of the zoomed 

17  Smart Brush (F)

45  Vertical Type (T)

image at your chosen magnification. 

18  Detailed Smart Brush (F)

46  Horizontal Type Mask (T)

19  Clone Stamp (S)

47  Vertical Type Mask (T)

1 Zoom 

(Z)

20  Pattern Stamp (S)

48  Text on Selection (T)

2 Hand 

(H)

21 Blur 

(R)

49  Text on Shape (T)

22 Sharpen 

(R)

50  Text on Path (T)

23 Smudge 

(R)

51 Pencil 

(N)

24 Sponge (R)

This section covers all the tools that 

25 Dodge 

(R)

allow you to select all or parts of your 

26 Burn (R)

image for targeted editing, cutting out or 

This set of tools is primarily concerned 

duplication to new layers. 

with how you can affect the crop and 

intelligently move items in the frame for 

3 Move 

(V)

The Draw section of the toolbar contains 

different compositions. 

4 

Rectangular Marquee (V)

various elements that let you paint, draw, 

5 

Elliptical Marquee (V)

erase and sample colours in your photos. 

52 Crop 

(C)

6 Lasso 

(L)

The text tools are also in this section. 

53  Cookie Cutter (C)

7 

Polygon Lasso (L)

54  Perspective Crop (C)

8 

Magnetic Lasso (L)

27 Brush 

(B)

55 Recompose 

(W)

9 

Quick Selection (A)

28  Impressionist Brush (B)

56  Content-Aware Move (Q)

10  Selection Brush (A)

29  Colour Replacement Brush (B)

57 Straighten 

(P)

11  Magic Wand (A)

30 Eraser (E)

12  Refined Selection (A)

31  Magic Eraser (E)

13  Auto Selection (A)

32  Background Eraser (E)

33  Paint Bucket (K)

Here you can set your foreground and 

34 Gradient (G)

background colours, swap them over if 

35  Eyedropper/Color Picker (I)

required, access the colour picker and 

The set of tools found in this section of 

36  Custom Shape (U)

set back to default as required. 

the toolbar are for enhancing the image. 

37  Rectangle Shape (U)

You can heal, clone, blur, sharpen and 

38  Rounded Rectangle Shape (U)

58 Colour 

Tools
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STARTING WITH PHOTOSHOP ELEMENTS

The File 

Menu Layout

Get yourself familiar with the file menu system and you will see just how powerful the program can be. 

Adobe Photoshop 

Elements has many one-

click solutions to make 

your photos look their best 

but over time you may find the 

need to dig deeper into the 

more advanced options that are 

on offer with the Photo Editor. 

Many options are presented in 

the taskbar at the bottom and 

the panel bar on the right. If 

you need them however, the 

File Menu is where you can find 

all the vital tools. 

From this menu you can see 

One of the key menus you 

In many ways, Edit is quite 

Here you can make many 

the About screen and manage 

access at the start and end of 

similar to the options available 

changes to your photos. You 

any Plug-ins as well as update 

a session. You can create new 

on a word processor. You can 

have various rotation and 

your Preferences and quit 

documents, open existing ones 

copy, paste, delete or merge 

transformation options along 

Photoshop Elements. You can 

and save them. You can also 

images. You can also fill 

with cropping and resizing. You 

also view any legal notices or 

import or print your documents 

selections, alter colour settings 

can also convert the colour 

hide the workspace. 

and create contact sheets. 

and undo actions. 

mode or profile of the image. 
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THE FILE MENU LAYOUT

Many of the main adjustment 

A vital aspect of image 

Every time you make a 

This menu has all the creative 

options are found here. They 

manipulation is the ability to 

selection of all or part of your 

and fun filters that can add 

range from contrast, brightness 

add layers of effects to your 

image, you can modify its 

new life to your photos. Add 

tone, sharpness and colour. You 

image. Here you can add new 

properties here. You can feather 

blur, sharpening, distortion 

can also access the Open Closed  layers, fill layers and adjustment the edges, expand or contract 

and artistic effects at the 

Eyes feature and much more. 

layers for non-destructive edits. 

it, invert it and save it. 

click of a button. 

When you explore the file menus on 

offer in Adobe Photoshop Elements, 

each menu and sub-menu will 

always display the keyboard short 

cut next to the action or tool. To 

speed up your work flow, it's always 

a good idea to become familiar with 

those short cuts. 

Some of the basic zoom in 

This menu lets you control 

Should you need it, you can 

and zoom out options are 

the visibility of certain tools 

enter search parameters for 

kept here including being able 

and panels and turn them on 

any issues you encounter. There 

to view the print size of your 

and off as needed. The major 

are also a number of options 

image or turn the visibility of 

adjustment panels, including 

presented to you that can help 

rulers, grids and selections on 

Effects, Layers and Filters, can 

you in certain situations should 

and off. 

be controlled here. 

they arise. 
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STARTING WITH PHOTOSHOP ELEMENTS

Guided Mode 

Categories

Here is a quick reference sheet of all the current guided tutorials available in Adobe Photoshop Elements. 

At the time of writing, there are 

currently 53 guided edits available in 

Adobe Photoshop Elements. 

Just as the name 

They can be accessed from 

suggests, the Guided 

the Guided workspace 

mode is designed to help 

page and are 

you produce a number 

distributed under 

of creative and artistic 

six categories. 

effects by taking you 

Each one 

through the process in 

has a small 

numbered steps. It is 

before and 

a semi-automatic edit 

after slider 

where you click various 

that gives you a 

available options and 

quick overview of 

Elements does the 

what each effect is 

rest for you. 

designed to achieve. 
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GUIDED MODE CATEGORIES

Brightness and Contrast

Correct Skin Tone

This lets you adjust the brightness of your photo and 1

Your photos may suffer from a colour cast that can make 2

control how much contrast is present. You can view the your human subject's skin look a little off in terms of after image only or view both the before and after images either its colour tone. This guided edit can alter the tan, blush and vertically or horizontally. 

lightness of skin. 

Crop Photo

Levels

A crop box will be drawn on your photo so you can resize 3

This uses a levels adjustment whereby you can alter the 4

that box to whatever size and proportion you like. You can shadows, highlights and middle tones brightness of your restrict it to certain proportions and change the overlay to Grid selected image. Any adjustments are made globally across the or Rule of Thirds. 

entire image. 

Lighten and Darken

Resize Your Photo

The Lighten and Darken option can be viewed as a more 5

You can output for web and print and will be presented 6

simplified version of the Levels adjustment option. You with a couple of options that control the final size of your are given three sliders that affect the brightness of Shadows, image. You can specify width and height pixel dimensions and Midtones and Highlights. 

apply the result. 
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STARTING WITH PHOTOSHOP ELEMENTS

Rotate and Straighten

Sharpen Photo

You have the options to rotate your photo clockwise and 7

You can use an Auto Fix sharpening effect or you can use 8

anticlockwise and if you have a sloping image, you can use the supplied slider to manually increase the amount of the Straighten Tool to bring it back to level. 

sharpening until you have it how you want it. 

Vignette Effect

Enhance Colours

This lets you add a soft dark or light border to your image. 

9

You have an Auto Fix option to make a best-guess at 10

You can control its intensity and use sliders to change the the correct colour balance and contrast in the photo. 

softness of the vignette and its roundness. 

Otherwise, you can use the Hue, Saturation and Lightness sliders to fine tune it. 

Lomo Camera Effect

Remove a Colour cast

This replicates the effect of the popular and cheap cameras 11

A colour cast is an unwanted bias towards a tone that 12

that create a very specific look due to their low quality spoils the look of your photo. You can use the colour picker manufacture. You can also add a vignette to the photo. 

to find an area of pure grey, white or black to remove the cast. 
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GUIDED MODE CATEGORIES

Saturated Film Effect

Black and White

Applying this effect makes your photo look as though 13

This is a quick black and white conversion with four 14

it was shot on old slide film for a much more saturated presets ranging from light to dark. If you want, you can look. You can add the effect a number of times to increase the add a diffuse glow to the image for a dreamy effect or increase intensity of the effect. 

the contrast. 

B&W Colour Pop

B&W Selection

Select a preset colour or use the colour picker to keep one 15

You can use a selection brush to selectively pick out 16

colour and turn the rest of the image to black and white. 

the areas you want converted to black and white whilst You can refine the effect and also increase the saturation of the retaining colour elsewhere. You also have the option to invert the remaining colour. 

effect if required. 

High Key

Line Drawing

High key images are characterised by their very bright 17

This effect mimics the look of a pencil drawing. Click to 18

appearance with very little shadow detail left in the photo. 

convert the photo into a pencil sketch and if you want to, You can use a colour or black and white high key effect. 

you can add a small amount of colour back into the image and darken the lines. 
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STARTING WITH PHOTOSHOP ELEMENTS

Low Key

Double Exposure

Works in the opposite manner to a high key image. It is 19

You can combine and blend two images together for a 20

characterised by small amounts of highlight detail and is more creative effect. You can use a preset image or one dominated by darker tones. You have the colour and black and of your own photos and superimpose it over the subject in your white options. 

main composition. 

Effects Collage

Meme Maker

With this effect, your chosen image is split into a number of 21

Great for creating memes for social media. This tool guides 22

sections chosen by you and then a number of effect styles you by letting you create a meme template, edit your text are added to each section of the collage. 

and resize the main subject's photo. You can apply new borders and add effects for a memorable look. 

Multi-Photo Text

Old Fashioned Photo

You can create visual text using this guide, placing a 23

Converts your photo using one of three black and white 24

different photo inside each letter. Add your text and then presets; also lets you adjust the tone of the conversion and one by one, you can place a photo inside each letter. You can the tint colour of the image to create an old fashioned photo. 

also add a new background and add effects to the text. 
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GUIDED MODE CATEGORIES

Out of Bounds

Painterly

This effect can take your primary subject and make it look 25

Turn your photo into a painting with this artistic effect. It 26

like it is escaping from the frame of the photo. You can add provides you with a number of preset brushes to paint onto a frame and then select the area of the shot you want to extend your photo. Choose a canvas colour and texture and then add an outside the frame and add a shadow for more depth. 

optional effect to enhance the painterly feel. 

Partial Sketch

Photo Text

This gives you a choice of effects that you can apply to 27

Use your photo as the basis of creating some creative text 28

your photo. Then you can simply paint using a brush over effects. Choose your font and how you would like it to your image where you want the chosen effect to appear. You appear on your photo, then select the background style. You can can work with more detail if required and change the size and also choose the intensity of bevel drop shadow and outline of opacity of the brush you use. 

your text. 

Picture Stack

Create Pop Art

Turn your photo into a collage with the Picture Stack 29

Go psychedelic and turn your photo into some fun pop art. 

30

effect. Choose the number of pictures you want your photo Choose from the styles available and then convert it into divided into and then add a border to each element. Then you a monochrome or posterised version. You can also add a neon can add a solid or gradient background for the finishing touch. 

glow if you wish, or tint it a single colour. 
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STARTING WITH PHOTOSHOP ELEMENTS

Puzzle Effect

Create Reflections

Your photo can be turned into a jigsaw puzzle with this 31

Add reflections to your photos for eye catching results. 

32

effect. Choose the puzzle piece size you want to use. 

Simply add the reflection and then use the tools provided Extract pieces for a more creative effect and arrange them by to colour the reflection, fill the background and then make the moving them to another part of the design and rotate the pieces reflection look more like glass or water. 

if needed. 

Shape Overlay Effect

Speed Effect

Choose from a series of different shapes and then position 33

Add some great blurred speed lines for a little more zoom 34

it over your photo and scale it to the required size. Then in your photos. Use a selection tool and choose an area of you can add an effect to both the inside and outside of the your image to apply the effect to. Then you can add the speed shape's area, before cropping it to your preferred proportions. 

effect and then precisely refine the look of your finished effect. 

Speed Pan

Zoom Burst Effect

Add motion blur to your backgrounds to give the 35

This mimics the effect of rapidly zooming your camera lens 36

impression of fast motion. Select your main subject using while you take the photo. You can crop your photo in order the selection tools and then add motion blur to the background, to put your primary subject in the centre of the shot and then keeping your main subject sharp. 

add the zoom burst effect. Refine the area of focus and add an optional vignette. 
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GUIDED MODE CATEGORIES

Depth of Field

Frame Creator

You can make your subject stand out in the photo by making 37

Use your own photos and graphics to create frame designs. 

38

the distracting background blurred as if photographed with Use the tools to select the areas you want to be your frame very shallow depth of field. You can add simple blur or use more and then save that frame design so you can work on it further in precise selections for more targeted effects. 

Expert mode. 

Create Orton Effect

Perfect Portrait

Based on an old slide film technique pioneered by Michael 39

For great looking skin in your portrait photos use these 40

Orton, you can add a soft and dream-like quality to your tools to heal blemishes in skin, remove red eye and whiten photos. Apply the Orton effect as many times as you wish and teeth. For a glamorous look to your shots, you can also add a then use the sliders to enhance the effect even further. 

glow effect and even slim your subjects down if required. 

Recompose

Replace Background

This works much in the same way as Photoshop's content-41

With this set of tools, you can select your primary subject 42

aware scale tool. This tool lets you scale an image but using one of a number of selection tools and then remove maintain the important content and detail in the photo. You also their background. Select a new background or texture and have the option to mask areas for greater control. 

then place it behind the original to match the colour tones for a convincing result. 
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STARTING WITH PHOTOSHOP ELEMENTS

Restore Old Photo

Scratches and Blemishes

If you have a number of old scanned photos that have many 43

For any small blemishes and flaws in a photo, use this tool 44

blemishes on them, then this tool can make them look new to quickly fix those troublesome areas with the spot healing again. Using healing tools, blur tools and clone stamp copies, you brushes. Larger areas will benefit from the application of the can improve those old photos with ease. 

healing brush. 

Text and Border Overlay

Tilt-shift

Choose from a selection of border designs to frame your 45

Turn your images into miniature effect photos using this 46

favourite photos. Choose its size and colour and then add specialised blur tool. It works best on photos taken from a text overlay using the type tool. You can then specify the text's above your subject and from a distance. It mimics the effect of position and edit the text style used. 

expensive tilt-shift lenses. Modify the focus area and add blur, contrast and saturation. 

Watercolour Effect

Photomerge Compose

A simple and effective way to turn your favourite photos 47

This allows you to select two photos you wish to work on 48

into watercolour paintings. Choose an effect, add a and extract from one photo and place it on another to watercolour paper overlay and a canvas texture. Then you can combine the two. You have selection tools to help you accurately refine the effect and add captions in various text styles. 

extract your first subject, then you can place it, move and scale it on the second photo. 
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GUIDED MODE CATEGORIES

Photomerge Exposure

Photomerge Faces

This is a form of high dynamic range photography. This tool 49

Combine facial features from two different portrait photos 50

lets you combine two or more different exposures of the for humorous results. Select two faces and open them. You same shot to create a much more exposed version. Use automatic can then use the alignment tool to pick out three distinct areas or manual modes for the final result. 

on each face and then blend them together. 

Photomerge Group Shot

Photomerge Scene Cleaner

Use multiple group shot images to make sure everyone has 51

If you have a series of photos of the same subject but there 52

their eyes open or is looking at the camera. Select two or are distractions in each, you can combine two or more similar group shots taken together. Set one as the final image photos to clean up the scene. Use one base image and blend in and use additional photos to merge preferred elements into the the best parts of additional photos to create a finished result. 

final photo. 

Don't forget to check out the 

inspirational news stories 

and guide information 

available on the Home 

screen. There is plenty 

to pique your interest. 

Photomerge Panorama

Great for creating super-wide panoramic shots. Combine 53 a sequence of several photos that captures a very wide panoramic scene by merging them. Select your photos, choose your panorama layout and type of settings and the program does the rest for you. 
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Most modern digital cameras allow you to shoot in a picture format known as Raw mode. Raw mode is a pure digital readout of the data captured by the sensor. This offers amazing scope when it comes to getting the very best out of your photos. 

Step inside your very own digital darkroom and take control of the final look of your photos. More than that, see how you can integrate Adobe Camera Raw (ACR) and Photoshop Elements for a professional looking workflow solution. 
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USING ADOBE CAMERA RAW

Contents

34 

The Camera Raw Interface

37 

The Profile Browser

34 

In the Raw

38 

Camera Raw Processing

35 Control 

Tabs

43 

Raw to Photo Editor

36 The 

Histogram

46 

Saving to DNG Format
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USING ADOBE CAMERA RAW

The Camera

Raw Interface Part

One

Let's take a look at the ACR interface, see what it has to offer and also how it can integrate with the Elements Photo Editor. 

Adobe Photoshop Elements comes 

with Adobe Camera Raw supplied. It 

1

2

3

4

5

6

7

8

is more usually referred to as ACR 

and lets you process Raw files from 

digital cameras as the first step of 

your digital photo processing 

workflow; but you don't have to stop 

there. You can process your Raw file 

and then continue to work with it in 

the Photo Editor in either the Quick 

or Expert editing modes. It is easy to 

get started. Let's take a look at the 

ACR interface, see what it has to offer, 

and also how it can integrate with the 

Elements Photo Editor to help you get 

more out of your favourite photos. 

1

A standard zoom in and zoom out 

tool that lets you view your image 

at increasing or decreasing levels of 

magnification. Each time you click the 

zoom tool, the image will be enlarged 

to the next level of magnification. 

Wherever you click on your image, 

it will magnify and centre it in the 

workspace using that clicked point. If 

you press Alt on your keyboard, you 

can decrease the level of magnification 

and zoom out. Right-click the image to 

call up the context menu to display all 

the preset zoom levels available. 

2

The Hand Tool allows you to move your 

magnified image around the screen by 

clicking and dragging. 
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THE CAMERA RAW INTERFACE

Crop Tool to drag a crop box over your 

3

6

image and using the control points on 

To help you remove colour cast from 

the box, scale and rotate it to get the 

If you happen to have a photo of a 

you photo, you can use the White 

perfect crop for your photo. Right-click 

family member or friend whose eyes are 

Balance Tool to bring the image back 

on the cropped image to call up the 

coloured red because a camera flash 

to a more neutral colour cast. Click on 

context menu to view more proportional 

illuminated the blood vessels at the back 

the tool and then place the eyedropper 

cropping options and to clear the crop if 

of their eyes causing the red-eye effect, 

cursor over an area of your picture that 

you need to start again. 

you can remove the redness using this 

is either meant to be white, middle grey 

tool. Click and drag a marquee selection 

or solid black. It will use that reference 

over each eye and the program will do 

5

point to neutralise any colour cast. 

the rest. 

Right-click the screen to call up the 

This is particularly useful if you have 

content menu to display all the white 

strong vertical or horizontal elements in 

7

balance presets available to use. 

your photo that need to be levelled so 

they are perfectly vertical or horizontal. 

Opening this dialog box allows you to 

Click the Straighten Tool and then click 

set some Camera Raw Preferences such 

4

and draw a line along the part of your 

as where your image settings are saved 

If you need to crop your image to 

photo that needs to be straightened out. 

and whether you automatically sharpen 

different proportions, you can use the 

all images. You can also set other auto 

functions such as tone adjustments and 

also specify how DNG files are handled. 

8

Lets you rotate your photo clockwise or 

anti-clockwise in 90° increments. 

Continue over the page and we delve into the 

control tabs, colour treatment options and profiles of the Adobe Camera Raw interface. 
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USING ADOBE CAMERA RAW

The Camera

Raw Interface Part

Two

Our journey around the Adobe Camera Raw interface continues with more of the tools to bring the most out of your photos. 

9

Clicking this button lets you toggle the 

full screen mode. When you do, no file 

menus will be visible until you toggle 

full screen off again. 

10

Shadow Clipping is there to warn you if 

any of the darkest tones in your photo 

become solid black. A blue highlight 

will appear to warn you which parts of 

the photo are clipped. 

11

This is a graphical representation of the 

distribution of colour and tonal values 

throughout the image. The amount 

of tones in any given part of the tonal 

range are shown as peaks along the 

length of the histogram. 

12

This works in the same way as the 

Shadow Clipping warning. If any of 

the brightest highlights in the image 

are solid white, or get pushed to solid 

white as a result of editing, they will be 

displayed as red highlights. 

13

The left side of the panel shows the 

RGB values of the image at the cursor 

position. The right side of the panel 

displays the exposure information for 

the image such as aperture, shutter 

speed and ISO. 

19

16

18
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THE CAMERA RAW INTERFACE

Profile menu allows you to choose from 

14

18

a number of preset colour profiles  and 

The ACR interface breaks down the 

a series of artistic, modern and vintage 

Help accesses the Adobe help files for 

workflow process into discreet sections. 

effects too. 

ACR processing, whilst the Save button 

First is the Basic panel where the 

allows you to save your current edits to 

majority of your processing will be 

DNG file format. 

16

done. You can control all the basic 

exposure and colour adjustments 

Instead of using the Zoom Tool, you can 

19

here. The Detail tab reveals sliders 

use the Zoom Level options. 

for controlling Sharpening and Noise 

Choose from 8 Bits/Channel and 16 Bits/

Reduction. The Camera Calibration tab 

Channel colour depth. 

17

lets you specify the calibration process 

you are using. 

The buttons let you cycle through the 

20

available before and after view options, 

swap the before and after settings, copy 

Done Commits all edits and exits without 

15

the current settings to the before image 

opening the file. Cancel quits without 

Gives you the choice of processing your 

and toggle between the current settings 

accepting any changes and Open Image 

photos in the main colour workspace or 

and the default settings. 

will apply changes and open the image 

in the Black and White workspace. The 

in the Photo Editor. 

Click on the Profile Browser button and you can view all the standard and artistic colour presets you can use on your photo to alter its colour. There are a number of camera matching profiles as well as artistic, modern, black and white and vintage. 

9

10

11

12

13

14

15

17

20
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USING ADOBE CAMERA RAW

Camera Raw 

Processing

ACR lets you process Raw files from digital cameras as the first step of your digital photo processing workflow; but you don't have to stop there. You can process your Raw file and then continue to work with it in the Photo Editor, in either the Quick or Expert editing modes. 

BEFORE

AFTER
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CAMERA RAW PROCESSING

To begin, you'll need to open Photoshop Elements and 1

Go to File > Open in Camera Raw (Alt + Cmd + O) to open 2

from the home page click on the Photo Editor icon, this your file browser and navigate to the folder that contains will activate the Photo Editor program. The default is to open in the Raw file you wish to process. Once you have located it, Expert mode. You can access Adobe Camera Raw (ACR) from double-click the file or highlight it and press Open at the bottom either the Quick, Guided or Expert mode workspaces. 

right of the browser window. 

The Raw file, in this case a seascape shot in Cornwall, will 3

A good place to start with a landscape shot like this is 4

open in the ACR workspace, as ACR runs in a separate to ensure a nice level horizon. If yours is sloping, use the window to the Elements Photo Editor. You can use the zoom Straighten Tool (A). Click on one side of your horizon line, then tools to fill the active image area of the workspace; you can drag across to the other side and release the button to bring it clearly see the effect your edits will have on the photo. 

back to level. 
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USING ADOBE CAMERA RAW

Click on the Basic tab to make sure it is the active tab and 5

If you turn on your Highlight clipping warning (O) and your 6

you will see the range of adjustments available; you can use Shadow clipping warning (U), you will be shown any areas these to get the most out of your image. The photo is slightly of your image that are turning solid black or solid white. These underexposed, so a good place to start is to increase the value of areas will suffer a loss of detail so having the warnings turned on the Exposure by moving the slider to the right. 

is useful to avoid degrading the image. 

Now, as you move the slider and increase the exposure, 7

An alternative to viewing the highlight clipping warning is 8

any areas that are becoming too overexposed will now to press and hold the Alt key while moving the Exposure, be highlighted in red. You can often get away with just a slight Highlights and Whites sliders to see just the affected highlight overexposure in your images but beware of pushing it too far and areas without the image itself being seen. It does give you the destroying the image. 

chance to fine tune the exposure without taking it too far. 
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CAMERA RAW PROCESSING

If you are adjusting the Shadows and Blacks sliders, too 9

Holding down the Alt key while making Shadows and 10

much underexposure will be highlighted in blue by the Blacks adjustments, just the darkest areas turning solid Shadows clipping warning. Solid black areas are much like black will be seen to warn you there is a potential Shadows highlighted areas: you can have a small amount of solid black clipping problem. 

areas but beware of heavy underexposure. 

If you want ACR to do some of the heavy lifting for you, 11

Adjustments are a personal thing of course but we opted 12

there is always the option to click the Auto button. When to increase the Exposure, reduce the Highlights to -75, to you do this, the program will attempt a set of best adjustments recapture detail in the lightest parts of the image, and pushed that it thinks will suit the image for optimal exposure. It is Shadows to +55 to make sure detail was kept in the darkest areas certainly a good baseline for you to continue editing. 

of the shot. Whites were also reduced slightly to help keep detail in the brightest parts of the scene. 
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USING ADOBE CAMERA RAW

Next are the three sliders that affect midtone contrast 13

Click on the Detail tab to control Sharpening and Noise 14

and how vivid the colours are. Clarity is a refined version Reduction in your photo. Sharpening is essentially an of global contrast, affecting the middle tones for more detail. 

increase of contrast between the brightest and darkest edges of Vibrance affects muted colours first and Saturation is a more your image. 

general adjustment for much more vibrant colours. 

The Detail and Masking sliders control artefacts caused 15

The Calibration tab is best left at its most current version. 

16

by over-sharpening. The Noise Reduction settings let you For ACR in this form, Version 4 is the most up to date control image noise present in high ISO photos. Beware of very Process that offers the most recently improved tools and high noise reduction settings that can make your photo look functions within ACR. Changing it to older versions will result in muddy and lacking in detail. 

certain improvements not being possible. 

To the far right of the adjustment panels, is a small icon 17

Once you have adjusted the image to your taste, one final 18

comprised of four lines. When you click on this, you can call option is to crop your image. Use the Crop Tool (C) to draw up your image's settings, Save New ACR defaults and reset to a crop box over your image to remove any unwanted area of the the standard default settings. 

photo and create a more pleasing composition. 
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CAMERA RAW PROCESSING

If you are happy with your photo and the edits you've made 19

You also have the option to click Open Image and continue 20

you can simply click the Done button and your adjustments to work on the photo in either of the Quick, Guided or will be saved in what is known as a Sidecar file with an XMP file Expert modes on offer in the Elements Photo Editor. You can extension. This file remembers the edits you've made and applies then save the result as a PSD file or jpeg. We've decided the sky them non-destructively to your Raw file when opened. 

needs to be worked on so we're going to open it. 

The image file will now open in the Elements Photo Editor. 

21

The first thing you need to do is create a new adjustment 22

We're going to work on it in Expert mode because we will layer. Click on the Create New Fill or Adjustment Layer need a few extra adjustments and layers to achieve our goal of icon to expand the dropdown menu and you will see a number making the sky more dramatic. 

of adjustment layer choices. Click on Levels to add a 'Levels 1' 

adjustment layer to the layer stack in the right hand panel. 

The 'Levels 1' layer will appear above your base image 23

When you create an adjustment layer, its properties are 24

which will be on a default locked layer called 'Background'. 

displayed in a panel that will appear when it is added to You will see that it is split into a layer thumbnail and a layer mask the layer stack. In the case of a levels adjustment, there are thumbnail. The layer thumbnail controls the levels properties and three sliders that control brightness of the shadows, middle the layer mask controls masking properties. 

tones and highlights. 
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USING ADOBE CAMERA RAW

Move the middle tone slider from the middle to the right; 25

Once you have the sky looking darker and a bit more 26

as you do so, the whole image will get darker. You can also dramatic, you will see that the rest of the image is too drag the furthest right highlight slider to the left slightly to make dark. What you can do now is use the layer mask to only let the clouds a bit whiter. Concentrate on how the sky is looking the levels adjustment affect the sky and level the rest of the and don't worry about the rest of the image for the moment. 

image unchanged. 

To do this you must first make sure your Foreground 27

Next you need to click on the Gradient Tool (G). When 28

Colour is set to Black. You can click the Switch you do, the Tool Options Panel will display all Gradient Foreground icon or press X on your keyboard to swap the Tool options. Click on the Edit button and make sure you have default foreground and background colours around so black is Foreground to Background set as the gradient. Then make sure now the foreground colour. 

the Linear Gradient button is clicked. 
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CAMERA RAW PROCESSING

Make sure the 'Levels 1' layer mask is clicked to make it 29

When you let go of the mouse, a gradient will be drawn 30

active and then click and drag a line with your gradient tool on the layer mask that fades from black to white along the that starts just below the horizon and ends just above the level of points you clicked with your mouse. Wherever masks are used the lighthouse. 

remember that black conceals and white reveals. 

If you look at your image now, the sky is darker at the top 31

It doesn't have to end there. You can add another Levels 32

and transitions to normal at the horizon and the rest of the Adjustment layer and tweak the overall brightness of the image is untouched. The mask you added only lets the image. You can then go back to the 'Levels 1' adjustment and adjustment you made affect the sky at the top and fades to make the sky even darker by sliding the middle tone tab even zero effect where the layer mask is black. 

further to the right. 

If you are happy with the image, you can go to File > Save 33

Your ACR to Elements workflow example is complete. You 34

As (Shift + Cmd + S) and save your composition as a have processed the original Raw file non-destructively, Photoshop PSD file with the layers and adjustments intact, which opened the resulting processed file in the Elements Photo Editor allows you to return and adjust it still further if you wish. 

and made further targeted edits using adjustment layers. 
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USING ADOBE CAMERA RAW

Saving to

DNG Format

Each digital camera manufacturer has its own custom format for Raw files. 

Canon cameras save their Raw files with a .CR2 file extension, whereas Nikon cameras use their own .NEF files. Not every file format can be read by every piece of software, hence the creation of the DNG open standard format. 

DNG is a publicly available Raw image format, created by 1

To begin the process, you will need to access the raw 2

Adobe as a proprietary image standard. It’s able to store file that needs converting to DNG format. You can open image data in a more generic format that is widely compatible Elements Organiser and search for the required image. When with many photo-processing programs. DNG is also known as you have found it, highlight it, then go down to the taskbar and Digital Negative. 

click on the Editor button. 

The Photo Editor will open, but since this is a Raw file, 3

Alternatively, you can bypass Elements Organiser altogether 4

which cannot be opened directly in the Editor workspace, and just open the Photo Editor directly. At this point, you Camera Raw will be opened automatically on top of the editor can be in any of the three modes: Quick, Guided or Expert. You workspace, with your image ready to be processed and saved in simply need to be able to click on the Open button and navigate the alternate DNG format. 

to your Raw file, or go to File > Open in Camera Raw. 
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SAVING TO DNG FORMAT

Select the file you want to open. In the case of our example, 5

A simple number of adjustments have been made including 6

we have a Raw image shot on a Canon camera with the Exposure, Clarity and Saturation, along with some tweaks 

.CR2 extension. Double-click it to open the file in Camera Raw. At to the Temperature and Tint. When your image looks right, you this point, you can make any adjustments that you require using can go to the bottom left corner of the Camera Raw screen and your preferred methods. 

click on the Save Image button. 

The Save Options panel will open, where there is a 7

If you choose Save in New Location, you can specify, or 8

comprehensive set of options for your Raw to DNG 

create, a new destination folder for the converted file. 

conversion. At the top, you have your Destination options. You Below that, in the File Naming section, you can choose a can choose Save in Same Location to put it in the same place as filename for the converted file by typing text and numerals in the the original Raw file, or Save in New Location. 

File Naming fields. 

Below that, you have the Format options panel. This lets 9

When you click Save, the file will be created. If you now 10

you choose the Compatibility of your file and how readable quit and return to Elements Organiser, it will be added to it is by older versions of Camera Raw and Lightroom. You can your import list, if it is within a watched folder. Now you can also select the size of the Jpeg Preview and whether you wish to activate the DNG file and edit it as you would any other Raw file Embed Original Raw File in the conversion file. 

in your catalog. 
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Elements Organiser is packed with powerful features designed to help you make the most of your photos and videos by organising them and creating albums and catalogues as efficiently as possible. Import and tag your photos with keywords, location data and ratings. Organiser can also auto curate your photos, finding the best ones based on image quality, tags and ratings, so you can quickly find your favourites. Let's look at what Organiser can do for you. 
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GETTING ORGANISED

The Organiser 

Workspace

Before you dive in and start using the Organiser and its tools, it's worth taking a look at the workspace and how its tools are arranged. 

8

Use Elements Organiser to organise and 

2

4

5

share your photos and media files. You 

can view thumbnails of all your favourite 

images and media you’ve imported. You 

3

can view a large thumbnail of a single 

media file or smaller thumbnails of 

many media files. You can fix the most 

common problems in the media files by 

using the tools in the Instant Fix tab of 

1

the Task panel. 

1

The File menu options appear in the 

top left of the menu bar. These are the 

basic methods for interacting with the 

program, managing your catalogues and 

finding, tagging and viewing all of your 

media files. 

2

From the drop-down menu, you can 

choose to import photos from various 

files and folders on your computer, from 

your camera and card reader. Another 

option lets you search your hard drive. 

3

Click the Albums button to view any 

Photo Albums you may have created. 

Click on Folders to display a folder view 

of your files. 

4

Click a Folder name to display just the 

photos within that chosen folder. Click 

the All Media button at the top of the 

media browser window to display all 

images from all folders. 

5

If you are viewing the content of one 

folder, you can click the All Media button 

6

to leave the selected folder and see all 

photos. Next to the All Media button is 

a Sort By drop-down list where you can 

7
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THE ORGANISER WORKSPACE

sort according to Newest, Oldest, Name 

browser, the date range of all media and 

10

and Batches of photos. 

the View Notifications button. 

Click this button to open the Search pane. 

You can enter a search parameter or click 

6

8

on any of the search types listed down the 

The tools arranged on the left at the 

At the top of the Organiser window are 

left hand side of the search panel. 

bottom of the screen represent the 

five clickable tabs. Media displays either 

main tools for tagging and organising 

a folder or the entire catalogue. Click 

11

your photos. You can hide the Folders 

this tab to view photos where you have 

panel, Undo steps, Rotate your images, 

identified faces. Click the Places tab to 

These two buttons reveal drop-down lists 

Add location data, Add an Event, use 

tag an image with a place on the map. 

where you can create slide shows, photo 

the Instant Fix feature, open the Photo 

Finally, you can click the Events tab to 

books, video collages and more. Note 

Editor, create a slideshow or return to the 

display photo tagged as Events. 

that certain creations require Adobe 

Home screen. 

Premiere Elements to be installed for 

video-based tasks. The Share button lets 

9

you email and share your media on social 

7

The contents of your catalogue or a 

media and image sharing sites. 

This small bar displays information such 

single folder will be displayed in the main 

as the number of items in the media 

browser window. 

12

Ratings lets you filter your search by 

10

any star ratings your images have 

been given. Auto Curate automatically 

chooses the best photos for you. You 

11

can specify how many are shortlisted, up 

to 500, and the results are displayed in 

12

the browser window. 

13

When you click the Keyword/Info 

button at the lower right of the 

13

workspace, a panel opens providing 

you with a number of different ways 

to add keywords and tag photos. An 

Information pane is provided where 

information about a selected photo can 

be displayed. 

14

You can adjust this slider to see your 

9

image thumbnails larger or smaller in the 

browser window. 

15

Click this button to open the Panel Bin 

and choose options from the Tags or 

Information panel. 

A media organiser is only as 

good as the tagging and 

keywords associated with 

your images. Spend 

some time tagging 

your images to 

reap the benefits 

when it comes 

to searching 

and retrieving 

them again. 

15

14
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GETTING ORGANISED

Setting Up

Elements Organiser

Elements Organiser gives you complete control over how you import, search, tag, organise and share your photos and videos. Organiser scans your files and analyses your photos and can even find faces ready for you to identify. 

When you open Elements, you are presented with the 1

There is usually a default catalogue created but you have 2

Home Screen. Down in the lower right are the programs the option to use the Catalogue Manager to create a available to use or to try a free trial. Click on Organiser to activate custom location for your catalogues. Click the Custom Location it and follow any on-screen prompts. 

and then Browse to the location where you would like to create your custom catalogue. 

If you are creating a new folder, you can give it a bespoke 3

The Organiser workspace will open and you will see the 4

name and then hit the Create button to make the folder main Media workspace displayed. If you are using it for the into which your catalogue will be placed. Once you have done first time, it will prompt you to start importing images ready to that, you can then give a name to your catalogue. We have called be organised. 

ours 'My Catalog 1'. Click OK to create it. 
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SETTING UP ELEMENTS ORGANISER

There are also screens giving you a brief overview of what 5

Start the process by clicking the Start Importing button 6

each section of the Organiser program can do. The People and Organiser will ask you to add folders from which to section can identify faces for tagging. The Places section can import media and photos from. You can add and subtract as geotag or let you manually add location data to your images and many folders as you wish. Click Add Folder to choose more, and Events groups your images by date and time. 

even customise how much content from each is imported. 

When you click Add Folder, browse to where your folder 7

All the selected media you chose will be imported. If you 8

of images are kept and double-click it to add it to the have chosen a lot of images, you will see a progress bar import list. There is a small icon shaped like binoculars that when listing the items as they are imported. When complete, Organiser highlighted, informs you when new files are added to that folder. 

will display a grid view of your images ready for you to start When you are ready, you can hit the Import button. 

working on. 

Click on the People section and it will start the process of 9

The Events section displays all your photos in chronological 10

scanning your photos looking for faces so you can organise order based on date and time. You can create new events images by people. The Places section will display images ready and stack all images of that event within it. Now that you are for you to add location data; unless they already have GPS data organised, let's find a little more about the workspaces on offer. 

attached, whereby they will be pinned to the map. 
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GETTING ORGANISED

Tagging and 

Keywords

If your photo library is large and scattered across many folders, it would help if they were tagged and had keywords added to make your searches more streamlined and efficient. Rather than trawling through folder after folder, why not tag them with keywords? 

From the Home screen, click on the Elements Organiser 1

We made a folder called 'Places' that contained a number 2

icon to open the Organiser workspace. We worked in of images but only a few of them were relevant to our Folder view with the Media tab clicked and all media currently particular requirement of moorland photos. The first thing we on display. We had some example images of Dartmoor in Devon did was to press the Cmd key and left-click each of the required that we wanted to tag for future reference. 

moorland photos. There were five shots in total. 

Now that the images are selected, you can begin to tag 3

Press enter and the dialog panel will show you possible 4

them. The first and foremost requirement is to add a place locations based on the name you entered. We knew ours tag. In the taskbar, click on the Add Location button. This calls was in the Dartmoor National Park, so clicked on that option up the Add a Location dialogue panel. Our shots were taken at a and then the Apply button to add that location data to the five place called Haytor, so we entered 'Haytor' in the dialogue panel. 

images we had selected. 
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TAGGING AND KEYWORDS

Now if you look over at the Places Tags section in the Tags 5

If you highlight all of the images again, you can add more 6

panel bin, you will see that location data has been added tags to help you identify the photos at a later date. Under as a tag, which may consist of several sub categories. If you click the Image Tags panel, you can add custom keywords; in this the top category, in this case United Kingdom, only the tagged case, the keyword 'Sunrise' was used. Click Add to include the images will now be seen in the browser window. 

new keyword. 

It is added to the Other category but you can click and 7

In the New Category window, you can choose a colour 8

drag to any of the other categories; or click the green plus for your category icon as well as choosing the name you symbol in the top right corner and click on the New Category want the new category to be called, in this case 'Sunlght'. If you option in the drop down menu that appears. When you do, the wish, you can even select an icon from the choices listed in the New Category window opens. 

category Icon window. Then you can click OK to proceed. 

The newly named category is added to the Keywords list. 

9

As you can see, we had tagged the photos with a specific 10

You can drag and drop the its Image Tag into this new Places Tag and also with the new Sunlight category and folder. If you turn off the Places Tags visibility icon and then click Sunrise image tags. These various sets of tags mean that if we on the new category's visibility icon, your images will still be ever need to find a sunrise photo taken on Haytor, we can just displayed in the browser window. 

search for those particular criteria and they will be displayed. 
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GETTING ORGANISED

Putting Names

to Faces

Now that you've tagged a few photos, let's move over to the People workspace. Your library was scanned for all faces present in the photos and then displayed here. Now you can tag these people and literally put names to faces to aid you in your search for friends and family. 

Click on the People tab to open the workspace for tagging 1

The view you are presented with is a thumbnail portrait 2

faces. Just like the main Media view, you can view the of each individual face that has been identified. Below contents of selected folders or click the All People button for a the thumbnail are the words Add Name followed by a number. 

view of every face that has been found in your entire catalogue The number represents how many pictures of that person have of images; this includes those in the UnNamed category. 

been found. 

If you hover your cursor over any given thumbnail, it 3

To name a known person, Ursula Romanovich in this case, 4

displays two options. One shows all the complete photos you can click on Add Name and type in their name. Next to of that person and the other just shows a small thumbnail of the name is a small tick and cross icon. Click the cross to cancel their face without any background context to distract from the inputing the name or click the tick to assign that name to the process of identifying them. 

person. Doing this will move them to the Named category. 
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PUTTING NAMES TO FACES

If some photos of that person have been missed and are 5

Sometimes a photo of a person that is very similar to 6

still available in the UnNamed category, you can click those another may be added by mistake. If that is the case, you thumbnails and click Add Name. If the facial match is close can right-click the offending thumbnail and choose 'Not Ursula enough, the name will be displayed and you can simply click it Romanovich' to remove them from the list. 

and click the tick button to add those images to the list. 

On other occasions, if you name a person and then view 7

As an example of grouping, here are five members of a rock 8

their photos in the Named category, you may be shown band: it would be handy to group the members for easier a series of additional pictures and asked if they are also of that searching later on. To do this, go to the small the green plus person. You can also multi-select those that are not the person symbol in the All People panel to open the Add Group dialog box you want and click the Not This Person in the taskbar. 

for you to create a new group for the members of the band. 

Under Name, you can type the name of the group; we just 9

The new group called 'Rock Band' will appear in the All 10

called it 'Rock band'. The Group it appears in is None since People panel bin. Now you can highlight all five members of we want to create this as a brand new Group category to appear the band and drag their thumbnails into the 'Rock Band' group. If in the All People panel bin. When you're ready, you can click OK 

you click on their group folder, only their faces will be displayed to create the new group. 

since the tag is relevant only to them. 
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GETTING ORGANISED

Tagging Photos 

with Location Data

Tagging places is similar to the way you worked with People. There will be Unpinned modes and Pinned modes for those photos that have had their locations identified. We've already touched on adding Location tags briefly, but now we can explore the Places workspace in more detail. 

Click on the Places tab to view the Places workspace. For 1

If you are using this view, then you can alter the Number Of 2

the moment, you will need to be in the UnPinned category Groups value displayed in the left hand panel.  Moving the and view all the photos that have yet to have any location data slider left and right, increases the numbers of groups on view for added to them. If you click Group By Time, then they will be more detailed scrutiny or reduces the number for a broader view displayed in chronological order. 

of all the photos you are viewing. 

We have opted to tag a specific group of shots taken at a 3

On the right of your Places workspace is the map where 4

location called Hound Tor. These shots are kept in a folder you can view any pinned photos. If you know where you called 'photos', so we have used the folder view to find them. 

are looking on the map, you can zoom directly to that place, We haven't worried about viewing in chronological order in this otherwise you can search for a location by putting a name in the instance. There are four images to tag. 

search pane at the top of the map. 
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TAGGING PHOTOS WITH LOCATION DATA

In the media view panel on the left, press the Cmd key and 5

Sometimes, you may find that the location of the images on 6

multi-select the images for location tagging. Then enter the map is not that precise but it does give you the option your search destination in the Search panel above the map. Press to drag the pin to the correct place. If you are having trouble enter and a list of matches will be displayed. Click the correct identifying the correct area, you can alter the map from Streets one and the selected media will be placed in that location. 

to Satellite for a better view of the land. 

Now you can see the land better, you simply drag the pin 7

You can also navigate directly to a place you know on the 8

the right spot and click the Place 4 Media Here? green map and then highlight the pictures you wish to place tick to confirm placement. You can double-click the pin to view there. Once highlighted, the pictures can then be dragged and the images contained at that location. It will also appear in the dropped directly onto the map at the location you navigated to. 

Pinned category view now as well. 

These will also appear in the Pinned category. 

If you import any pictures that contain GPS data, they 9

If the placement area is too broad, you can edit the location 10

will be automatically replaced on the map in the Places information by clicking on the pinned thumbnail and workspace when the data they contain is analysed. Our inputting more precise location options or dragging the pin to a example of some aerial photos taken on the Devon coast were new location. 

accurately placed. 
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GETTING ORGANISED

Adding Events 

Tags to Photos

Having talked about who was in a photo and where was it taken, it seems only right to mention how you can search for images when you want to know when something was taken. Now you can tag and group them by the type of event it was and when that event happened. 

We have an example folder full of various types of events 1

Much like the People and Places workspaces, the Events 2

such as weddings, parties and sporting events. When workspace has a Suggested category for untagged events viewed in the Events workspace, they are listed by date order to yet to be identified and a Named category where any that are help you find what you are looking for. They are listed with most tagged as an event will finally be displayed. 

recent dates and times first. 

Click the Number Of Groups slider and push it to the far 3

The event we are looking for happened in April - May 2017. 

4

right Max setting. The media browser will display more Now you can use the Calendar panel on the far right to time and date options for you to focus in on. We are looking for open the 2017 calendar and click on either April or May. Clicking a particular sporting event, Autocross, which was photographed on May 2017, reveals the photos from that motorsport event. 

back in 2017. 
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ADDING EVENTS TAGS TO PHOTOS

The photos are spread out across the duration of the entire 5

Now that you have all the photos in once place, you can 6

day but  are all there ready to be tagged. You can use the highlight them by pressing Cmd + A to select all, or by Number Of Groups slider again to break down the view into dragging a section around all the photos with your mouse. They fewer groups or more groups of photos split across that day's will be highlighted in blue with a small tick box in their bottom worth of shooting. 

right corner. 

Down in the taskbar in the bottom centre of your screen 7

Start by giving it a name. We used 'Autocross Event' and 8

is the Add Event button. If you click this it will call up the kept the Start and End dates the same since it all occurred Add Event dialog box where you can begin to add details about on May 13th 2017. Since no other Group names have been the event itself such as Event Name, Start and End Date and a created, Group is kept as None. A short description is also added. 

Description if required. 

Now you can click OK to proceed. 

You will see that all our photos now have a small calendar 9

If you return to the main Media view, you will see that 10

icon in their top right corner to indicate they have an the Events Tags panel now contains the Autocross Event event tag called 'Autocross Event' added to them. If you look tag. If you are viewing all media and click the Autocross Event in the Named category now, you will see that event listed. Click tag to make it visible, only the shots tagged will appear in the on the small information icon to see the description you typed. 

browser window. 
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GETTING ORGANISED

Reviewing and 

Comparing Images

Within Photoshop Elements, you are provided with a couple of options that allow you to quickly and easily review photos in the Organiser. You have the choice of either the Full Screen, or, Side By Side views and can examine images at multiple levels of magnification. 

In Full Screen view, you can inspect your images in detail 1

If you move your Mouse cursor over the full screen image, 2

before making a selection of photos and presenting them the Control bar will reappear. If you look to the left of the as an instant slide show. Click and select a thumbnail image in screen, you will see a couple of grey tabs. If you move your the Media Browser panel and then choose View > Full Screen. 

cursor over these tabs, you can open the Quick Edit and Quick The Media Browser will be replaced by the Full Screen view. 

Organiser panels, again. 

Now, if you move the cursor back to the centre of the 3

One thing to bear in mind is that, if you don't see your Film 4

screen and leave it motionless for a short while, this will be Strip, you can press Cmd + F on your keyboard to make it noticed. After a brief spell of inactivity, the Control bar, the Quick visible. Clicking on the Film Strip icon in the Full Screen view's Edit panel and the Quick Organiser panels will all disappear again Control bar will have the same effect as the keystroke option. 

until you move the cursor to activate them. 
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REVIEWING AND COMPARING IMAGES

The Film Strip positioned below the main image, is there to 5

On the Control bar, you can use the Previous Media and 6

show you all the photos in your Media Browser. If you select Next Media buttons, either side of the main Play button, to multiple images and then enter Full Screen view, the Film Strip shuffle backwards and forwards through the images displayed on will only display the photographs you have selected rather than your filmstrip. Alternatively, you can press the left and right arrow all your images. 

keys on your keyboard. 

If you press the spacebar, you can view your photos in a 7

On the Control bar, you will see the button marked Theme. 

8

Full Screen view slide show. You can also access the Control This gives you several Transition Options to determine how bar and press the Play button to commence the slide show one image fades into another, throughout the slide show. Under presentation. To stop the slide show, you can simply press the Settings, there are a number of Presentation Options including spacebar or click the Pause button on the Control bar. 

Background Music and Include Captions. 

You can also set Page Duration to control how long an 9

Be aware that if you are using 3D Pixelate along with Pan 10

image is visible before it transitions to the next, in the and Zoom as your transitions, pressing the spacebar to presentation. You can also choose to Allow Photos to Resize and stop the slide show will not work. Instead, you can simply press Allow Videos to Resize. For continuous playback, you can select the ESC key on your keyboard to exit out of the presentation. 

Repeat Slide Show. 

Pressing ESC again will exit back to Organiser. 
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GETTING ORGANISED

Comparing Photos 

Side-by-side

Being able to compare your photos and media side-by-side is very useful. 

One image can be kept in a fixed position and scale, on one side of your screen, while on the other side, you can cycle through other images and then compare them for similarity of composition or content. 

Go to Full Screen view by selecting View > Full Screen 1

The view options available to you are quite straightforward. 

2

(Cmd + F11); you will need to access your Film Strip. If it When you click the View icon, a small menu will pop up isn't visible, you can click Cmd + F on your keyboard to make it with the option to either view the images in the Side by Side visible at the bottom of your screen. Bring up the Control bar orientation, or to view them horizontally, with one above the and click on the View icon. 

other across the width of the screen. 

In this example, choose the Side by Side view option. 

3

Any operation you perform on the image, whether it is an 4

Select your primary image from the Film Strip and it will be edit or adding keywords, for example, will only be applied displayed on the left as image 1. The next image in the series will to the image that is currently active. In this case, image 2 will be be marked as image 2. Image 1 will be active by default with a the one that is affected by any changes you make to it. 

blue box around it. You need to click image 2 to make it active. 
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COMPARING PHOTOS SIDE-BY-SIDE

If you click image 1 to make it active again and then select 5

Now make image 2 active, then, if you press your right 6

a new image from your Film Strip, the newly chosen image arrow key, or the Next Media button, you can flip though will become the new image 1. If you wish, you can press the Tab images in your Film Strip and view them as image 2, on the right key on your keyboard to alternate between having image 1, or of the screen. Image 1 will remain fixed until you opt to change it, image 2 as the active image, at any time. 

if required. 

The active image can be viewed at different magnifications 7

If you are viewing two very similar photos and want to 8

by rotating the scroll wheel on your mouse, if you have one. 

be able to compare them very closely, you can choose to Otherwise, you can use the Cmd key and either the minus (-) or synchronise the panning and zooming of the photos so they plus (+) keys to alter the magnification at which you view the both scale and move at the same time, then if one is moved, the photo. The image can also be dragged around if required. 

other will move in unison. Click the Sync icon to do this. 

If you click on the View icon again, the View Options menu 9

Each image, that is currently selected, can have some 10

will pop up. You will see that there is a full screen option, simple edits applied to it. With an image active, click on the or you can choose the Above and Below view option instead. 

Fix icon in the Control bar and the Quick Edit panel will open. 

This places the images one above the other, horizontally, across You can apply a star rating, rotate the image and delete it, or the screen. 

mark it for printing. Press Exit to quit Full Screen. 
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GETTING ORGANISED

Watched

Folders

Photoshop Elements uses watched folders to aid the process of keeping your image catalogue up to date as you add or remove content over time. You can define any number of folders as watched folders. Any time you add or delete images to these folders, you will be alerted. 

Within Elements Organiser, you can find the Watch Folders 1

You can choose to have any new files that are detected, 2

option under File > Watch Folders. This calls up a panel within a watched folder, added automatically to your where you can set various parameters to: govern which folders catalogue, with no input from you. You can also choose to are watched, add new folders, remove existing ones if required have Photoshop Elements ask how you wish to proceed, when and even turn the function off. 

importing the new content. 

If you choose to be alerted before proceeding, whenever 3

If you use any online services and cloud-based storage 4

any new items are added to your watched folders, providers, such as Google Drive, One Drive, Dropbox Photoshop Elements will display a message to indicate that it and iCloud, for secure storage backups and syncing to mobile has detected new items. You can click Import to continue the devices, Elements Organiser can automatically detect their process or Cancel to abort. 

relevant folders and include them as watched folders. 
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WATCHED FOLDERS

To add a new watched folder, activate the Watch Folders 5

If you wish to remove a folder from the Folders to Watch 6

dialog panel and click on the Add button. A browser listing, simply highlight the required folder and click the window will open, enabling you to navigate to a folder you wish Remove button to the right of the list. Removing a folder does to watch, or create a new folder into which you can put content, not delete its content; that remains untouched. You have only after setting it up as a watched folder. 

told the program to ignore that folder. 

As an example, we have used the Watch Folder function 7

Now, if you go back and open up Elements Organiser, a 8

to create a new empty folder called 'tutorials' and closed screen will appear indicating that new files have been found the program down. We then downloaded some images from a in the folders it has been instructed to watch. Depending on how recent photoshoot, processed them and then saved the favourite many folders you have set up, you can choose to import from images to the 'tutorials' folder. 

selected folders only, or cancel the entire import. 

If you go ahead and import the images, once they are 9

If you don't have a particular folder watched and you 10

added to your catalogue, they will each have a thumbnail physically delete, or move, an image out of its folder, the created for them and they will be added to your Media browser next time you open up Elements Organiser, the image may still window view. If you choose to Sort By Newest, they should appear in your Media view, but it will have a small question mark appear at the top of the Media view. 

in the top left corner to indicate that it is missing. 
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GETTING ORGANISED

Import from a 

Digital Camera

Usually, when importing images and media content into Elements Organiser, you will be doing so from the pre-existing folders and drives on your home computer. However, there may be times when you wish to import directly from a digital camera, or other mobile device. 

In this example, we are going to connect a digital camera to 1

Digital cameras can be connected to your computer via a 2

the computer and import images straight from the camera USB cable. Most cameras offer an A/V Digital port to let into Organiser. If you have a card reader, or are using another you move files off the camera in the event of not having a card mobile device such as your phone or tablet, the process will be reader. Connect the USB lead to your camera and the other end the same. 

to your computer's USB port. 

If you are working on a Windows PC, you may find that 3

Start up Elements Organiser. If you look in the top left 4

the Auto Play dialog box appears when you connect your corner of the workspace, you will see the Import button, camera. Under the Pictures Options, there may be the choice of click on it and a dropdown menu will appear. You can choose either importing via Windows, or using Elements Organiser. For from several options, but the one that concerns us is the From the purposes of this example, you can simply close the box. 

Camera or Card Reader option. 
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IMPORT FROM A DIGITAL CAMERA

Click the From Camera or Card Reader option and the 5

You can choose to keep the Import Settings at their 6

Photo Downloader window will appear. Depending on what defaults or you can opt to change the location of the is connected to your computer, one, or more, Source options downloaded files by clicking on Choose and navigating to a will appear under the Get Photos From dropdown menu. In our preferred destination folder, or creating a new folder, into which example, the source is a Canon 5D Mark III digital camera. 

your images will be stored. 

Below the Location path is the Create Subfolder(s) option. 

7

Below the Create Subfolder(s) option, is the Rename Files 8

This lets you create subfolders within the specified location option. You have a large choice of renaming options, such path with either a custom name or a choice of Today's Date or as: Shot Date (yyyy mm dd) + Custom Name. This lets you the Shot Date in various date formats, such as: Shot Date (yyyy rename each downloaded file with its shot date and a custom mm dd). 

name, plus an ascending four-digit number. 

Finally, you have the Delete Options to choose from. There 9

Click on the Get Media button. If a Failed to Connect dialog 10

are three main choices: After Copying Do Not Delete box appears, you may need to check if your camera has Originals, After Copying Verify and Delete Originals, (which gone into standby mode. Turn your camera back on, click the checks the files before they are deleted) and finally, After Retry button and click Get Media again. The images will then be Copying Delete Originals. 

downloaded onto your computer. 
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GETTING ORGANISED

The Advanced 

Photo Downloader

Downloading images from your digital camera, using the Photo Downloader, can be as simple as you require. If, however, you do need some more advanced options for naming, tagging and organising, then you can delve deeper into the advanced settings provided. 

Open Elements Organiser, click on the Import button at 1

The Advanced Dialog panel displays a thumbnail preview 2

the top left of the screen and choose the From Cameras or of each of the files on your camera along with its shot date Card Reader option, once again. The Photo Downloader panel and filename. There are a number of options for setting locations will open and your camera will be identified as an image source. 

and subfolders, as with the standard dialog box, plus a number Leave the settings at their default and click on Advanced Dialog. 

of advanced options. 

Choose Custom Groups (Advanced) in the Save Options 3

Using our example, if you set the slider to a lower groups 4

section, under Create Subfolder(s). This divides up the setting of 3, the shots are divided up into three groups, images into groups based on their shot date and capture time. 

which is handy since there are three different sets of images, There is a slider below the Create Subfolder(s) menu that lets taken some time apart. Change that setting to 15 and, naturally, you control how the groups are subdivided. 

the number of subdivisions increases to 15. 
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THE ADVANCED PHOTO DOWNLOADER

You can experiment with the numbers of groups you generate 5

When you have settled on how many groups of photos you 6

by moving the slider back and forth, then reviewing the effect want to create, you can specify a set of custom names for by scrolling down through your list of thumbnail images. Keep an the subfolders that will hold each group of photos. Under Group eye on the small box to the right of the slider, as it will update you Name you can choose an option such as: Shot Date (yy mm dd) as to how many groups are being created. 

+ Custom Name. 

In the thumbnail view, click on each Custom Name field and 7

In the Advanced Options section, you can check, or 8

give it a unique name to identify that folder. In our example, uncheck, the four options available. If you have a lot of folder one is called 'Beach', folder two is called 'Party' and folder portrait photos taken at a party, you can check the Automatically three is named 'River'. For clarity, we have also chosen the Fix Red Eyes function and each photo will be checked for Red Rename Files option of Same as Subfolder Name. 

Eyes and, if necessary, fixed. 

You can make your Advanced Options choices and then, at 9

You can also apply Basic Metadata to your image, as well 10

the bottom, you can choose: After Copying Do Not Delete as Creator and Copyright information. When you are happy, Originals, After Copying Verify and Delete Originals, or, After you can click the Get Media button and import your images. 

Copying Delete Originals. We would recommend that you don't Back in your Media workspace, you should see three new folders delete your originals, just to be safe. 

with a date and a custom name to identify them. 

71

[image: Image 72]

GETTING ORGANISED

Search by Metadata, 

Similarity & Objects

When you take a photo, metadata is added to your image to identify: the camera settings used, the lens used and various other parameters, then Elements Organiser adds some more. You can use this metadata to find the images you want and use image analysis to search by visual similarity. 

Open Elements Organiser and keep it in the Media view. In 1

You have three search strings. The first has options such 2

the file menu, go to Find > By Details (Metadata). Click this as: Filename, Camera Model, Capture Date and much more. 

menu option to open the search criteria panel, where you can The second and third search strings finesse the search parameter enter search parameters to locate matching shots. 

using words that your files may, or may not, contain and whether it starts or ends with a specific word. 

To the right of the search strings, is a small plus (+) symbol 3

When you click on the Search button in the bottom right 4

in a box. If you click it, you can add more search strings of the panel, it will display all the images shot on a Nikon to the Search Criteria for even more targeted searching. In camera, contained within your catalog. We also tried searching our example, we chose Camera Make as the first search item, by focal length of lens used (16mm - 24mm), to find all our wide-Contains as the second criteria and Nikon as the third. 

angle photographs. Preferred searches can also be saved. 
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SEARCH BY METADATA, SIMILARITY & OBJECTS

Another method of searching is by visual similarity. You can 5

From the media browser window, click on an image you 6

search within preferred folders, or the All Media browser would like to use as the basis for finding visually similar window. Go to file menu and choose Find > By Visual Searches photos. Drag that image up to the Find: window and Elements 

> Visually Similar Photos and Videos. A small Find: panel, with a Organiser will use visual analysis algorithms to search and display plus (+) symbol, appears at the top of the media view window. 

similar images. 

If you look at the top right of the media browser window, 7

You can experiment with the position of the slider to see 8

you will see a slider that can be moved from Color to how they match. Notice that each image displayed is Shape. You can use this slider to refine the visual search and listed in descending order of visual similarity to your original display better Color matches, or move it the other way and it will photo. For further refinement, you can add another photo to display images that better match the Shape of your original. 

the Find: panel. 

Another method you can use is to search for a specific 9

We chose a portrait and highlighted just the face. When you 10

object. Back in your media browser window, go to File > click on the Search Object button, any image that contains By Visual Searches > Objects Appearing in Photos. Now when a similar shape or colour, will be displayed. You can use the Color/

you drag an image onto the Find: panel, you will be prompted to Shape slider again to change the bias towards your preferred select a specific area from your image. 

match. As before, images are listed in descending order. 
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GETTING ORGANISED

Using 

Instant Fix

Not all photos are perfect when taken on a digital camera. Some of them may be underexposed and too dark, others may be overexposed and too bright. Part of the process of getting your photo library organised and looking its best, is to also make image adjustments to your photos. 

You can add image adjustment as part of your cataloguing 1

In the main Media Browser window, select one or more 2

and keywording routine, to not only get your image images that are in need of some adjustments. In most organised, but also looking its best. Elements Organiser has an cases, they will be images that are too dark or too bright. With Instant Fix option that lets you make some basic, but essential, them highlighted, go to the taskbar at the bottom of the screen fixes to your images. 

and click on the Instant Fix icon. 

The Instant Fix window is a fairly easy workspace to 3

If you have selected more than one photo to work on in the 4

understand. You have buttons to Undo or Redo actions, Instant Fix window, at the top middle of the screen are two a Before and After toggle switch to compare the edits you've View options. One is to Show One Photo and the other is to Show made so far and a Reset button to revert your photo back to its All Photos so you can choose which image to work on. If required, original state, if you need to start again. 

the Editor button will open the image in the Photo Editor. 
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USING INSTANT FIX

Running down the right side of the Instant Fix window, are 5

Other panels, such as Crop, display a number of options 6

tools to adjust your photos. From top to bottom, they are: you can click to apply that particular adjustment. The Crop, Red Eye, Effects, Smart Fix, Light, Color and Clarity. Each Effects panel has a list of colour effects you can apply to your one has a fly-out panel; some with a simple vertical slider that image and Red Eye will simply scan your photo for any eyes lets you increase or decrease a particular effect. 

affected by a direct flash from a camera. 

Smart Fix is another option that has no direct input from 7

To get a little more hands-on, the Light, Color and Clarity 8

you. When you select it as an option, it will analyse your adjustments are probably the best route for a superior photo and make a series of changes based on what it thinks is looking photo. Clicking on Light gives you a vertical slider to best for that particular image. It is quick, but it may not give you increase or decrease the brightness of the image. To apply, the effect you are after. 

simply move the slider to the preferred brightness. 

Next comes the Color slider. Moving this upwards makes 9

Once you are happy with the photo, to apply the changes 10

the image more saturated, with colours that are more vivid. 

click the Save button at the bottom right of the screen. 

Moving it downwards will de-saturate the image until it becomes Then, if you click Done, you will leave the Instant Fix window. 

black and white. The last adjustment is Clarity, which will increase Your image will have a small icon in the top right corner called or decrease the contrast in all the middle tone areas of the photo. 

Version Set, indicating an original and an edited version exist. 
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We hope that by now you feel like you've had a good introduction to what Adobe Photoshop Elements is all about. 

There's a lot more to come on the following pages but before we dive in further, we thought it would be great to show you a series of quick tutorials exploring the vast range of techniques and tools available. There's everything, from making a panorama from multiple images, to putting pictures inside text. Take a look and enjoy the Elements experience. 
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THE ELEMENTS EXPERIENCE

AFTER

The Elements Experience 1

Open Closed Eyes

Now you need not consign a photo to 

the trash just because your subjects eyes 

are shut. Thanks to the latest version of 

BEFORE

Elements, you can tackle the problem with 

ease. If you have another example of a 

face where the eyes are open and they are 

not too different in terms of their colour 

and lighting, you can swiftly replace those 

closed eyes for open ones. This works in 

both the Quick mode and Expert mode. 
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OPEN CLOSED EYES

Open your photo by going to File > Open 

1

Go to Enhance > Open Closed Eyes and 

2

and navigating to where your primary 

you will see the Open Closed Eyes dialog 

photo is kept and either double-click the image box. Here you can choose your Eye Source to 

or select it and press the Open button. 

open your subjects eyes with. 

Just in case, there is a small selection 

3

For best results, find a photo that roughly 

4

that you can try straight away, with two 

matches the lighting and colours of your 

female and two male sets of sample eyes, on 

original photo. You can select Choose from > your photo. 

Computer and locate a suitable image. 

When you have found a likely candidate, 

5

The new eyes you found will be mapped 

6

double-click it to load it as an eye source 

over your existing image and blended as 

and then click on its thumbnail to apply it to seamlessly as possible. If you like the result, you your main photo. Click OK when done. 

can save it under a new name. 
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THE ELEMENTS EXPERIENCE

AFTER

The Elements Experience 2

Partial Sketch

Guided edits are a simple, quick and 

fun way to add edits to your photos. 

Have you ever fancied yourself as a 

BEFORE

great sketch artist? Well, with the Partial 

Sketch guided edit, you can instantly 

turn any of your favourite photos into an 

artistic rendering with just a few clicks. 
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PARTIAL SKETCH

Open the Elements Photo Editor, go to 

1

You have four pencil sketch effects to 

2

File > Open and choose a favourite photo; 

choose from. Click one to activate the 

then go to the Guided workspace. The Partial 

sketch brush. Select Add and use the slider to Sketch effect is under Fun Edits. 

control its size. 

Paint across your image to reveal areas 

3

If you want to, you can use the Detail 

4

you want to be converted to a sketch 

Brush to more precisely paint the sketch 

effect. You can always use the Subtract brush, effect on or off your photo, controlling the 

to remove any sketch areas you don't want. 

brush size and opacity. 

An optional effect is to soften any hard 

5

With the image still active, you can 

6

edges or flip the effect. If you're happy, 

actually go to the Expert workspace and 

you can select Next and Save your image. 

continue to work on your photo adding more 

contrast to the sketch layer. 
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THE ELEMENTS EXPERIENCE

AFTER

The Elements Experience 3

Replace Background

Hopefully it isn't an exaggeration to say 

that cutting one subject out of a photo 

and transplanting it into another is one of 

BEFORE

the core photo manipulation tasks that 

everyone has encountered or at least 

thought about when perusing their photo 

collection. Well, there is a great Guided edit to help you do just that. 
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REPLACE BACKGROUND

In the Guided workspace, you will find 

1

Choose from the available tools to select 

2

the Replace Background edit under the 

your subject. The Quick Selection tool 

Special Edits category. Put the photo you want should work well on our subject. Drag inside 

to work on in the Photo Bin. 

the edge of subject to select them. 

Use the tool options to subtract areas 

3

Now you can import a photo that will be 

4

that stray outside what is required. Then 

the new background. It will be placed 

you can use the Refine tool to improve the 

behind your main subject. Both subject and 

quality of the selection. 

background can be moved if required. 

Now you can make further refinements 

5

Click Auto Match Colour Tone to make 

6

to the outline of your subject if you want. 

the colours of your subject match the 

A soft brush can be used to feather the join 

background more closely. Now you can save 

between the foreground and background too. 

the image as a PSD or jpeg. 
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THE ELEMENTS EXPERIENCE

AFTER

BEFORE

The Elements Experience 4

Photomerge Panorama

Sometimes, a view is too expansive to capture in one photo unless you have some specialist 

super wide-angle lens. Luckily, Elements has a Guided edit that can take a series of shots and stitch them seamlessly together to create a 

super-wide panorama that can stretch from 

horizon to horizon if needed. 
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PHOTOMERGE PANORAMA

In the Guided workspace, you will 

1

Make sure all your photos are selected 

2

find Photomerge Panorama under the 

and choose the type of setting you want. 

Photomerge category. Place the sequence of 

In nearly all cases, the Auto Panorama settings panoramic photos you want in the Photo Bin. 

is fine for standard photos. 

Make sure the Blend Images Together 

3

Now you can click the Create Panorama 

4

and Vignette Removal boxes are ticked. 

button and the stitching process will 

If you want to fill transparent areas then 

begin. Note that Expert mode is used to stitch choose Content Aware Fill Transparent Areas. 

your images. 

Once Expert mode has stitched the 

5

In Expert mode you can flatten the image, 

6

images and filled any transparent areas, 

make adjustments to the image and crop 

it returns you to the Guided page to save it or it if required. Then you can save the result as a continue working on it in Expert mode. 

PSD or other image format. 
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THE ELEMENTS EXPERIENCE

BEFORE

AFTER

The Elements Experience 5

Meme Maker

What is a meme, you may ask? A meme 

is an image, video or piece of text that is 

humorous in nature. It is copied and spread 

around the Internet and social media and 

often has slight variations added to it. The 

power of the meme has not gone unnoticed 

at Adobe, so they have introduced the 

Meme Maker as one of their Guided edits 

for you to have some fun with. 
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MEME MAKER

In the Guided workspace, the Meme 

1

We have a funny picture of a monkey 

2

Maker is under the Fun Edits category. 

sticking his tongue out. The first thing to 

Make sure you have a suitably worthy image 

do is to click the Create Meme Template button open and ready to go. 

to add the basic frame and text. 

You can type new text using the Type 

3

Then you can zoom your photo if required 

4

Tool and choose any font from the Tool 

and flip it horizontally or vertically. Then 

Options panel in the lower left of the screen. 

you can choose to add a new border from the 

options available. 

You can also add more effects to the 

5

Finally, when your meme is ready, you can 

6

resulting image. You can choose from 

save it, continue to work on it in Quick or 

a pop art, black and white and several other 

Expert mode and Share it with the world on 

options. Click on the effect you want to add. 

Flickr and Twitter. 
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THE ELEMENTS EXPERIENCE

AFTER

The Elements Experience 6

Multi-photo Text

Creating visual text with a photo inside 

BEFORE

each letter can be a laborious process, 

particularly if you are working with a long 

word. Once again, the Elements Guided 

workflow has a guided edit that can take 

the work out of the process, so you can 

enjoy what you are creating. 
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MULTI-PHOTO TEXT

The Multi-photo Text guide is in the 

1

Use the Type Tool first to add your text, 

2

Fun Edits section. With your chosen 

alter its style and size using the Tool 

background photo open, you're ready to then 

Option panel. You can also specify how it fits click on the Multi-photo Text icon. 

your photo. 

When you click the Create Frames 

3

Choose from your computer or your 

4

button, each letter is converted to a 

Photo Bin and place one image inside 

frame ready for you to click and then select a each letter. Double-click each frame to adjust photo to appear in it. 

the image size and position. 

You can add a new background if you 

5

Save it there and then or open it in Expert 

6

want by clicking the options available; or 

mode to work on it further. We made the 

you can add outlines and drop shadows to the 

rabbit larger and more visible and then saved it. 

text to make it stand out more. 
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THE ELEMENTS EXPERIENCE

AFTER

The Elements Experience 7

B&W Colour Pop

Converting a photo to black and white 

is great for highlighting the texture and 

composition in an image to make it more 

BEFORE

powerful. There is a creative option to that, where by you convert it to black and white 

but leave a part of it in colour so the object really stands out and draws your eye. It is 

referred to as selective colour or in the case of our guided edit example, B&W Colour Pop. 
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B&W COLOUR POP

The B&W Color Pop edit is found in the 

1

You can click on one of four presets or of 

2

Black & White section. Open a photo that 

you prefer, click on the Select Custom Color 

you want to add the effect to and then click on button and pick the most dominant colour you 

the B&W Color Pop icon to proceed. 

want to remain untouched in your photo. 

Then, if you increase the Fuzziness 

3

You can then use the Refine Effect 

4

value, more colours similar to the one 

buttons to bring back more areas to 

chosen will become visible again while the rest colour using the Add tool, or remove them 

remains in black and white. 

using the Subtract tool. 

The Size and Opacity sliders dictate size 

5

Paint over areas that you want to be 

6

of the brush and how opaque the effect of 

coloured again, using a smaller brush for 

adding colour or subtracting it appears. We're finer detailed areas. Finally, you can then click bringing colour back at full strength. 

Increase Saturation for a more vivid image. 
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AFTER

The Elements Experience 8

Zoom Burst Effect

Sometimes you want to add motion to an 

image that is otherwise quite static-looking. 

Elements has a few Guided edits that can 

add a motion effect to your photos to give 

BEFORE

them a little extra punch. The Zoom Burst 

Effect is a digital version of an ages old 

photographic trick where the photographer 

quickly zooms the lens as they take a 

shot to create streaks within the photo; 

emulating the feeling of speed and action. 
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ZOOM BURST EFFECT

The Zoom Burst Effect edit is found in the 

1

The first step is to crop your image so the 

2

Fun Edits section. Open a photo that you 

main subject is in the centre of the shot. 

want to add the effect to and then click on the The zoom effect will start from the centre so it Zoom Burst image to proceed. 

makes sense to position the image centrally too. 

Use the crop tool to drag a crop box 

3

You can then click the Add Zoom Burst 

4

around your main subject. Our example 

button and the effect will be added to the 

is of a motorcycle to which we want to add 

shot. It mimics a photographic effect where the some motion to create a bit more drama. 

lens is quickly zoomed as the photo is taken. 

At the moment, the entire image has the 

5

We used the Add Focus Area tool to 

6

effect added to it, however, you can use 

bring the rider back into focus to give 

the Add Focus Area tool to remove some of the the shot a point of interest. We also clicked the effect in a chosen area. 

Apply Vignette button to darken the corners. 
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AFTER

The Elements Experience 9

Old Fashioned Photo

Calling this particular effect old fashioned is a bit of a misnomer since the vintage look 

is quite popular at the moment. Giving a 

photo a retro feel, or making it look like it BEFORE

has come from a bygone era, can bring a 

charming touch to a photo. Just be aware 

that a very modern-looking photo will not 

translate so well, as the photo has no real 

indicators of what era it was shot in. 
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OLD FASHIONED PHOTO

In the Guided edit mode, open your photo 

1

We have chosen an example of two 

2

by going to File > Open and navigating 

rockabilly musicians who have a very 

to your photos. Select the one you want to use retro look and, given their location, this should and press the Open button. 

convert well into a shot with a vintage feel. 

Click the Old Fashioned Photo preview 

3

Next, you have the option to click the 

4

under the Fun Edits category and begin 

Adjust Tone button. Adjusting the tonality 

the process by choosing from the three Black 

of the photo makes it slightly more contrasting. 

and White pre-sets listed. 

It can be quite subtle, but worth a look. 

Old photographs are characterised by 

5

The final step is to click the Hue/Saturation 6

their graininess. The Add Texture button 

button. You can use the Hue, Saturation 

allows you to add a certain amount of grainy 

and Lightness sliders to add a tint to your photo. 

texture to help with that old photo feeling. 

We've opted for a classic sepia look. 
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THE ELEMENTS EXPERIENCE

AFTER

The Elements Experience 10

Depth of Field

Depth of field is a photographic term that 

is used to describe how much of a scene 

is in sharp focus and how much is out 

of focus. If a scene has only a very small 

BEFORE

portion in sharp focus, it is referred to as 

having shallow depth of field. Shallow 

depth of field is beloved by photographers 

and Elements has a Guided edit that can 

emulate this particular effect. 
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DEPTH OF FIELD

You have two options to create your 

1

The second option is the Custom approach, 

2

effect. The first is the Simple option where 

which involves making a more detailed 

you blur the image and then click and drag a 

selection of the subject that you wish to remain gradient that defines an area of focus. 

in focus, whilst blurring the rest of the photo. 

You start the Custom process by using 

3

You can use different brush sizes and if 

4

a Quick Selection Tool and dragging it 

the selection goes wide, you can switch 

around the outer edge of the subject you wish to Subtract selection to remove areas that have to remain in sharp focus. 

strayed outside your subject's outline. 

Use the Subtract tool and with a small 

5

Once your selection is ready, you can click 

6

brush size, carefully remove any parts 

the Add Blur button. Below the button is 

of the selection that have jumped outside the a Blur slider, which you can use to increase the outline of your intended subject. 

amount of background blur. 
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The great thing about Adobe Photoshop Elements is that it can cater for all skill levels when it comes to image editing, digital manipulation and creating new works of art. Whether you are a complete novice who is starting out and wanting to learn the ropes or an experienced digital artist who needs more advanced tools to complete their project, Photoshop Elements has all the power and sophistication you need to get the most out of your photos. 
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A Guide to

Using Layers

Layers are one of the fundamental aspects you can employ when it comes to non-destructive image editing. 

The use of layers has become the  will remain untouched in case it doesn't  1

very core of image editing since its 

turn out quite as you had hoped. Within 

introduction in the early '90s. As 

Elements, there are four main types of 

You can click the Create New Layer 

you might imagine, layers are exactly 

layer. There is the basic pixel layer which 

button at the top of the layer panel, use 

what they sound like. You can have a 

contains the main photo elements of the 

the key broad shortcut or go to the file 

number of separate elements, each 

project. There are text layers where you 

menu and choose Layer > New > Layer 

on its own layer, that are stacked one 

can type text and change the size and 

to add a new layer to the stack. You will 

on top of the other. When all viewed 

colour. Then there are fill/adjustment 

be prompted to name the new layer. You 

together, they create the final image. 

layers that are designed to affect the 

can rename it at any time. 

The advantage of using layers is clear. 

layer below it such as changing the 

It means you can change an element 

saturation or brightness of the layer 

2

on one layer only and not have an 

below, or just adding a colour to that 

impact on the rest of the image. It also 

layer. Finally there are vector layers that 

Sometimes it may be necessary to take 

means that you can take an image 

contain scalable graphical elements such 

a number of layers and group them 

and duplicate it on another layer and 

as shapes and work paths. Each layer 

to make things more manageable, as 

perform any edits you want on that one 

type can also have a mask added to it so 

the number of layers increases in your 

in the knowledge that the base image 

only part of that layer can be seen. 

document. You can highlight each layer 

100

[image: Image 101]

A GUIDE TO USING LAYERS

you want and then press the Create 

specific parts of that layer only. Areas 

7

New Group button to group them. 

of the mask in white let the layer remain 

Alternatively, you can go to the file menu 

visible, while any areas of the mask in 

The trashcan shaped button lets you 

and select Layer > New > Group

black hide that part of the layer. The 

delete any selected layers if you wish to 

rule of thumb is: white reveals pixels and 

remove them from the layer stack. 

black conceals them. 

3

8

Fills and Adjustments allows you to add 

5

colours, gradients and patterns to a layer. 

There are a number of menu options 

They also allow you to add adjustments 

Clicking this button locks the layer 

available here such as Rename Layer, 

such as Brightness and Contrast, Hue and 

completely and no further edits can be 

Duplicate Layer, Delete Layer, Link 

Saturation and Levels. Adjustment layers 

made to it. You will also be unable to 

Layers, Merge Visible and Merge Down. 

affect the layers directly beneath them in 

reposition the image on a locked layer. 

the stack or they can be clipped to the 

9

one layer directly below them only. 

6

Blend Modes determine how the image 

If you click this button, any area of a 

colours on the layer interact with the 

4

layer that has no image pixels in it is 

layer below it. It can be changed for 

Each layer you use in a document can 

considered transparent. An area that is 

every layer individually or as part of a 

have a layer mask added to it. The mask 

transparent is then locked and no edits 

group for certain visual effects. 

is designed to let you hide or reveal 

can be made so it remains transparent. 

10

The small eye icon on the left of each 

1

2

3

4

5

6

layer lets you turn that layer off so it is 

not visible. Any effects associated with 

that layer are also rendered invisible until 

the eye icon is clicked once more. 

11

This lets you link a number of layers 

so that any transformations and move 

commands you make are all applied to 

the linked layers at the same time. 

7

8

12

The Background layer is the default 

9

bottom layer. Whether it is an image 

you have opened or a new document, 

the Background layer is always partially 

locked until you choose to unlock it. 

10

11

16

13

A typical layer with pixel information 

displayed on it. 

15

14

An adjustment layer is designed to affect 

the layer below it. In this example, we 

14

have a Levels adjustment that alters the 

brightness and contrast of all the layers 

stacked below it. 

15

13

A vector layer contains scalable data 

such as shapes in the case of our 

example. A small icon in the lower right 

corner of the thumbnail indicates it is a 

scalable graphic. 

12

16

The thumbnail of a Text layer displays a 

T to indicate the layer contains scalable 

text. The layer name also reflects 

whatever text is on that layer. 
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Methods for 

Adjusting an Image

When it comes to methods for adjusting your images in Elements, you are spoilt for choice. There are a number of methods to get an image looking great. We'll show you how each one works, with some examples, to help you choose which method suits you best. 

Quick Mode

We start in the Quick mode workspace with a sunrise 1

To remove such a blemish, you can go to the toolbar and 2

image of a pier that is in need of some work to make it choose the Spot Healing Brush Tool (J). When you choose look its best. The first thing to do is remove that large black spot this tool, the Tool Option panel displays Spot Healing Brush in the top right corner: probably a bit of mud stuck to the lens, options. You can choose Spot Healing Brush or Healing Brush to currently spoiling the shot. 

remove the spot. 

The main difference between the two brushes is that the 3

The Healing Brush Tool asks you to select an area to be 4

Spot Healing Brush lets you paint directly over the blemish the clone source by clicking on a clean part of the image and then works out what to fill it with by analysing the area next to the blemish. This chosen area will then be cloned over around it. Proximity Match and Content Aware are the best the blemish when you paint over it. The cloned source will be options here for this kind of blemish. 

blended in to be as seamless as possible. 
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METHODS FOR ADJUSTING AN IMAGE

You can alter the brush size by using the Size slider in 5

Now that the blemish is gone, we can look at making 6

the Tool Options panel or by pressing the left and right the image more vibrant and appealing. Layers are not bracket keys. Pressing [ will reduce the size of the brush and available in Quick mode, so it comes down to choosing the pressing ] will increase the brush size. This lets you clone with right method for the best overall effect. The easiest way to see greater accuracy and detail if you need it. 

the effect you can have on the image is to choose Adjustments from the taskbar. 

This calls up the Adjustments panel. You can choose 7

Next, you can go to the Exposure adjustment and 8

Smart Fix and select from a number of options that make choose to make the image brighter or darker. Again you subtle changes to the image and recover detail in the highlights can hover over a number of options and see a preview of the and shadows. Hover over each one to see a preview of the effect or use the slider to make more subtle adjustments to the effect applied to your photo. Click the one you want to apply. 

brightness of the image. 

The Lighting panel is the key to really controlling the 9

The vividness of your image can be controlled in the 10

brightness of your Highlights, Midtones and Shadows, Colour panel. Increase the Saturation globally or use each of which has its own tab for you to access. Choose from Vibrance to increase the most subdued colours first. Hue lets the options provided or use the sliders for more subtle control you shift the entire colour palette for a surreal colour effect if of each of the tonal options. 

you require it. 
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Balance lets you shift the colour temperature from cold 11

Finally, you can go to the Sharpen panel and apply levels of 12

to warm and Tint allows you to add either an increasingly sharpness to your image; but beware of overdoing it and green colour cast or a magenta cast to help offset any colour creating artefacts and halos as the contrast increases and bright inconsistency in your original image. 

unwanted highlights appear around areas of high contrast in your photo. If you are happy, you can save the result. 

Quick Mode Auto Modes

Under the Enhance menu are a number of Auto features to 1

If you go to Enhance > Auto Smart Tone (Shift + Cmd + T) 2

improve your image. These are quite broad in their effect an interactive panel appears, where you can drag a cursor and do lack a certain finesse, so you have no real control over the around a grid. Each corner of the grid shows a possible outcome outcome. If you want some more input in the effect there are a that can be achieved by moving the cursor further in that couple with a bit more control worth looking at. 

direction. Move it around until you get the result you want. 

If you go to Enhance > Adjust Colour > Adjust Colour 3

Another option, but one that needs a light touch, is the 4

Curves, you can adjust the Highlights, Midtones and Haze Removal tool. Go to Enhance > Haze Removal (Shift + 

Shadows of your image. There are a number of preset styles you Cmd + Z). This can be quite a strong effect but there are sliders can choose from to enhance the colour in your image as well as to adjust the strength of the Haze reduction applied and also the the option to manually adjust the tone sliders. 

sensitivity of the haze detection. 
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METHODS FOR ADJUSTING AN IMAGE

Guided Mode

Guided Mode is an alternative if you are happy to have less 1

The great thing with Guided edits is that you don't have to 2

advanced adjustment options available but with more step-apply just one edit. We are going to apply several to get by-step guidance to help you on your way to creating the final the end result we are after. Start with Levels to get the overall image. Make sure you have an image open in the Photo Bin ready brightness of the image dialled in first. Levels can be found in the to work on. 

Basic category. 

You will be asked to create a Levels adjustment and a 3

Now, if you look in the Photo Bin, back at the main Guided 4

dialog panel will appear. Click OK. Since the image has a Home screen, the photo will have a small icon in its top lot of underexposed dark areas in the foreground, sliding the right corner that indicates it has edits applied. Then, you can go Midtone slider to the left will brighten the photo in those darker to the Colour category and choose Enhance Colours to add more areas. You can then click Next and then Done for this part. 

vividness to the photo. 

You can use the three sliders of Hue, Saturation and 5

Finally, back in the Basics category, click Lighten and Darken 6

Lightness to make the image much more saturated and and use the three Shadows, Highlights and Midtones sliders bring out the colours in the sea, sky and foreground. A boost of to make final tweaks to the image. The Highlights have been Saturation to 45 and Lightness to -2 is enough to bring more life reduced to bring more detail back into the brightest areas. At this into the photo. You can lick Next and Done once more. 

point you can click Next and then save your image. 
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Using the Photo 

Editor Expert Mode

Don't be put off by the title of Expert. In this case, you get more tools to play with and you can actually be more involved in the editing process. 

You can switch out to another mode, but to truly unlock the power of the program, you will want to try out some image editing in this mode. 

We have opened another image that needs some fixing. It 1

First, the colour balance needs to be adjusted. The image 2

is a sunrise on the moors that is a little underexposed and is a little too magenta and warm, particularly if you look needs some work to bring out the foreground, while keeping the at the colour of the grass. This can be altered  by using a really sky relatively untouched, since that is quite well exposed. This is simple trick that can be really effective and requires the use of where the use of layers and masks will help us out. 

layers to do it. 

Press Cmd + J to copy the Background layer. Name the 3

Make sure this layer is active then go to Filter > 4

new layer 'remove cast'. Then go to Filter > Blur > Average. 

Adjustments > Invert (Cmd + I) to invert the muddy brown This will blur the duplicate of the scene and average out the colour to a pale green hue instead. This colour, derived from colours it contains into one colour. In this case, it turns a muddy the colour average of the original scene can be used to create a brown colour. 

colour correction filter. 
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Go to the Blend Mode button and from the dropdown 5

Altering colour can be quite subjective and if you feel 6

menu that appears, choose Overlay as the blend mode for that the correction is too much, you can always go to the 'remove cast' layer. This will blend the colour of that layer into the Opacity slider and adjust to about 80% to lessen its effect the photo of the moors below it. You should see that the snow slightly if you wish. Now you can continue editing the image. 

now looks a lot cleaner and whiter than it did. 

Now to make the image punchier, click the Create New 7

Choose the Brush Tool (B) from the toolbar, then set the 8

Fill or Adjustment Layer button and choose Levels. Make foreground colour to black. You can press D to default sure 'Levels 1' is at the top of the layer stack. Adjust the Midtone the colours so black is the foreground  colour and white the slider so the sky is a bit darker. This will obviously make the entire background colour. Pressing X will swap those foreground and image too dark but you can fix that next. 

background colours over if you require. 

When you choose the Brush Tool, the Tool Options panel 9

You can now use that soft black brush to paint on any areas 10

will display parameters for the brushes. We need a large of the mask where you do not want the adjustment to be soft brush which can be chosen from the Brush Presets menu. 

visible. In this case, we only wanted the sky to be adjusted so we Click on the Soft Round 200 pixels brush to make it active. Make painted over the rocks and foreground. 

sure the Levels 1 layer mask is active by clicking it. 
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When you paint over those areas, you are hiding the 11

Push the Highlights and Midtones sliders of the 'levels 2' 

12

adjustment so they become their original brightness again. 

adjustment to the left; as you do this, you will see the entire In fact, it would be nice to make the foreground rocks and snow image become lighter. Concentrate on the foreground rocks and brighter, so let's get another Levels Adjustment and add it to the snow and adjust the sliders until they look nice and bright. The layer stack. This will be 'Levels 2'. 

sky might be too bright but not to worry. 

Just as you did with the 'Levels 1' layer mask, paint with 13

If you want, to blend the masks better, you can keep 14

your soft black brush on the 'Levels 2' layer mask over the the 'Levels 2' layer mask active and go to Filter > Blur > sky area and horizon. You are now concealing areas of the 'Levels Guassian Blur and choose a blur of about 125 pixels to help blend 2' adjustment so the sky goes back to being darker again. 

the two adjustments you've made seem more seamless. 

There is no reason you can't add the same amount of blur 15

Now that you have both the Levels Adjustments in place, 16

to the 'Levels 1' layer mask as well. The softening of the two you can revisit them at any time and tweak the settings to masks means there are no obvious joins betraying the fact that your heart's content. You can even go back into the layer masks various adjustments have been made. Thanks to the use of layers, for each and use your brush tools to refine those masks you this has all been non-destructive editing. 

applied in the first place. 
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The image has now been colour balanced and two sets of 17

Now let's turn up the vividness of the image. Click on the 18

adjustments have brought some sparkle to the snow in the Create New Fill or Adjustment Layer button and choose foreground and kept the sky dramatic in the background while Hue/Saturation from the list that appears. A 'Hue/Saturation 1' 

the rocks now have some nice detail showing in them as well. 

layer will be added to your existing layer stack. Make sure it is the topmost layer. 

How much Saturation you add is a matter of personal taste 19

Click the Channel button and you will see how you can 20

but to capture the glorious colours of that sunrise, it's been affect the saturation of the component colours. Select pushed to +36. You will notice however that the grass could do Yellows and dial up the saturation and push the Hue slider to with a little push to make it more vibrant. 

about +23 to really bring out the vibrant green of the grass. 

At this point, you may want to perform more edits to the 21

You can now perform edits directly to the pixel data of the 22

image. It is always good housekeeping to create a snapshot 

'merged' layer, safe in the knowledge that if anything goes of the work done thus far. To do this, press Shift + Alt + Cmd + E. 

wrong, you still have all the original work on the layers below This creates a new layer which is a merged version of all visible which you can use to create another merged version. You can layers. Name this layer 'merged'. 

also save your document as a PSD file when complete. 

109

[image: Image 110]

YOUR GUIDE TO IMAGE EDITING

Working with

Selection Tools

Some aspects of image editing will require you to select certain areas of a photo so you can either place it on another layer or edit it in isolation from the rest of the image. With Elements, you have a number of options for being able to achieve this and we cover them next. 

Rectangular Marquee

Elliptical Marquee

This tool lets you make selections of square or rectangular 1

The Elliptical Marquee tool behaves in the same way as the 2

areas of your image. In addition to making the selection, Rectangular Marquee tool and has the same tool options you can add to it, subtract from it and intersect with it. You can available. You can make circular and elliptical selections of any make selections of a fixed size, fixed ratio or normal aspects. You size or proportion. If you hold the Alt key, you can centre your can also feather and refine the edge. 

ellipse over the cursor position. 

Lasso

Magnetic Lasso

The Lasso tool can be used to make area selections from 3

This tool uses edge detection to adhere to the edge of the 4

your image or active layer. The shapes you select with the subject you are attempting to select in the image. You can Lasso tool can be completely irregular and hand drawn. When alter its parameters for more accurate detection in order to make you join the lasso back up to the point where you started, the it snap to the edge of your subject. Areas of high contrast work selection is closed. 

best with this tool. 
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Polygonal Lasso

Quick Selection

The Polygonal Lasso allows you to draw point-to-point 5

The Quick Selection tool lets you paint a selection as if it 6

straight lines around your subject. This is good for were a brush. It uses edge detection to attempt to match geometric and straight-edged subjects where a perfectly straight your selection to the nearest edge in the image. You can alter line is required. Like the Lasso Tool, when you join back up with brush size and settings and it works best on high contrast your start point, the selection is closed. 

subjects that are in sharp focus. 

Selection Brush

Magic Wand

The Selection Brush is more of a freeform brush that lets 7

This tool is useful for the selection of image areas that 8

you choose a brush type of certain size and hardness are the same colour and brightness. You can adjust its and paint a selection around your chosen subject. You can also sensitivity, refine its edge and also choose whether it will globally choose to make it a mask instead. You can add or subtract from select all areas of a chosen colour or just its nearest neighbours. 

your selections in the usual fashion. 

Refine Selection Brush

Auto Selection

The Refine Selection Brush lets you make targeted 9

This works in a similar way to Quick Selection except that 10

adjustments to an existing active selection. In additional to you use Rectangular and Elliptical Marquees and the Lasso adding or subtracting from the selection you can actually push the and Polygonal shapes to enclose an area for edge detection to selection edge and smooth it by applying the refinement brush. 

work within. It works best with well-defined shapes that have good contrast. 
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Cloning, Healing

and Enhancing

Even with modern digital cameras, a lot of photos may have imperfections in them; for instance with dust contamination. This will be displayed as a black smudge on the final photo. Removing these blemishes is quite easy. The technology can also do much more. 

Eye Tool

Red-eye is caused by light from the flash of a camera 1

Click the Eye Tool (Y) and simply click your cursor over the 2

reflecting off the blood vessels at the back of the eye when offending redness in the eyes of your subject. The tool will the pupil is wide open. If you happen to find a favourite photo remove the redness and you can alter Pupil Radius and Darken where your subject has red-eye, then it is a simple process to values to make sure the red has been completely removed. It can remove it. 

also be set for Pet Eye as well. 

Closed Eye Correction

Another great function available in the options panel is the 1

Eyes that closely resemble your subject will work best or if 2

function to open closed eyes. Click the Open Closed Eyes you have another image where the eyes are open, you can button to activate the dialog. The image will scan for closed eyes load that and the program will automatically apply those open and circle possible candidates. Choose the one you want. You eyes to your current image. 

can then choose a set of open eyes to merge into the shot. 
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Spot Healing Brush Tool

The Spot Healing Brush is great at removing dust spots 1

You can choose between Proximity match, Create Texture 2

from photos and  is also great for removing spots from and Content Aware. For most of your subjects, you may humans too. If you have a portrait and the subject has some find that you are switching between Proximity Match and unwanted blemishes, you can use the Spot Healing Brush to click Content Aware. You can adjust the brush size for smaller spots. 

on the spot and it will use nearby pixels to fill the area. 

With care, most blemishes and wrinkles can be removed easily. 

The Healing Brush is an older version of the Spot Healing 3

When it comes to Healing Brush techniques, you will find 4

Brush. It requires you to specify a sample point of a similar that subtlety is the key. Spot Healing is not perfect and may clean texture which is then cloned over your chosen area much require several attempts to get it right. Avoiding too many repeat like a Clone stamp when you click on the target blemish or patterns is important to avoid creating a texture that doesn't look wrinkle you wish to remove. 

like it has been cloned. 

Smart Brush

The Smart Brush uses edge-detection to allow you to brush 1

Choose an effect such as a pencil sketch effect and begin 2

areas of your photo and apply different effects to those to drag your brush over the image, where you want the areas. When you select the Smart Brush Tool (F) the options effect to be seen. You can change brush size and settings such as panel has an effects picker to let you choose which effect you hardness and roundness and subtract from the current selection. 

want to apply to your photo. 

Choose the Detail Smart Brush for more refined selections. 
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Clone Stamp Tool

After the Healing Brush Tool, the Clone Stamp Tool (S) 1

Select the Clone Stamp Tool (S). In the options panel, you 2

will seem quite familiar. It copies pixels from one area onto will have a number of paramaters to choose from such as another to remove things from your photos. Despite recent Size, Opacity and Blend Mode. The Aligned button, when ticked, advances with the Content Aware and Spot Healing Tools, it links to and moves your source point as you move your cursor. 

remains one of the best ways to remove things from a photo. 

Unticked, it uses the same source point each time. 

Here is a wildlife photo from which we want to remove the 3

Press the Alt key and select an area right next to the tip 4

distracting blades of grass that are sticking up to the right of the grass as the source of your cloned pixels. Now you of the rabbit. This is a good example of how cloning can quickly can clone that area over the blades of grass. If the colours don't remove elements from your photos with minimal effort. 

match, you can reselect an area that more closely matches and doesn't stand out as cloned. 

Work you way down the grass stem, you can change the 5

One thing that really gives cloning away is a repeating 6

size of the brush at any point by pressing the left and right pattern. If you see a pattern building up, you can press bracket keys on your keyboard. Take your time and don't be undo (Cmd + Z) to step backward through your last performed afraid to keep selecting new clone source points so the colours actions and change your clone source again to avoid the match the background when you clone out more of the grass. 

repetition of that pattern. 
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In the options panel, you also have the Pattern Stamp 7

You can change the Pattern Stamp's Size and Opacity as 8

available. As the name suggests, you can use this tool to well as the Blend Mode. Choosing Soft Light, for instance, apply a preset pattern to your image. Click on the pattern picker allows a softer blend of the pattern into the image. Click and choose the pattern you want to apply to your photo. 

Impressionist to turn the patterns into paint dabs for a more artistic effect. 

Blur, Sharpen and Smudge

The Blur Tool (R) is a fairly self-explanatory tool for adding 1

The Sharpen Tool (R) uses a brush tool to apply sharpening 2

blur to specific areas of a photo. You can choose a brush to your image. Like the Blur Tool, it is a more targeted type and alter its Size and Strength values for a subtle or intense method of adding sharpness to a photo. Choose your brush type blurring of your subject. 

and alter the Size and Strength values to get the desired effect. 

Approach sharpening with caution since it is very easy to 3

The Smudge Tool (R) can be used to smear the pixels of 4

overdo it and ruin an image with over sharpening. Make your photo across the screen for a creative effect. Just sure the Protect Detail button is ticked and begin to apply the like Sharpen and Blur, you can alter the brush type and set the sharpening effect. 

Size and Strength of the effect. The Finger Painting button adds colour to the smudged pixels. 
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Sponge, Dodge and Burn

The Sponge Tool (O) has two Mode settings of Saturate 1

It's a simple tool for adding targeted saturation or 2

and Desaturate. You can control the Size settings as well as desaturation to the photo. It is recommended to set the the Flow of the effect you are adding to your image. You can also Flow of these brushes to about 10%. Then gradually build up the set the type of brush you want to use to apply the effect. 

application of colour saturation, the removal of colour entirely or just lessen the vibrance of areas in the photo. 

Click and drag the Sponge Tool over the areas you 3

The Dodge and Burn Tools are named after the 

4

selectively wish to Saturate or Desaturate. Continue to techniques that were originally used in traditional film brush the areas to increase the amount of the effect you are processing darkrooms. Dodging refers to selectively making applying. In this example, brushing using the Desaturate option areas lighter in an image and Burning is the opposite effect of eventually turns the affected areas to grey. 

making images darker. 
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The Dodge Tool can be used to lighten images. Use the 5

You can selectively brighten areas of the image that you 6

Range button to determine if you are affecting just the want to make lighter. These tools work better for images Highlights, Midtones or Shadows in your photo for greater that start with lower amounts of contrast to begin with. High control of the final result. Again, using very low Exposure settings contrast images will have less need for these kinds of adjustments. 

around 10% is recommended. 

The Burn Tool will selectively make parts of your photo 7

Now you can brush over areas that you want to be darker 8

darker. You can darken the Highlights, Midtones and and create more contrast. Since this particular method is Shadows by clicking the Range button again and adjusting a destructive one, in that you are altering pixels, duplicating the the Size and Exposure settings of the brush. Subtlety is key to base layer and working on a copy is a good way to avoid losing making it work, so Exposure settings of 10% are a good start. 

the original. 
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Draw, Fill, 

Shapes and Text

The Draw section of the toolbar contains various elements to let you paint, draw, erase and sample colours in your images. There are also a number of text options available for adding text effects to your photos and making masks in the shape of any text that you type. 

Brush Tool

The Brush Tool (B) is one of the most often used tools 1

When you click on the Brush Tool, the options available are 2

in the photo editor's arsenal. Whether you are painting quite varied. You can control brushes with your mouse or if directly over a photo, or adding brush strokes to a layer, the you use a tablet, you can control it as if it were an airbrush with Brush Tool is designed to behave like its real world counterpart pressure sensitive effects for more artistic flair. 

but with more powerful features built in. 

You can choose any number of brush types from the brush 3

You can choose the colours you  brush with and also use 4

picker and alter the Size and Opacity values. You can also the Brush Settings sliders to change how much the colours load new brushes that can be purchased and downloaded from a fade and alter with each brush stroke. You can also tell the brush large number of vendors specialising in photo editing tools. 

how much Scatter or Spacing to use with each brush stroke you apply. Tablet settings are also available. 
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Next to the standard brush is the Impressionist Brush Tool 5

When you paint with this brush, the image beneath the 6

(B). Using its various Brush Settings you can turn your cursor is turned into a series of loose curls, swirls and photo into a painting much in the style of the old impressionist daubs. The larger the brush size you use, the more abstract the painters whose works were rendered as a series of dots, strokes image becomes. Using a brush that is too large will render the and swirls. 

photo unrecognisable. 

The next brush is the Colour Replacement Tool (B). Select a 7

Our example picture is of an owl set against a green 8

foreground colour in the toolbar to use as the replacement background. The colour of the background can be replaced colour. Once again, you have a number of tool options available fairly easily since the owl itself contains no strong green colours including Size, Tolerance and Limits. 

that match the background too closely. 

The Colour Replacement Tool works by continuously 9

In the case of the owl image, dragging the Colour 10

sampling the colour directly under the cursor position. The Replacement Tool over the green areas next to the owl colour beneath the cursor will then be replaced with whatever replaces that colour; but the owl remains untouched since it is not you have chosen as the foreground colour. You can select the the same colour as the colour beneath the crosshair of the tool. 

Blend Mode used to effect how the replacement colour is applied. 
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Eraser Tool

Much like its real world counterpart, the Eraser Tool (E) 1

If the photo is on a layer, then erasing pixels will reveal 2

removes pixels from your image. Whatever colour you have transparent areas instead. Again, if you alter the Size and chosen as the background will be used to erase pixel data from Opacity of the Eraser Tool, those transparent areas can either the photo as if it were a solid coloured brush. You can also set be fully transparent or partially transparent, depending on brush the Size and Opacity of the eraser. 

opacity settings. 

The Background Eraser Tool (E) is a useful one for targeted 3

You can alter the Size and Tolerance of the brush, as well as 4

removal of certain parts of an image. It behaves a little like the softness and spacing of the brush you use. Tolerance the Colour Replacement Tool but in this case, any pixel colour is key to setting the sensitivity of the brush to changes in colour. 

beneath the cursor is erased, leaving the area transparent when High Tolerance will mean more varied colours are removed under it's on a layer. 

the cursor position. 

In our example, the blue can be removed sky from the 5

The Magic Eraser (E) is a more global erasing tool. Set your 6

photo by placing the cursor over the blue areas to be Tolerance higher for more colours to be included or lower removed. As you click and drag the mouse, any blue that falls to pick out less shades of the target colour at the cursor position. 

under the cursor position will be removed, but the white clouds When you click on the blue sky, large swathes of that colour will remain untouched since they are not blue. 

be removed with each click of the mouse. 
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Paint Bucket Tool

The Paint Bucket Tool (K) allows you to fill areas with solid 1

You can fill and entire layer, or it can be used to fill specific 2

colours. You can set Opacity, Tolerance and Blend Mode. 

areas based on what edges it encounters. Our example High or low Tolerance settings mean it will use edge detection to has a cartoon character on a white background. His outline is decide which areas can be filled or ignored. 

quite well-defined so clicking with the paint bucket means the background can easily be filled with a colour. 

You will notice there is an option for Contiguous fill. If it is 3

In addition to the Paint Bucket, you also have the Pattern 4

ticked, only the nearest neighbouring colours will be filled. If Fill option. Once again you have Tolerance settings and the Contiguous button is unchecked, then all matching colours in Opacity values to alter. Choose a pattern and use that to fill an the image will be filled, no matter where they are in the photo. 

entire layer or in the case of our cartoon, the blank background can be filled with texture. 

Gradient Tool

The Gradient Tool (G) lets you fill areas of your image or 1

You can pick the kind of gradient you want to use by 2

entire layers with colours that fade from one to another or clicking on the Gradient Picker and choosing a preset from can fade from one colour to transparent. The Gradient Tool does the list. They range from Foreground to Transparent to multiple not use edge detection. If you need a filled shape, it needs to be colour gradients all at the click of a button. 

defined by a selection. 
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If you want to make your own gradient, you can click on 3

Our example of a camera on a white background could 4

the Gradient Editor and add what are known as Colour use some colour. The background has an active selection Stops to a basic gradient, change their colour and define if they around it to enclose the gradient when it is added. You can click are solid or transparent. Any custom made gradients can be and drag your cursor to draw out a start point and an end point saved as a preset. 

for the gradient to follow. 

When you let go of your mouse, the current gradient will 5

If required, you can change the type of gradient you are 6

be applied and fills the active selection around the camera. 

using from its default. You can also use Radial gradients, The default Gradient Type is linear, meaning that the gradient Angle, Reflected and Diamond gradients. They can all have their travels in a straight path from start colour to end colour. 

Blend Mode altered as well as Opacity. They can be reversed and Transparency and Dither turned off. 

Colour Picker

The Colour Picker (I) does as the name suggests. When you 1

You can choose whether it samples a single pixel or a 3 x 2

choose this tool, it gives you a small eyedropper cursor that 3 average or a 5 x 5 pixel area to create an average. The when clicked on a photo, picks the colour beneath the cursor colour it samples can be across all layers or a single layer. 

position and makes it the active foreground colour. 
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Custom Shape Tool

Choose from a number of predefined shapes and add them 1

Once you have chosen your settings, you can draw out 2

as vector shapes on a new layer. Choose their colour and the shape on your photo. You can click and drag from the Layer Style from the Style picker. You can also choose whether corner outwards or choose From Centre to draw the shape out they are of fixed size or unconstrained and if you add to a shape from the cursor position. The shape will fill with your chosen or subtract from it. 

colour when you let the mouse button go. 

Horizontal Type Tool

The Horizontal Type Tool (T) gives you a multitude of text 3

You also have vertical text options, text for masking and 4

options. Choose your font, its colour and size. You can then the ability to fit typed text to a shape or path. Our example type on your document and a new text layer will be added above shows a butterfly's outline with sample text following the outline your photo. The text can be manipulated and bent into a curve or of that shape. 

other shapes for creative effects. 

Pencil Tool

The Pencil Tool (N) is designed to act like a real world pencil 1

You are then free to use your mouse or tablet, to sketch and 2

and is a hard-edged tool that has a number of preset pencil draw with your pencil as you see fit. You can draw directly tip shapes to draw with. You can choose the Size, Opacity and over your existing image or create a new layer and draw on that Blend Mode for your pencil strokes along with its colour. 

so as to preserve your original image. 
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Modify, Crop, Move 

and Recompose

The Modify section of the toolbar contains a set of tools that give you the ability to crop in a number of ways and to scale your images but protect certain parts from being affected during the scale. You can also move the subject of your photo from one part of the scene to another. 

Crop Tool

The Crop Tool (C) is the most common method of cutting 1

You can use set proportions to crop or you can go it alone 2

areas of your photo off in order to change the composition with no restrictions and make your own crop. Simply click and proportions. When you click the tool, the options panel will and drag your mouse across the area of the scene that you want display some suggestions for you as to how it thinks the image to be cropped and a gridded box will show you the current crop. 

can be cropped. You can use those or make your own crop. 

You can click the green commit arrow to proceed. 

Within the crop tool options you also have the Cookie 3

With your shape chosen, you can drag it over your image 4

Cutter Tool (C), which lets you cut out images using a and scale it to cover the area of the photo you want to number of preset shapes. You can choose from all the available crop. If you tick the From Centre button in the optional panel, the shapes such as butterflies, snowflakes, graphic symbols and shape will be drawn outward from your cursor position. You have much more. 

the option to feather the crop if you want. 
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If you hold the Shift key as you drag, you can keep the 5

The Perspective Crop Tool (C) lets you draw a crop box 6

shape's proportions locked. When you let go of the mouse, around a specific part of your photo that is distorted and the image will be cropped in your chosen shape. You then have gives you a chance to crop and remove the distortion at the options available that let you Rotate, Scale and Skew the shape same time. You start by drawing a crop box around the area you until you have it how you want it. 

want to crop. 

You can then begin to manipulate the crop box to match 7

When you click on the green commit button shaped like a 8

the perspective of the object you are cropping. Use the tick, the Perspective Crop Tool will crop and stretch out the control points around the crop box to drag the box out to match image, removing the distortion. It may take a couple of attempts the subject. In our example, the road sign gives us some helpful but it can help you rescue some tricky, distorted images. 

straight lines to match the perspective. 

Recompose Tool

The Recompose Tool (W) uses content aware scaling 1

Here is an example of a rally car with a lot of empty space 2

technology to let you scale images to a different to the right. It could be cropped but this image provides proportion, but only scale areas with no detail. You can also a good excuse to try the Recompose Tool. The options panel select areas to remain untouched by the scaling process for a displays a number of tools to help you with the scaling process. 

much better final result. 
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You can use the Mark For Protection brush to highlight 3

Once you have marked out your image and have either 4

areas that you want kept intact and untouched during selected areas to protect and areas to remove, you can the scaling process. Similarly, you can also make areas that you click and drag on the control points around the perimeter of the want removed. You can adjust brush Size and Threshold and image. In this case, we are going to drag the right middle control any scaling restrictions you wish to apply. 

point inwards. 

You can begin to drag the control point inwards and as 5

The control point can be dragged all the way across the 6

you do, all the areas that are unprotected will concertina image. All the dirt and dust on the right of the image has together and the program will attempt to blend that pixel data been merged into the space that remains now the image is half together. The areas that are selected to be protected will not be the width it was originally, but the car is unchanged. 

crushed together. 

Content Aware Move Tool

the Content Aware Move Tool (Q) uses similar technology 1

The options panel gives you some simple tool parameters. 

2

to the Recompose Tool but in this case it lets you move You will need to draw a selection around the object in an object in your photo and place it elsewhere in the shot and the photo you wish to move. You can add or subtract from the blends it back in and fills the original gap left by the subject. 

selection you've made by using the New, Add, Subtract and Intersect options provided. 
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With the tool active, you can draw around the subject 3

Enclose your subject in a selection and then drag it to its 4

that is going to be moved. Be aware that areas with new location. The Healing slider controls how aggressively complex content can be a challenge and the area you move it tries to blend the image into the new location and also fill the your subject to needs to be of a similar texture and colour for it gap it leaves behind. The Mode can be altered from Move to to work properly. 

Extend to stretch your selection if required. 

The Content Aware Move Tool will blend the image 5

We tried the sailboat image and also a simple object on 6

together. It can be a hit and miss process and may require grass. The grass image yielded better results after a few the settings to be tweaked. You can also try selecting more of attempts but it still needed some cleaning up with the Clone the area around your subject for more blend data to be used. 

Stamp Tool to remove some obvious artefacts and blend in some untouched grass. 

Straighten Tool

The Straighten Tool (P) will easily take care of wonky 1

Simply click and draw along a slanted horizon line that 2

landscape photos and get them level again. You have a needs to be level. When you let go of the button the number of options as to how the image is handled once horizon will be levelled. There is an option to Autofill Edges. 

straightened. The canvas can grow as required when rotated, When the image is rotated, any blank areas will be filled with stay the same size or be cropped to remove the background. 

nearby similar textures. 
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Panels and

the Panel Bin

The Editor workspace environment is a fairly intuitive space with which to interact. It has a comprehensive set of tools and menus. Chief among these is the Panel Bin and the various Panels that provide access to information, history, navigation, effects and tools. 

In the Editor workspace, the Panel Bin is found to the right 1

Below the Panel Bin, in the Taskbar, are the various 2

of the main Edit pane and contains listings of effects and buttons that let you access and switch between: the filters. By default, the Elements Photo Editor starts up Quick Layers panel, Effects, Filters, Styles and Graphics. Under Filters mode and the Panel Bin contents are displayed, one set of for instance, the Panel Bin displays the Artistic filter options in examples at a time. 

its first category. 

To the far right of the Taskbar is the More button. If you 3

Click the More button again, to hide the panels. Now, go 4

click it (not the small triangle next to it), you can open up back and this time, click on the small triangle and choose the rest of the Editor panels. These additional panels open in a Histogram. The floating panels will appear again, but this time tabbed group that floats on top of the Editor workspace. The the Histogram panel will be uppermost in the group of tabs Info panel is uppermost amongst the tabs. 

visible in the panel. 
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As an alternative to this method of controlling the panel’s 5

If you call up the tabbed panel group again, you can click 6

visibility, you can show and hide the various panels by and drag on any of the named tabs on that panel and set going to the File menu and choosing Window. From here, you them afloat, on the workspace, as a panel on their own. The can access those selfsame panels, via the More button and the panels can be dragged anywhere around the workspace to suit small triangle next to it. 

your working preferences when editing. 

You can also drag one tabbed panel off the main tabbed 7

You can, therefore, set up a tabbed group that contains 8

group and drop it onto the single panel floating on its own. 

your preferences only and then clicking the cross in the top For example, if you dragged the Histogram off as a single panel, left of the panel can close the original group. Click More to hide you could drag the Actions tab across from the original panels, and show the custom panels. If you close the custom panel, it will drop it onto the Histogram panel and merge them. 

go back to the default, tabbed group. 

You can also drag two panels away from the main tabbed 9

To save space while you are working, if you don’t require 10

group and dock them together. Drag one out on its own, the docked panels you can easily collapse them until you then drag another and position it at the bottom of the single need them again. Double-click on each name tab and that panel panel. A small blue line will appear, to indicate that the two will collapse down leaving just the name tab visible. Click it once panels can now be docked together one above the other. 

to open it again. 
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Customise the 

Panel Bin

As you become more proficient with the Photo Editor Expert mode, you may find that it is preferable to switch from the Basic mode to a Custom mode for more targeted effects and tools to suit your needs. In Custom mode, the Panel Bin can display more than one panel at a time. 

The beauty of the Custom mode, when arranging your Panel 1

In the Expert mode workspace, go to the small triangle 2

Bin, is that you can arrange the panels you use the most (to the right of the More button), on the Taskbar, at the and dock them so you are not cluttering up your workspace and bottom far right of the screen and click it. At the bottom of the editing window with too many panels. You also have the benefit menu that pops up, select Custom Workspace to activate the of not needing to use the Menu commands to access them. 

custom mode. 

When you switch to the Custom Workspace, you'll notice 3

Now in the Custom Workspace: Layers, Effects, Filters, 4

that the icons for: Layers, Effects, Filters, Styles and Styles and Graphics are all tabbed and docked at the top of Graphics have been removed from the Taskbar. You can still the main Panel Bin. To display any particular panels and access access those panels, but the custom mode has moved them. 

their contents simply click each of their name tabs. 

Only the More button remains in the bottom right of screen. 
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Just as in the Basic Workspace, you can still access other 5

By clicking on the More button, you can open the floating 6

panels by going up to the File menu, choosing Window tabbed group containing the Info, History, Navigator, and then choosing which panel you want to open. You will see Actions, Color Swatches and Histogram panels. From here, you that there is also the option to hide the Panel Bin or rest Panels can drag either the entire group, or individual panels, onto the entirely. The More button can also be used, as before. 

bottom edge of the Panel Bin, by their name tabs. 

When you drag the floating panel group over the bottom 7

You can take that idea further by opening another panel 8

edge of the Panel Bin, a blue line will appear to let you or dragging more panels, that are currently floating, and know that you can dock the floating panel to this new position. 

dock them beneath the ones you added previously. This means When you let go of the mouse, the panel will appear docked to you can have a Panel Bin that contains just the panels you want, the bottom edge of the Panel Bin. 

arranged how you want. 

You can dock as many panels, under each other, as your 9

Finally, if you decide you want to remove one or more of 10

monitor resolution and workspace allows. This is a great your panels, you can simply click on a desired name tab to way to keep your Editor window free of clutter and panels you bring that one to the front and then you can click on the small don't need. Any tabs you want moved, to create a different order, Menu icon in the top right of the panel window and choose Close can be dragged into a new position or docked elsewhere. 

to remove that single panel. 
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How to Correct 

and Enhance

Using the Instant Fix option within Elements Organiser is usually enough to save an image that is in need of adjustment. For the remainder, you may be in need of the Photo Editor as it offers a lot more control. It is also important to understand a photo's inherent problems so you can correct it accordingly. 

The Photo Editor can be accessed from the Home Screen when 1

Highlight one or more of the images you want to work on 2

you first open up Photoshop Elements. If you don't yet know in the Photo Editor and then go to the Editor button down which images you are likely to be working on, it is better to open in the bottom left of the taskbar. There is a small arrow next to Organiser first and locate the photos in need of some attention. We it and this opens up editing options in other programs. For this have some photos with various problems in our example. 

example, just click on the main Editor button. 

When you click the Editor button, it will open with the 3

Depending on whether you've already been using the 4

photos you had selected in Organiser, displayed in the Expert mode, for good housekeeping, go to Window > Photo Bin, ready for working on. If it isn't already, click on Reset Panels to put all panels back in their default arrangements the Expert mode at the top of the screen to put you in the and positions. If you can't find your photos, or the Photo Bin, go workspace with its more advanced toolset. 

down and click on the Open Photo Bin button, in the taskbar. 
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To the right of the taskbar, click on the small arrow beside 5

Change the Channel setting by clicking on the menu and 6

the More button. From the menu that appears, choose changing it from its default of Colours to RGB. This gives a the Histogram option. The tabbed group of panels will appear, more simplified histogram display. If there is a small yellow alert with Histogram as the active panel. The histogram is a graphic symbol in the top right corner of the display, click on it to refresh representation of the tonal values spread, from darkest to lightest. 

the histogram information. 

Our first, example image, has a histogram with reasonable 7

The next photo in our example has practically no data at all 8

image data at either end of the graph, but the large dip in at either end of the histogram. There are no dark shadow the middle suggests areas of the tonal range where it is lacking in areas and no bright highlights. As a result, all the data is bunched midtone contrast. A lack of midtone contrast can make an image up in the middle of the histogram. This is an image with little look a bit dull, lifeless and underexposed. 

contrast, since it is comprised mostly of middle tones. 

The final image shows a histogram that is very biased towards 9

Our three example images are fairly common in their 10

the left of the graph. This is an image where the majority of the deficiencies. However, in general, images that are too dark, tonal range is made up of shadow, with very little mid-tone detail too light and lacking in contrast are easy to put right. Now that and almost no highlights. Any image with a histogram pushed this their particular problems have been identified, you can set about far to the left is very underexposed with little, visible detail. 

rectifying each of their issues and improve them greatly. 
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Levels

Adjustments

Once you understand what the Histogram is telling you, you are armed with the necessary information to be able to make effective and dramatic changes to the overall look and quality of your less than perfect photos. The Levels adjustment option is a very effective way to improve an image's tonal range. 

We have another example, which is a low contrast image. 

1

In the Input Levels window, the Levels panel will show you a 2

The histogram shows the tones in the photo bunched up in recreation of the histogram for that image, displaying how the middle of the graph. To access the Levels adjustment, go to the tones are distributed. Directly below the window are three Enhance > Adjust Lighting > Levels. The Levels panel will open. 

sliders: the shadows slider to the left, the mid-tone slider in the To begin with, make sure the Preview option is checked. 

centre and to the right, the highlights slider. 

Manual Levels adjustment is usually based on personal 3

Next, click and drag the highlights slider to the left so it 4

preference, although the image here clearly requires more touches the right edge of the graph; the lighter parts of the contrast. To begin, click on the shadows slider and move it to image will get brighter. Continue to tweak both the shadow and the right so it touches the left edge of the graph. As you do, the highlight sliders, until you have the spread of dark and light tones image will get progressively darker. 

that you prefer. 
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Now you can tackle all the middle tones in the image. 

5

After some tweaking of all three sliders, the image now 6

Click on the mid-tone slider and drag it either to the left to has a lot more contrast and is a fairer representation of the brighten all the middle tones, or to the right to darken them. A original scene, at the time of capture. The muddy low-contrast small amount will make a significant difference, so be subtle with image is now stronger with more saturated colours, as a result. 

your inputs. 

If you look at the Histogram panel, you will see that it shows 7

Although the Levels panel has an Auto button, to make a 8

the original histogram display, along with the new adjusted best guess at how to adjust the image, it is always preferable version overlaid, so you can see the difference. Now the graph to get hands on, as you can get a feel for the changes you are has a more even distribution of tones from shadow to highlight making and see the results of your own input. You also have the rather than being bunched in the middle. 

option to use the Set Black Point and Set White Point eyedroppers. 

The Set Black Point eyedropper lets you click anywhere 9

Take into consideration that as you make adjustments, you 10

on your photo and whatever tone is beneath it, becomes run the risk of degrading the image. Any edits will affect it the darkest part of the photo. Watch out as this can make your to some degree, so watch your histogram as you edit, the more image far too dark. The Set White Point works in a similar way; gaps appearing in your graph, the more image quality is being any part of the image you click on becomes the brightest part. 

affected and data lost. 
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How to Use

Colour Balance

Although modern cameras and smartphones have good image quality, even the best device can be fooled by tricky lighting conditions and deliver a photo that has an unwanted colour cast on it, making it too blue, or too yellow in the case of tungsten lighting conditions. 

Our example image was taken with some lights that 1

We are going to use the Quick edit mode on the Elements 2

produce a very yellow colour cast. The camera that took Photo Editor. If it isn't already in Quick mode, click on the the photo was set on auto white balance, but even this was mode selector at the top of the screen. To clean up the Quick not enough to offset the yellow tint (typical of indoor tungsten edit workspace, in case there are any panels floating around, go lighting), cast over the scene. 

to Windows > Reset Panels. 

To modify the colour balance, first open up your image. It 3

If it isn't already active, go to the bottom right of the 4

helps to assess what you're doing so in the top left of your taskbar and click on the Adjustments button. The various screen, click on the View button. Here you can select a Before & adjustment options available are displayed in the panel on the After - Vertical view, so you can see the effects of your choices. 

right of the screen. Since our example image has an issue with both colour balance and tint, we need to use the Balance options. 
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Click on the Balance button and it expands to show you the 5

Temperature adjustment is represented by a grid of nine 6

Temperature and Tint tabs. These two controls can help you thumbnails with your original in the centre to provide a get your image closer to how it would look, if the colour cast of reset, if you want it. Around it are variations making the image the lighting had been compensated for at the time of shooting. 

either cooler in tone or warmer. When you click on a variation Begin with Temperature. 

option, it appears highlighted by a blue frame. 

Obviously, the variants at the extremities may prove too much 7

With the Temperature adjusted towards the cooler end, 8

for this image, so it’s simply a case of rolling over each one the image is looking a little more neutral than it did. Next, to see the result. One or two thumbnail options towards the cooler you can click on the Tint tab and use the thumbnail previews to end of the variations may be enough. Failing that, for more subtle add more green or magenta to your image, to help remove more control, you can use the slider directly above, or enter a value. 

colour cast. 

Here, it is apparent that the image is very slightly too green. 

9

Go to Expert mode and call up the Histogram panel, from 10

To help offset this, you can compensate by choosing a here you can compare the before and after effects of your more magenta thumbnail. One click toward magenta may prove adjustments. At first, there is marked separation of the three too much, so, as with the Temperature adjustment, you can use colours making up the image. Once the adjustments are made, the the Tint slider instead. In this case, a value of 12 was enough. 

colours show much less separation. It's not perfect, but it is better. 
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Enhancing

Colour

The Guided edit mode offers ways to affect the colour of your photos. There are creative colour options such as Lomo Camera Effect, plus a couple of more technical options for more standard and technical correction of colour cast in your photos. We will have a look at a more technical approach. 

As you've seen, you can remove a colour cast using the 1

The Enhance Color effect can be found under Guided edits 2

Quick edit mode's Balance functions. Now compare that and by clicking on the Color category selector. There are to what you can achieve using the Guided edit modes. Although several colour effects listed here, but Enhance Color allows you there is a remove Color Cast guided option, in this case, we will to work with a broader set of colour correction options, enabling look at the Enhance Color option in more detail. 

you to do more with your images. 

In our example, we clicked the Open button in the top left 3

Launch the Enhance Color guided edit and in the View menu 4

of the screen and navigated to a folder that contains an in the top left bar, above your edit panel, choose the Before image of glassware that has a definite colour cast. Select your 

& After - Horizontal option, so you can monitor the effect you are image and click Open to send it to the Photo Bin ready for the having on the photo. In the file menu, you can also choose View > Guided edit to be applied. 

Fit On Screen or zoom in and out for the best view. 
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When using this Guided edit mode, you only have two tools 5

Your first available option is the Auto Fix button. Clicking 6

in the toolbar on the left of the screen: the Zoom Tool for this will automatically attempt to fix both colour and zooming in and the Hand Tool for moving the image around. All contrast in the photo. One click will make an improvement and the other tools you require are in the main panel on the right remove some of the colour cast, but you can actually choose to hand side of the screen. 

click Auto Fix several more times for continued enhancement. 

Below the Auto Fix button, you are presented with three 7

If you move the Hue Slider to the left, colours are shifted 8

sliders, which you can use to add further fine-tuned through the spectrum. Yellow becomes red, Turquoise turns adjustments to the Hue, Saturation and Lightness of your photo. 

green, blue shifts to turquoise and red becomes purple. In this Start by clicking and dragging the Hue slider to experiment with case, small shifts of the three sliders are enough, but it could still how it shifts colours. 

do with a little more punch. 

Click Next in the lower right and then click Done. Go to 9

In our example, the Highlights slider is fine at its default, 10

the Basics category and choose Lighten and Darken as but pushing the Shadows and Midtones sliders to the right, your Guided edit. We will forego the Auto Fix option here and creates a lot more contrast. You can experiment with your own just concentrate on the three sliders that you can use to control images until you have something that suits your taste. Then you Shadows, Highlights and Midtones. 

can click Done and Save your image. 
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Quickly Resize

Your Photos

Odd as it may seem, resizing photos is not something people generally have to worry about, particularly when submitting images to social media sites since automatic processes normally do the work for you. If, however, you need to meet a very specific size requirement, then read on. 

Open up the Elements Photo Editor and click on the 1

Before you start, in the top, far left corner of the Guide 2

mode selector panel at the top of the screen, then choose workspace, click on the Open button (not the small arrow Guided. This switches you to the Guided edit mode. Before next to it). This opens up a browser window where you can starting, you will need a photo that requires some specific sizing navigate to the image you need to resize. When you have it, and scaling. 

double-click or click it and then click on the Open button. 

The chosen photo will now appear in the Photo Bin of the 3

Listed in the panel, on the right of the screen, are the steps 4

Guided edits workspace. The Resize Your Photo guided needed to resize the photo. The first choice you need to edit can be found in the Basics category. Click its preview and make is whether your image is intended for Web or Print usage. 

it will launch the resize editor using the photo currently in the Our example is intended for use on the web, but it is a large 5MB 

Photo Bin. 

file that’s nearly 6000 pixels on the long edge. 
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Since we want to reduce the size of the image significantly 5

Our example had its Long Edge reduced from 5981 pixels 6

for Internet use, click on Web. Under Select A Size, you can wide to 800 pixels wide. If you choose Width and Height, choose from a number of options to suit your preference. Now you can then specify these measurements to create a cropped you can specify, in pixels, what the target size of either the long box, within which you can move the preview image by clicking or short edge of the photo is going to be. 

and dragging it, until you have a crop that you like. 

When you have your preferred crop, you can click the Next 7

If you reset the Resize Your Photo procedure and choose 8

button and choose your Save, Save As or Continue Editing Print, as your Output Option, you’re presented with some options in either the Quick mode or Expert mode. Any image similar size options, along with some typical print sizes such as you choose to Save As, will be saved with an 'edited-1' extension, 8x10". Choosing one of these will give you the option to check to tell it apart from your original image. 

the Shrink To Fit button. 

Shrink To Fit will make sure the entire image is small 9

Unlike the Web output option, when you click on the Next 10

enough to fit in the 8x10" print size, while still maintaining button to access the Save or Continue Editing options, its original proportions. In doing so, you may find that there are you also have the Print option dialog box available, where you some white spaces either side of the image. Be aware that these can print out your resized 8x10" image onto the paper size of will be saved as part of the actual photo. 

your choice. 
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Selecting Fine 

Edge Detail

In many respects, making complex selections is time-consuming and tedious. 

This is particularly true if you are trying to make a selection of some very fine detail, such as hair or fur. Using a Lasso, or even the Quick Selection tools, will prove difficult and this is where the Refine Selection Brush can help. 

We have an example image of a dog that we would like 1

We can open the image of the dog from either: the 2

to cut out of its background and either use it isolated as it Elements Organiser workspace, by selecting it and then stands, or dropped into another background. When it comes to clicking on the Editor button down in the taskbar, or we can go selecting and cutting out, fur, hair, grass and foliage make for a straight to the Photo Editor and choose Open in the top left of testing time. 

the workspace, or File > Open from the file menu. 

If it isn't already active, we can go down to the taskbar and 3

We begin this example by choosing the Quick Selection 4

in the lower left corner, click on the Tool Options button. 

Tool (A) from the toolbar. In the Tools Options panel below, Now, whatever tool we choose from the main toolbar on the left we will see a number of other available tools and settings. We side of the screen, will display its available options in the Tool will need these to help the process of selecting the dog's fur Options panel. 

more accurately. 
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We’ll make the Size of your Quick Selection Brush about 60 

5

If the selection goes wrong and we choose too much of the 6

pixels and then move the cursor onto the image of the dog, background, we can press Cmd + Z to undo one step and near the edges of its fur. Now we click and slowly begin to drag try again, keeping the cursor further away from the fur's edge. It the cursor around the inside edge of the dog. The selection will doesn't need to be a super-accurate selection at this point. Once grow bit by bit as it moves. 

we have the whole dog selected, we can proceed. 

After clicking on the Refine Edge Selection Brush in the 7

Carefully hover the cursor over the edge of the selection 8

Tool Options panel, any part of the image outside the edge where it turns red and the cursor should change from the of the Quick Selection will appear in red. We’ll make the Size 500 

larger Add Selection cursor to the Edit Selection Edge brush. 

px and Snap Strength and Selection Edge to their maximums. 

Once we see this, clicking and holding the mouse button will Then push the View Opacity to 100%, to make it solid red. 

activate it. Now we can start to move the cursor. 

We drag the Edit Selection Edge brush around the edge 9

The edge selection will be refined, so now we’ll click on any 10

of the dog, making sure to paint any areas of the fur edge selection tool, such as the Lasso, then right-click the dog. 

that need to be more refined. If necessary, we’ll go back over After choosing Layer Via Copy to create a new layer that contains any areas to make sure we have all the fur edges painted, before just the dog, we can turn the Background layer off. We can save letting go of the mouse button. 

this file as a PSD and place a new background behind it if we want. 
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Cleaning

a Scene

For anyone out taking photos on holiday or sightseeing, it can often be a frustrating scenario when you want to capture a scene, but it is always filled with cars or people meaning you never get a clean, empty shot. Thanks to the Photomerge option, you can remove any unwanted guests from your photo. 

If you are trying to capture a scene that is always busy, 1

We have an example street scene that demonstrates the 2

here's a great photographer’s tip. Set up your camera on principle. It was never quite clear of people, but several shots a tripod and shoot a sequence of images where people are in were taken and loaded into Elements Organiser. The best three many different positions in each shot. This can be used to your shots, which offered the most varied positions of people, were advantage later. 

chosen as the most useful in aiding our scene-cleaning attempt. 

Highlight the images you are going to use and then click 3

The images are named remove_1, remove_2 and remove_3. 

4

the Editor button, down in the taskbar. The Photo Editor Click on the Guided mode selector at the top of the screen will open and the selected images (three in our example) will and then choose Photomerge from the list of guided edits below. 

appear down in the Photo Bin. If the Photo Bin isn't visible, click The one we are going to use is the Photomerge Scene Cleaner. 

the Photo Bin button and it will appear. 

Click its preview, to open it up. 
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CLEANING A SCENE

You may be prompted to choose photos, or just click 5

There are three sets of people we need to remove from the 6

Open All to continue. For clarity, our three images are now Final green image. Click on the blue image in the photo bin, highlighted from left to right as blue, yellow and green. Drag one to make that the Source image in the left hand panel. Choose the photo (green in our example) onto the grey Final base image Pencil Tool, choose a Size and then paint diagonally over the first panel, on the right. 

couple in the centre of the right-hand Final image. 

This action selects the corresponding area in the blue 7

Now we need to remove the last couple from the very far 8

image and pastes it over the same spot in the Final image right of the Final shot. Click on the yellow image, to make on the right. Since the blue image had nobody in that spot, the that the new Source, in the left-hand panel. You will see the two couple in the Final image are removed. Do the same with the Pencil Tool marks you've already used, marked in blue, overlaid more distant couple on the right of the Final image. 

on the yellow image for guidance. 

Now draw a diagonal line that covers the far right couple 9

If you should require it, there is an Advanced Options tab 10

on the Final image and the clean portion of the yellow you can click to help you align your photos, if they weren't image will be pasted on the green Final image. The last couple taken on a tripod. You can click the same feature in different from the street scene are removed. You can use the Eraser Tool photos to be used as alignment guides. Then you can click Next to remove portions of the pencil strokes, if needed. 

and choose to Save or Continue Editing. 
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The Artwork 

Library

Photoshop is much more than just a photo editor for improving a photo's brightness, contrast and saturation. If you dig a little further, you will see that it can also double as a creative and versatile design tool to aid you in the creation of amazing art projects. 

The Elements Photo Editor provides you with a large and 1

Starting in Elements Organiser, you need to check that you 2

varied collection of effects, textures, shapes and frames have no images highlighted before opening the Editor. To that can be accessed either through the Create function, or in be sure, go to the file menu and choose Edit > Deselect. You can the Quick or Expert edit modes. In this example, we will open the also use Cmd + Shift + A on a Mac, or Ctrl + Shift + A on a PC, to Export edit mode and take a look at the Graphics panel. 

deflect all images. 

Click on the Editor button down in the taskbar, to open 3

Now, click on the small arrow next to the More button in the 4

up the Photo Editor, then use the picker at the top of the bottom right of the taskbar and choose Custom Workspace screen to choose Expert mode. If you've previously been working from the menu that appears. The Layers, Effects, Filters, Styles in the Editor and moved your panel layouts around, you can go and Graphics buttons will be moved to the top of the Panel Bin, to Window > Reset Panels to put it back to its default layout. 

in tabbed groups. 
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THE ARTWORK LIBRARY

For example, click on the Graphics tab to bring it to the 5

Below the set of Panel Bin tabs, you will see two menus. 

6

front. For a better look at the available graphic items, go to These allow you to sort what is displayed by choosing a the small menu icon, in the top right of the Panel Bin, click it and category from each menu. The first is a broad setting that filters chose Large Thumbnail View from the menu. You can also widen by certain categories, such as Type, Color, Event and Mood. The the Panel Bin by dragging its left edge outwards. 

second lets you choose from context sensitive lists for each choice. 

You can use these two sorting menus to view the available 7

If you choose By Word then in the second menu, instead 8

content in any number of permutations. If, in the first menu, of a list, you are presented with a text entry box where you you choose By Colour, you can then select a context sensitive list can type in your own search word and then click Find to see of colour choices from the second menu. Choose By Season and what is available, based on the word you typed in. For example, the second menu displays the four seasons to filter your search. 

type in 'sun' and any item matching will be displayed. 

Your other choice, for displaying Graphics content, is to 9

The other tabs behave slightly differently, as they have only 10

click on the Show All option in the first menu. When you one menu. Filters, for example, lets you choose from (and do this, all the content currently stored on your machine will be view) a single category at one time, or you can choose the Show indexed in one long list. To be able to view all the content, you'll All option to list all the Filters available in one go, as you did with need to drag the scrollbar to the right of the Panel Bin. 

the Graphics panel. 
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The Favourites 

Panel

Having explored the contents of the artwork library, you would be forgiven for feeling a little overwhelmed by the huge number of graphics, textures and backgrounds available. However, with a little bit of thought and time, you can select a group of favourite artwork items and set up a Favourites panel. 

Open the Editor, go to the file menu and select Window > 1

Click the Favorites tab and drag it over the lower edge of 2

Favorites. When a floating tabbed panel group appears, the Panel Bin. You will see a blue line appear indicating you you can drag the Favorites tab off the main group to isolate it can dock the Favorites panel beneath the Graphics panel list. 

and close down the other group of tabs. Drag the Favorites panel Click the top edge of the Favorites panel and drag it upwards to to the lower right of the screen, next to the Panel Bin. 

enlarge the panel window. 

You will see that the Favorites panel already contains a 3

Now you can begin the process of choosing your favourite 4

few basic examples. For a clean slate, click on each of the graphics items. If, for example, you are looking for wood samples in turn to highlight it, then click on the trash can icon in graphics, you can set the first menu to By Word and then enter the top right of the Favorites panel header bar. You can also right the word 'wood' into the text field and click Find. From the Filter click each sample and choose, Remove From Favorites. 

menu below, choose the Show All option. 
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THE FAVOURITES PANEL

Any graphic item that has 'wood' as one of its keywords will 5

Click on one of the items you want and drag it down onto 6

be displayed as a match, in the panel below. If you require your Favorites panel. That graphic item will then be added to a specific graphic item, instead of Show All, choose one of the your Favourites panel, you can continue to drag down more items. 

other options such as Frames and then only frame graphics that You can change your search parameters at any time to find other match will be displayed. 

items that you want. 

Replace the word 'wood' with 'paper' and click Find. Then 7

Change your top two menu options to By Object and 8

change the Filter menu option to Backgrounds and any Flower then select Shapes as your Filter listing and a series background items with paper, as a match, will be displayed. 

of black and white flower graphics will be displayed. As with the Now you can drag down your preferred selections of paper previous steps, you can drag across any that you want to use background to go with your wooden frame graphics. 

regularly, or for a particular project. 

You are not limited to dragging favourites from the Graphics 9

The Graphics library only contains a small number of 10

panel alone. The Effects and Styles panels can also be installed items, but many more are available. If a swatch searched by a particular type, or by clicking Show All and the results has a small blue arrow in its top right corner, this indicates it can be dragged down onto the Favorites panel. Be aware, anything is an online asset. You can place it in a project and it will be from the Filters panel cannot be dragged onto the Favorites panel. 

downloaded on demand and stored in your library. 
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How to Make

a Photo Book

The option to create a printed Photo Book is found under the Create menu in the top right of the Organiser and Photo editor screens, next to the Share button. The techniques and skills you'll be learning are applicable to the other options in the menu, so let's find out how to make one. 

In our example, we are going to make a Photo Book of 1

Depending on how many pages your book is intended to 2

some of our favourite landscape photos. The process starts be, you may not want all the photos to be included. If that by opening up the Elements Organiser and choosing a number is the case, you can simply highlight the ones you are likely to use of likely candidates for the book. We have a folder of 45 possible when constructing the book. Press Cmd and click on each photo landscapes photos ready for inclusion. 

you want to use. If you want them all, press Cmd + A to select all. 

When you have your selection of photos ready, go to the top 3

Once the Photo Editor has opened, the Photo Book creator 4

left of the Media Browser and click on the Create button. A will open. The first panel on the left shows you the available menu will appear with all the various options available. Click on size it can print that matches your locally installed printer. Click the Photo Book option and the Photo Editor, which will be used to on one of the Size options. We chose the 12.00 x 12.00 inches make the Photo Book, will be opened up automatically. 

option, for a square format. 
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HOW TO MAKE A PHOTO BOOK

At the bottom left of the screen, is the Autofill With 5

Next to the Sizes panel is the Themes panel. This contains 6

Selected Image checkbox. Make sure this is unchecked; a number of styles you can use for your Photo Book. If you otherwise, your book will be automatically and randomly filled click on each one, it displays a preview of the results for that with your images before you've had a chance to use your own particular theme. We opted for the Monochrome theme, as it was input as to placement and composition. 

simple and bold. 

Directly below the Themes panel is the Number Of Pages 7

Once the artwork assets have been downloaded, the book 8

box. Click on this and type in how many pages you would will be assembled. It will preview the Title Page as well as like to form your book. For example, if you type 8, it will create an show you the page layouts in the right hand panel. Since the eight-page document, plus a title page. Click OK and the assets for Autofill option was deselected, the picture boxes are all currently this theme will be downloaded, if you haven't used them before. 

blank and awaiting images to be dragged onto them manually. 

If your selection of images chosen within Elements Organiser 9

When you choose a Theme, it creates the Photo Book; it 10

are not visible, click on the Photo Bin button in the lower is done automatically and generates random layouts with left of the taskbar to make them visible. Now you have the basic each page of the book having a varying number of picture boxes, components you need to assemble your Photo Book. Before you do, at different sizes and in different numbers. If you review the you can make changes if you wish. 

layouts and want to change them, you can. 
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Having reviewed the previews, we decided that page 5 

11

The right hand panel will display a number of layouts you 12

needed to be altered, since the arrangement of three small can apply to page 5 to change the design. There are: the images was not going to be very impactful for our landscape Different Layouts options for multiple images and text, there is the images. If you look down in the lower right of the taskbar, there is One Photo layout choices and finally the Three Photos and Two a button marked Layouts. Click this to view alternate page layouts. 

Photos layouts. 

Choose a layout you would like to try, then click and drag 13

For our example, we chose a simple two-photo layout 14

that option before dropping it onto page 5.  Note that any with text, clicked it and dragged it across to the page we layout design that has a small blue triangle in its top right corner wanted to alter. You will see a progress bar as it takes affect and indicates that it is an online asset. Once you drag it over to your then the new one will appear on page 5.  If you don't like it you page, it will be downloaded automatically. 

can press Cmd + Z to undo, or try another layout from the list. 

Click on the Pages button to go back to your preview. Your 15

Now you can continue the process by adding your images to 16

choices for amending your page layouts don't end there. For the blank picture boxes. Make sure your Photo Bin is visible example, on page 4,  you can actually click and drag each picture and start adding photos. Drag one photo at a time from the Photo box to a new position and by using the corner control points, scale Bin and drop in onto your picture boxes. Be aware, if you click a the box or rotate it to make a number of custom page layouts. 

photo but don't hold and drag, it will open up in its own window. 
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Each photo that is dropped into a picture box, will display a 17

Continue to drag and drop your photos into their respective 18

small control panel that lets you: rotate it left or right, alter picture boxes, if you have a photo in the wrong box, you can the size of the image within the picture box or replace it with simply drag and drop the correct one over the top and it will be another image. You can also click and drag the photo to move its replaced automatically. Once you have it looking how you want, position within the box. 

return to the title page. 

The title page and page 5 both contain text, which you 19

The text will be highlighted and you can type in a new title. 

20

can alter. In the left hand toolbar, click on the Horizontal Double-click it again and you can go to the search fonts Type Tool; the Photo Bin will be replaced with the Type Options menu and, if you wish, choose a new font. You can also change Panel. To start, take your type cursor and double-click on the its size or colour and even warp the text. Alter the sub-title and Photobook Title Here text, to activate it. 

you can move on and edit the other text in the book. 

If the running order of the spreads is not quite right, you can 21

Your first Photo Book is complete. Go to File > Save As 22

alter that too. In this example, we decided that page 7 and 8 

and navigate to a folder where you would like to save your should be in front of the current page 5 and 6. Swapping the two project. You’ll notice that it will be saved in a PSE Photo Project spreads is simple; click and drag 7 and 8 in the preview so it sits Format. Give it a name and make sure both Layers and Include In above the current page 5 and 6 and it will be inserted there. 

The Elements Organiser are checked. 
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Photo Book 

Advanced Mode

Having created a Photo Book and saved the document, you can try a more advanced tweak that will pep up your book's backgrounds. To do this you use the Photo Book Advanced Mode. Essentially this opens your spreads in Expert mode in the Photo Editor and you can access the layers that make up the book. 

Start by going to File > Open and navigating to your saved, 1

Click on the Advance Mode button, situated in the top 2

PSE Photo Book artwork. Double-click it to open the Photo left corner of the edit window next to the toolbar. When Editor. You will see the Mode Selector buttons at the top of the you click it, your pages become editable and if you look at the screen but if you click them, nothing will happen until you first bottom right of the taskbar, you will see that a Layers button has activate the Advanced Mode. 

appeared, next to the Pages button. 

Click the Layers button and all the layers, masks and text 3

Now that we are in Advanced Mode, it is possible to edit 4

that were automatically created for the Photo Book's title the Background file and replace it. If you want to insert a page, will be displayed in the Layers Panel Bin. The layer we new graphic background, go to the taskbar in the lower right want to concentrate on is the bottom Background layer, which is and click on the Graphics button. When you do, all the available currently a black Smart Object. 

Graphics will be listed in the Graphics Panel Bin. 
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PHOTO BOOK ADVANCED MODE

Scroll down and choose whatever element you would like to 5

If it needs to be downloaded, you will see a download 6

use as a replacement for the black background. Remember progress bar and then the graphic you chose will appear that if an item has a blue triangle in the corner, it is an online asset as the new background image. Our example uses a Background and will need to be downloaded first. Drag your choice across and called Dark Brown Silk. You can drag/double-click any number of drop it onto the black background, or double-click it. 

graphic items to try them out, until you have the one you like. 

Click on the Layers button. The layer that originally contained 7

Go to Pages, choose another spread and then click back 8

the Background has been replaced by your choice of on Layers to view all the layers making up that spread. You graphic. If you add a Levels adjustment layer above it, you can can also add your own images to use as background if you want. 

make it darker or lighter to suit your taste. Add a Hue/Saturation Make sure the Background layer is active and go to File > Place. 

adjustment above that and you can also change its colour. 

Find an appropriate file, select it, then click Place. 

Your chosen image will be placed on a new layer above the 9

With the photo now in place, you can add adjustment 10

Background. The placed file will have control points around its layers above it to alter its look to whatever you like. In edges that you can click and drag to scale and move it. Use these our example, a Hue/Saturation layer was added to de-saturate points to scale the image until it fills the entire double page spread. 

the colour and make it lighter. Once you have added other backgrounds, if required, you're ready to print your book. 
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Now that you've experienced what Elements has to offer and how the major tools work, it's time to try out some more involved projects to help you hone your skills. The Quick and Guided workspaces are all well and good, but if you really want to understand more about digital manipulation then ŏ

it's time to fire up the Expert workspace and dive in. There's an old saying: 'the best way to learn, is to do'. ŏWith that in mind, let's do it! 
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Sky
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Blue skies are wonderful. They mean we are having a lovely sunny day. This is particularly meaningful if you live in the UK, which is often the butt of jokes about its horrible weather. 

No better time then to get out and take some photographs. The only problem you may find if you’re anything like us, is that landscapes shot on days like this can look a little dull. The light is great, but the sky is lacking in any drama and it’s just a big, blue, empty canvas. Sometimes the sky is lovely but it’s in the wrong part of the image in relation to the landscape you were trying to shoot. Well, there is an answer to your woes with sky swapping. It requires your primary photo and a photo of a cloudy sky. 
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SKY REPLACEMENT

To begin you will need your primary photograph. Go to File 1

Our example is a shoreline image taken on a beautiful blue 2

> Open (Cmd + O) and use the file browser to navigate to sky day. Unfortunately, that blue sky just looks a bit empty the location your photo is stored. You can double-click the image and is in need of a little attention to make it more appealing. 

to open it or highlight it and then click on the Open button in the All the trees and rock details below make the image look a bit lower right of the browser window. 

bottom-heavy. Some clouds should help. 

The first thing that will need your attention though is the 3

Go to the toolbar and in the Modify section and then click 4

horizon. In the case of this shot, the camera was tilted on the Straighten Tool (P) to make it active. When you do slightly and it means the horizon is not on the level. Luckily, there this, the options panel at the bottom of the screen will display is a tool that can help us sort this out with just a few clicks. 

all of the available parameters and options available for that particular chosen tool. 

When the image is straightened, you can choose how the 5

Since rotating the mage will create blank areas at the 6

crop is dealt with once the photo is rotated. You don't want edges of the photo, you can also select the Autofill Edges to lose too much of the photo so choose the Grow or Shrink option. This uses the Content Aware Fill technology to analyse Canvas to Fit option. This way, it won't matter how much the the nearest textures at the edges and fill in the blanks using image rotates, it will not be cropped. 

cloned texture. 
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Now you can actually straighten that horizon out. Take the 7

When you let go of the mouse, the Straighten Tool rotates 8

Straighten Tool and click and drag a line across a tilted the image enough to level out the shoreline. The entire area that you know has to be level. In the back of this photo is a image rotated about 6°, which has created blank areas as the shoreline which can be used as a guide. Drag along it from left canvas expanded to make sure the photo was not cropped. 

to right. 

When you choose to Autofill the edges, the blank areas are 9

If you click on the layer thumbnail for the photo, you can 10

now analysed and then filled with similar textures. Because rename it. We called ours 'shore'. Now the image is ready of the random fractal nature of the trees, rocks and sea, the filled for its blue sky makeover. Go to File > Open (Cmd + O) once areas match very well, with no obvious cloning errors to be seen. 

again and navigate to the folder where your cloud replacement photo is kept. 

Our example clouds were chosen because they are lit in a 11

Double-click the 'clouds' image to open it. Since you only 12

similar way to the primary photo at roughly the same time need the clouds, you can selectively choose just that area of day. This is an important consideration since you want the to add to the primary photo. Go to the toolbar and choose the clouds to look as if they belong in the shot; otherwise the effect Rectangular Marquee Tool (M). You can use this tool to drag a is going to look very odd. 

selection box from the top left corner to the right horizon. 
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SKY REPLACEMENT

When you let go of the mouse the selection you drew 13

Click on the document tab of your primary photo to make 14

will become active with black and white dashes known it active and go to Edit > Paste (Cmd + V) to paste the as 'marching ants'. With the selection active, go to Edit > Copy copied clouds onto the current photo. It will automatically appear (Cmd + C) to copy the selected sky area to the clipboard ready centred on its own layer so as not to destroy the shoreline photo to use in your photo. 

below it. By default the new layer is called 'Layer 1'. 

Go to the toolbar and choose the Move Tool (V). You can 15

You will see that an active layer element will have control 16

use this to physically click and drag the clouds into the top points around its perimeter. You can click and drag these left corner of the photo and set about making it the right size to control points in order to scale the clouds to fit the new photo. 

match the dimensions of the primary photo. 

In this example, clicking and dragging the far right centre control point to the edge of the photo. 

You can rename 'Layer 1' as 'clouds'. Now click on the little 17

Go to the toolbar and choose the Quick Selection Tool 18

eye icon to the left of the 'clouds' layer thumbnail. This will (A). You need to use it to make a selection of the sky area. 

make it invisible for the moment. You need to work on the 'shore' 

With the Quick Selection Tool active, you will see various options layer, so click its thumbnail to make it active. 

available in the tool options panel at the bottom of the screen. 

Choose a brush size of about 50 pixels. 
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Use the Quick Selection Tool to start selecting just the blue 19

With all of the sky selected, you can now use the Refine 20

sky. Drag the cursor over all blue areas, avoiding all others, Edge tool to make the selection even more accurate. Click and it will automatically select as you go. Because the tree line the refine Edge button in the tool options panel to open the is of a different colour and hard-edged, the selection tool has no Refine Edge dialog panel. In this case, the default Edge Detection real difficulty in choosing just the sky. 

and Adjust Edge settings will be fine. 

Simply start to brush over the areas where the sky meets 21

The selection edge will be refined, ready for the next step. 

22

the horizon line and trees. The Refine Edge tool will make Click the 'clouds' layer visibility icon to make it visible more accurate, targeted refinements, particularly around the tree again and you will see the selection, denoted by 'marching ants', areas. If you are happy that the selection is as good as it can be, overlaid on the clouds. Keep the selection active and make sure you can click OK to proceed. 

the 'clouds' layer is also active. 

Click on the Add Layer Mask button in the layer options 23

When you Alt + left-click on the layer mask thumbnail, you 24

panel and a layer mask will automatically be added to the can view the mask on its own in black and white. You can 

'clouds' layer in the shape of the active selection. Anything inside see how the Refine Edge Tool has quite accurately masked the the selection is white, anything outside the selection is black. 

trees and horizon. You can Alt + left-click the layer mask again to return to the normal view. 
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SKY REPLACEMENT

With masks, the rule of thumb to keep in mind is that white 25

It would be good if the sky was just a little darker to match 26

reveals part of a masked image, whereas black will conceal the exposure of the primary photo. Keep the 'clouds' layer areas of your photo. In this case, the clouds are allowed to be active and click the Create New Fill or Adjustment Layer. Select visible but anything below the trees is hidden by the black areas Levels from the menu that appears. A 'Levels 1' adjustment layer of the mask. 

will be added above the 'clouds' layer. 

Right-click the 'Levels 1' adjustment layer and choose 27

A small box with an arrow will appear to the left of the 28

Create Clipping Mask from the context menu that appears. 

adjustment layer thumbnail to indicate it has been clipped This will clip the adjustment layer to the 'clouds' layer which is to the layer below. A Levels dialog panel will open automatically, directly below it in the stack. Any adjustments made will only ready for you to make adjustments to the clouds. 

affect the 'clouds' layer and nothing else. 

The sliders in the Levels panel allow you to darken and 29

With that, your sky replacement is complete; you can go to 30

lighten the Shadows, Midtones and Highlight areas of the File > Save As and save your layered document as a PSD 

photo. Dragging the Midtones slider to the right slightly will file. This will keep all your edits intact should you ever want to darken the sky. You can experiment with all the sliders until you revisit this image and make more amends to it. 

have something you like. 
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Frequency 
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BEFORE

AFTER

Thanks to digital technology you can be a makeup artist and control exactly how you want your subject to look. Naturally, there are numerous ways you can go about retouching skin. Some techniques are very simple but do not give natural results. Some people take it to extremes and end up with their models looking like mannequins. All we are looking to do is make our model’s skin look as healthy and glowing as possible. We are going to use a technique called frequency separation. Simply put, you break the base image down into two components. 

One layer carries just colour and tonal information, the other layer holds detail and texture. This means you can work on one, without affecting the other. It’s a simple and effective method. 
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FREQUENCY SEPARATION

Our example is from a portrait shoot of a young model. 

1

Click the 'Background' layer to make sure it is active; it will 2

Open your photo in Elements as a new document. The highlight in blue to let you know it is selected. Then press young lady has little makeup applied and she has some spots Cmd + J to create a duplicate layer. Name this layer 'colour'. 

that the foundation couldn't obscure so we are going to improve Highlight the 'colour' layer then press Cmd + J once more to her complexion by removing the blemishes from her skin. 

create yet another layer which you can name 'texture'. 

Make sure the 'texture' layer is now highlighted and press 3

Make 'texture copy' and 'texture' invisible for the moment 4

Cmd + J one more time to create a layer that will be called by clicking on their visibility icons to hide them. Make the 

'texture copy'. These are all the layers you need to begin creating 

'colour' layer active. What you are going to do is turn this layer your two main layers of texture and colour to edit. 

into colour data only. To do that you need to blur this layer to remove any obvious detail. 
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Go to Filter > Blur > Gaussian Blur to call up the blur dialog 5

Make all the other layers visible again and make the 'texture 6

panel. Set the blur Radius to about 15 pixels. You have to copy' layer at the top of the layer stack active. You need to apply just enough blur to remove any hard details but leave the apply the same blur amount to this layer. Go to Filter and the top general shape and colour intact. Do not over blur the image and menu item will be the last effect you applied. You can also press merge colours together too much. 

Cmd + F to apply the last filter you used. 

The 'texture copy' layer is blurred to the same degree as 7

All the colours of the 'texture copy' layer will be inverted 8

the 'colour' layer. You can use this layer and the un-blurred like a colour negative. With the 'texture copy' layer still 

'texture' layer below it to create the second component needed active, move the Opacity slider down to 50%. What you see now for the skin retouch. To do this, go to Filter > Adjustments > is a combination of the 'texture' layer below and the current layer Invert (Cmd + I) to invert the 'texture copy' layer colours. 

at 50% opacity. These two layers need to be merged. 
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FREQUENCY SEPARATION

Hold the Shift key and click on the 'texture' and 'texture 9

Next, keeping the new 'texture' layer active, go to the Blend 10

copy' layers to select them both, then right-click them to Mode button and choose Linear Light from the dropdown call up the context menu. Choose Merge Layers to merge them list that appears. This will blend the 'texture' layer into the 'colour' 

into one layer. You can rename this layer 'texture' now that it is layer below and the result of the two should look identical to the ready to use. 

original image. 

You now have your two components. The top 'texture layer 11

Click on the 'texture' layer to make it active. Texture will be 12

is detail only with no colour data and the 'colour' layer is your first stop for cleaning up the skin. Go to the toolbar only colour information with no real detail. This is the process and choose the Clone Stamp Tool (S). When you click on it, of frequency separation in action. Editing is much simpler now you will see various options become available down in the tool colour and detail are separated from each other. 

options panel. 
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Go to the brush picker and choose a hard round brush. You 13

Now the process of cleaning the skin can start. Place your 14

can alter its size later. Hard brushes generally work better cursor over an area of skin that is clean and unblemished for the kind of cloning of skin we are about to do. You can use close to the first area you wish to start retouching. Press the Alt the Size slider to set a brush of about 25 pixels. To begin with, key and a small target cursor will appear. Left-click the cursor keep the Aligned box unchecked and keep Mode as Normal. 

over the clean skin to set that as your clone source. 

Now you can move your cursor over the nearest area of 15

Now you can carefully begin to clone clean skin over the 16

blemished skin you want to retouch. You should see a blemishes on her face. You can always press Alt and choose realtime representation of the clone source at the cursor position. 

a new area of clean skin as your clone source if the texture When you click over a blemish, the clean source area will be changes too much and needs to be updated. Remember that all 

'stamped' over the blemish. 

these edits are only happening on the 'texture' layer. 

Take you time with this part of the process. Keep changing 17

Once you are happy that her forehead is done, you can 18

your clone source to avoid the build up of repeating make amends to any other areas of her face and neck that patterns that give the game away as to the use of cloning. You might need cleaning up. You can remove wrinkles in exactly the can use the Size slider to make the brush larger or smaller, if same way by cloning smooth skin over them. Stray hairs can also needed, as well. 

be cleaned up as well. 
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FREQUENCY SEPARATION

Now that the 'texture' layer is completed and her skin is 19

Make the 'texture' layer invisible and make the 'colour' layer 20

looking great, you can turn your attention to the 'colour' 

active. Go to the toolbar and choose the Lasso Tool (L). The layer and even out any mottling that may be present. This is Lasso optional panel will show you various options available for an optional step, but it does give the portrait that extra level of this tool. Go to the Feather slider and set it to about 35 pixels to professionalism and is very flattering. 

soften the selection you are about to make. 

There is a small amount of mottling visible on her forehead 21

Press the Shift key or click the Add button in the options 22

which we want to remove, as well as softening the shadows panel to add more selections. An area around her left cheek around her left cheek, nose and chin. Draw around the areas you has also been included and again, softened by 35 pixels to avoid want to soften with the Lasso Tool. Join up to your start point any hard edges to the colour. Keep this selection active for the and the selection will be closed and softened by 35 pixels. 

next part. 

Go to the menu and choose Filter > Blur > Guassian Blur to 23

If you want, you can also do the same to the highlighted 24

call up the blur dialog panel. Set the Blur ratio to about 30 

areas of her right cheek to give more of a matt finish to her pixels or however much you feel is needed to blur those areas a skin. It behaves a bit like adding more digital makeup foundation sufficient amount, to remove any mottling from her face. Click to her skin. When you are happy, you can go to File > Save As OK to blur the selected parts of the image. 

(Shift + Cmd + S) to save your finished result. 
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Compositing is the combining of visual elements from separate sources into single images, often to create the illusion that all those elements are part of the same scene. In this tutorial we will be looking at a fairly typical approach for the two main elements of the image which is the grey/neutral background compositing technique. Shooting your main subject against a grey screen gives them a well defined edge that makes the process of blending them into another environment all the easier. Grey screen compositing is the choice of many graphics professionals and is easier to do than you might think. We have a scenario in which we have a photo of our subject and want to put them into a much grander environment than just a grey background. 
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COMPOSITE IMAGES

Go to File > Open and navigate to where the components 1

We have 'girl.jpg' and room.jpg'. You will see that the girl is 2

for the scene are stored. In this example, we have our on a grey background. All the lighting gear and extraneous subject image and a ballroom scene in which to put her. 

items present in the shot have been cloned out leaving just her Highlight your images and click Open to create two new tabbed and a plain grey background. The grey background is a key part documents in Elements. 

of this process. 

The other image we will be working with is a photograph 3

For the moment, return to the 'girl' document and click on 4

of a baroque ballroom. There is a perfect spot upon which the layer lock icon next to the layer thumbnail to unlock the the girl can be placed. Now, you have the two images that will be layer. Go to the 'room' image and do the same. Press Cmd + A to combined. You wil see that it is not done in the conventional way select all pixels on that layer and then press Cmd + C to copy the that you might imagine but is very effective nonetheless. 

'room' image, or go to Edit > Copy. 
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Go to the 'girl' document and go to Edit > Paste or press 5

Click the 'girl' layer to make it active. You need to make a 6

Cmd + V to paste the copied room image into the 'girl' 

selection of her outline to start the compositing process. 

document. It will appear on its own layer above the 'girl' layer. 

Go to the toolbar and select the Magic Wand Tool (A). Although You can name this new layer 'room'. For the moment, click the the Magic Wand is a fairly simplistic selection method, it actually visibility icon of the 'room' layer to make it invisible. 

works really well in these situations. 

Set the Magic Wand Tolerance to about 34 and make sure 7

Click the Add To Selection button and a small plus symbol 8

the Contiguous button is checked. Position the cursor over will appear on your cursor to indicate anything selected will the grey background surrounding the girl and left-click. The be added to the currently active selection. Now you can click and Magic Wand will select as much grey as the Tolerance setting add more grey areas until all the grey is selected. 

dictates. Now we need to add the parts it missed. 
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Make the 'room' layer visible and active again. You will see 9

Go to the layer options panel and click on the Add Layer 10

the selection you just made overlaid on the image as a Mask button. When you do, a mask in the shape of the series of black and white dashes known as 'marching ants'. This selection will be added to the 'room' layer. Anything within the selection can be used to create a mask in the next step. 

bounds of the selection will be white and anything outside the bounds will be black. White reveals and black conceals. 

You might notice that the girl looks a little too much like a 11

Any area of the neutral grey 'girl' background that is 12

cut out figure. You can remedy that by changing the Blend blended with the 'room' layer makes no visual difference Mode of the 'room' layer to Overlay. This blends the pixels of the but any parts of the grey background darker than about 50% 

'room' layer into the 'girl' layer. Only the girl is unaffected by the grey show up. This is great since the girl's shadow now appears blend because of the mask on the layer above. 

on the ground. 
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Now we can begin to make the whole image more 13

Keep the 'mist' layer active and go to the toolbar and 14

cohesive. With the 'room' layer active go to the layers choose the Brush Tool (B). In the tool options panel at the palette and click on the Create New Layer button. Call this new bottom of the screen, choose a large soft brush of about 700 

layer 'mist'. We are going to add a subtle atmosphere behind the pixels. Keep its opacity at 100%. Make sure the foreground colour figure which is a popular thing to do in images like this. 

is white. 

Take the brush and paint white on the 'mist' layer around 15

Right-click the 'mist' layer and choose the Create Clipping 16

the upper part of the girl’s outline. You will be painting over Mask option from the dropdown menu that appears. When your foreground figure of course but we can actually use the you clip the 'mist' layer to the 'room' layer, it inherits the mask as mask on the 'room' layer below to help us remedy the issue. 

well. Suddenly, the mist is appearing behind the girl even though it is on the layer above. 

174

[image: Image 175]

COMPOSITE IMAGES

The 'mist' layer will now have small arrow icon next to its 17

Next you can add some subtle lighting effects to the 18

thumbnail to indicate it is clipped to the layer below. At the candles and windows for a moody feel. Create a new layer moment the white brush strokes look way over the top. Reduce and name it 'candles'. Make sure it is at the top of the layer stack the Opacity to about 40% and add Gaussian Blur to the mist to and active. Go to the toolbar and choose the Brush Tool (B) soften it if you want as well. 

again if not still selected. 

In the tool options panel, chose a soft brush, click on the 19

Start to dab your white oval brush over each candle group 20

Brush Settings button and change the Roundness setting in the scene. You can use the Size slider to alter the size to 50% and the Angle to -90°. This will make the brush oval to match the candle sizes that are dotted around the scene. 

rather than circular. Set the Size to about 400 pixels and ensure Although the brush strokes are currently white, you can use that the foreground colour is still white. 

Blend Modes to get a nice glow on those candles. 
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With the 'candles' layer still active go to the Blend Mode 21

Go to Enhance > Adjust Colour > Adjust Hue/Saturation 22

button and choose Linear Light from the dropdown list that (Cmd + U) to call up the Hue/Saturation dialog panel. First, appears. There will be no apparent change at the moment but make sure the Colorize button is checked. Then set Hue to 19, the next step will create a cosy glow for the candle flames. 

Saturation to 60 and Lightness to -31. This colours the white brush strokes orange and blends them into the layers below. 

You can do a similar technique with the windows. Create a 23

Now set the Blend Mode of the 'windows' layer to Overlay, 24

new layer called 'windows' and use your oval white brush then go to Enhance > Adjust Colour > Adjust Hue/

to paint large dabs of white on the three main windows. You can Saturation (Cmd + U) again and click the Colorize button so it is use the Size slider again to adjust brush size to match the size of checked. Make Hue 34, Saturation 81 and Lightness -19 to add a each window. 

warm glow to the windows. 

Now, you can add colour effects to tie the foreground and 25

A 'Hue/Saturation 1' adjustment layer will be added to the 26

background elements together. Go to the layer options top of the layer stack. All the layers below it will be affected panel and click the Create New Fill Or Adjustment Layer button. 

by what adjustments are made. A dialog panel will open and now Choose Hue/Saturation from the dropdown list that appears. 

go to Saturation and choose a value of about -30 to desaturate the whole image slightly. 
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Next, go to the layer options panel again and choose 27

The Photo Filter dialogue panel will open when you add 28

Create New Fill or Adjustment Layer again and this time the adjustment layer. Set Filter to Warming Filter (85), select Photo Filter from the list. 'Photo Filter 1' will be added to Density to 100% and make sure the Preserve Luminosity button the top of the stack. You are going to add a colour cast to tie the is not checked. The whole image will look dark orange now but various elements together a bit more. 

not to worry. 

Set the Blend Mode for the 'Photo Filter 1' layer to Overlay. 

29

Change its parameters by choosing Deep Emerald as the 30

This makes the image very contrasty but if you set the Filter type. Density is 100% and now check the Preserve layer's Opacity to about 30%, the effect is much more subtle. 

Luminosity box to maintain image brightness. Set this new layer You can deepen the colour effect even more. Press Cmd + J to to 20% Opacity as well, to create a moody image where all the duplicate the 'Photo Filter 1' layer. Rename it 'Photo Filter 2'. 

colours look more harmonious. 

You can adjust the brightness by adding another 31

Your composite is complete. You can now go to File > Save 32

adjustment. Use a Levels adjustment layer and adjust the As (Shift + Cmd + S) and save it as a named PSD file. This Midtone and Highlight sliders to brighten the middle tones and saves the layered document so you can return to it at any time highlights a little. You can also alter the Shadow Output Levels to and make amendments to the image. 

about 21 to change the darkest colours to slightly lighter ones. 
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Dodging and burning have their roots in the days of analogue photography, long before digital cameras and computers were in use. Dodging refers to the technique of lightening an image at the darkroom stage by reducing the exposure of a photographic print in specific areas. 

Burning is the opposite, where parts of the image are exposed for longer onto the print, making those areas darker. With the advent of digital technology the process is done on a computer but the basic principle and its terminology remain the same. In our example we had a basic image that was lacking in contrast; using the dodge and burn techniques, brightness and contrast were selectively added to produce a much stronger image. 
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DODGING AND BURNING

Begin by opening a relevant image to work on. Go to File > 1

The image were are using as our example is a moody 2

Open (Cmd + O) and navigate to the location of the image portrait but it is quite low in contrast. You could use levels you wish to work on. Our example is a portrait named 'dodge adjustments or brightness and contrast, but they are quite global and burn.jpg'. Double-click it to open or select it and press Open amends. Using Dodge and Burn Tools you can be much more at the bottom of the browser window. 

selective in your approach. 

It's good procedure to work on a duplicate of your image 3

Right-click your 'Background' base layer and choose 4

rather than your original. You never know when you might Duplicate Layer from the menu that appears. The Duplicate need to call upon it. It's better to have it and not need it, than Layer dialog panel opens and you can choose a name for your need it and not have it. 

new layer and then click OK at the top right of the panel. A new duplicate layer called 'base' is created for you. 

You can use a great little non-destructive method, as we 5

Go to Edit > Fill Layer to open the Fill Layer panel. Rather 6

did, for applying Dodge and Burn effects to your image than selecting the dual options of Foreground Colour or without altering its pixel data. Make sure the 'base' layer is active Background Colour, choose 50% Grey as the fill option. The and then go to the layer options panel and click the Create A reason for this will become apparent in the following steps. The New Layer button. Name this new layer 'dodge'. 

'dodge' layer is filled grey, obscuring the portrait for the moment. 
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Keep the 'dodge' layer active and go to the Blend Mode 7

We needed a second layer just like the 'dodge' layer and 8

button and choose Overlay as the blend. Because the grey could have just pressed Cmd + J to duplicate it but we is 50% neutral it will not be visible using Overlay as the blending wanted to show you another method of creating the 50% grey mode. Anything lighter or darker will have an effect on the layer layer with the blend mode applied and ready to go. 

below. This is key to the non-destructive method. 

Go to Layer > New > Layer (Shift + Cmd + N). The New 9

A new layer called 'burn' will be created for you that is 10

Layer panel will open. Under Name, call the layer 'burn'. 

already filled with 50% grey and set to the Overlay Blend Keep Colour as None and under the Mode button, choose Mode. You now have the two layers needed to start Dodging, Overlay as the Blend Mode. Then make sure the Fill with Overlay-to make the picture lighter and Burning, to make areas of the Neutral colour button is checked. 

picture darker. 

Begin by making the 'dodge' layer active. It will highlight in 11

Under Range, choose the Midtones Painting Mode and 12

blue to confirm it is active. Go to the toolbar and choose under the Brush picker, choose a soft brush of about 200 

the Dodge Tool (O). The tool options panel will show you the pixels. You can use the Size slider at any time to alter the brush available parameters you can apply to the Dodge Tool. 

size if required and also use the bracket keys [ and ] to scale the brush. Set the brush Exposure to 10% or less. 
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DODGING AND BURNING

You can now begin to lighten specific parts of the portrait. 

13

With each individual stroke of the brush, those light areas 14

It will be a subjective thing depending on your preferences will be made lighter and lighter. Using an Exposure of 10% 

but areas that are currently the lightest can be made lighter to or less means that you can be a bit more subtle and build up the begin to increase contrast. Start brushing over areas like the lightening effect gradually rather than applying it all at once. 

forehead, cheeks and nose. 

Continue to build up the brightness with your brush strokes 15

If you press Alt and click the 'dodge' layer thumbnail, you 16

on the 'dodge' layer. Work around the stubble, hair and can see exactly what is happening on that layer. Any part of eyebrows to increase the brightness. If you feel you've applied the image that is lighter than 50% grey has its brightness added too many brush strokes in one area, you can always press Cmd + 

to the layer below because of the blending method used. Alt + 

Z to undo a number of steps and try again. 

click again to return to the normal view. 

Once an area of the layer is dodged to pure white, it cannot 17

If you compare the dodged version of the portrait to the 18

get any brighter. However, if you feel the effect still isn't original you can see how the brightness has been focussed strong enough, you can always duplicate the layer for a more on, making the face more three dimensional with the addition intense effect and adjust the layer opacity if required. 

of those brightened skin areas. If you are happy with the dodge effects so far, you can turn your attention to the 'burn' layer. 
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Click the 'burn' layer to make it active and swap from 19

Just as with the Dodge Tool, choose Midtones as the 20

the Dodge Tool to the Burn Tool by either pressing O 

Painting Mode by clicking on the Range button. Keep the until the Burn Tool is highlighted or click on its icon in the tool brush as a large soft one and Exposure at 10% or lower. 

options panel. 

Start to add brush strokes on the 'burn' layer to the darker 21

If you Alt and click the 'burn' layer, you can view that layer 22

areas of the photo. We started around the eyes and in isolation. Now, any dodged area that is darker than 50% 

darkened the sides of his forehead, under the nose and the sides grey is added to the layers below, darkening the portrait. Alt + 

of the cheeks. Again, apply the brush strokes singly and build up click again to return to the normal view. 

the darker areas until you have it as you want it. 

Because you are working on separate layers, you can 23

If it looks like the 'burn' layer effect is too strong, you can 24

return to the 'dodge' layer if you want, swap the Burn Tool always click on the layer Opacity slider and reduce that for the Dodge Tool again and continue to brighten areas of the layer's opacity to about 70%. we also duplicated the 'dodge' layer image to your taste. In the case of this image, we went back and and set the second layer to about 20% opacity bringing a little brightened the eyes themselves. 

extra contrast to the brightest areas. 
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The next few steps are optional and down to personal taste. 

25

We wanted to reduce the saturation of the image a little. 

26

Go to the layer options panel and click on the Create New When you add an adjustment  layer to the layer stack the Fill or Adjustment Layer button. Select Hue/Saturation from the properties panel for that layer will be displayed automatically. We menu that appears to set it as an adjustment layer above the used the Saturation slider to reduce saturation to about -35. 

layers already created. 

One additional tweak was to add a Levels adjustment and 27

A side by side comparison now shows how much the image 28

push the Highlights and Midtones sliders to the left; this has been transformed with the use of targeted brightening helped boost contrast a little more and highlighted all the work of midtones and also selective darkening of certain areas to already done with the Dodge and Burn Tools. 

increase the overall contrast of the image that wasn't present in the original. 

With that your Dodge and Burn project is completed. You 29

You can choose to flatten the image, by going to File > 30

have applied some very focussed brightness and contrast Save As (Shift + Cmd + S) to create a new file under a new adjustments to bring out more detail and create a more dramatic name, or save the document in its layered form as a Photoshop looking image. 

compatible PSD file. 
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TAKE YOUR SKILLS FURTHER

Using Selective 

Colour

BEFORE

AFTER

It is quite a popular photo editing technique to convert your images to black and white, but then to return part of the image to its original full  colour mode. This is done to create a small splash of colour in your photograph that is instantly picked out of its surroundings to draw the eye to that point of focus. It is a simple and fun way to enhance your black and white images and uses some simple, but important, image editing techniques that are always handy to brush up on. With one duplicate image, a quick mono conversion, a little bit of masking and the use of a selection tool, your image will transform. We show you how it’s done in this simple tutorial. 
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USING SELECTIVE COLOUR

First of all, you will need an original photo which has a nice 1

Because we always strive to work in a non-destructive 2

range of colours, or at least one strong colour you can pick manner, you will need to create a duplicate image by out. We have used a shot of a fantasy owl image with a snowy pressing Cmd + J and name it ‘mono’. This new duplicate layer blue background. We have a great display of colours that should will appear above your base photo, so that one is safe. Before we convert to black and white with no issue. 

move on, here is the alternative method for creating a new layer. 

Make sure your base layer, called 'Background' by default, is 3

Make sure the 'mono' layer is active and then go to Enhance 4

active and then move our mouse cursor over the layer and 

> Convert To Black And White. The Convert To Black And right-click it. A small menu will pop up. Choose Duplicate layer White panel will appear and you can choose from a number of from the list to create the new layer. A box will appear where you preset conversion methods, or you can use the Adjust Intensity can name your new layer 'mono'. Press OK to continue. 

sliders until you have a conversion that you like. 

We've completed our conversion to mono. We’ve brought 5

Make sure the ‘mono’ layer is active. It will be highlighted 6

out a lot of mid-tone detail and added some contrast to in blue just to confirm it is the selected layer. Now go to make the image quite punchy, but keeping a good range of tones. 

the toolbar and choose the Lasso Tool (L). We will be using this You now have the newly created black and white copy ‘mono’ as selection tool to draw out a couple of areas on the image that will your top layer and your colour original on the layer below. 

ultimately reappear in colour. 
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You can draw in a free form fashion using the Lasso Tool 7

Whatever your preferred selection method, select the main 8

as if you were drawing with a pencil. If you prefer, however, area of one of the owl’s eyes. Don't worry if you cannot you can use the Polygonal Lasso Tool instead which draws in a accurately select the eye, just get the main details selected. 

series of connected straight lines by clicking on the image on a When you have drawn around that area and joined up with the point-to-point basis. 

start of the selection, you will see the marching ants appear. 

Now we need to be able to add more selected areas. Go 9

Using your preferred method that you used to add the 10

to the Tool Options menu at the bottom of the screen and first eye, add the second eye to the selection. Again, choose Add To Selection. Your cursor will now have a small + 

when you join up the to the start of the newly selected area, symbol next to it, indicating it will now be able to add another marching ants will show you now have the second eye selected selection to the one you have already. 

as well as the first. 

Now we need to create a mask that hides the eyes of the 11

The main body of the mask needs to be white, with the 12

owl and keeps the rest of the mono layer visible. With the actual selection filled in black. You may notice it is the other 

‘mono’ layer active, go to the top of your layers palette and click way around. Just press Cmd + I to invert the colours of the mask. 

on the Add Layer Mask button. A layer mask will be added to the The mask on the ‘mono’ layer is allowing the orange eyes of the 

‘mono’ layer in the shape of your selection. 

coloured original to show through. 
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USING SELECTIVE COLOUR

Your mask should now be predominantly white. Just the 13

Don't worry if your mask is not very accurate. You can 14

two areas of the owl's eyes should be black. If you Alt + 

always use a small brush and alternate between black or left-click on the layer mask, you can view the mask in isolation. 

white to hide or reveal masked areas until the owl's eyes are the Press Alt + left-click on the mask thumbnail again to go back to only coloured area in the image. The rest of the image will be in your main view. 

black and white thanks to the mask you made. 

At this point you could call the process done. The 'mono' 

15

Choose Hue/Saturation from the list to add a layer at the 16

layer has been created with a mask allowing the orange top of the stack. Now if you move the Hue slider around, eyes to show through. If you wanted though, you can change the you can alter the colours of the layers below. Since the 'mono' 

colour of the eyes. Go to the top of the layers palette and click layer is black and white, it is unaffected, but the eyes on the base the Create New Fill Or Adjustment Layer button. 

layer should change until you have something you like. 
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TAKE YOUR SKILLS FURTHER

The Orton

Technique

BEFORE

AFTER

The Orton technique is named after its creator Michael Orton. He developed the technique back in the 80’s with slide film, sometimes referred to as an Orton slide sandwich. One shot was taken in perfect sharp focus and the other was completely out of focus to register only light, dark and colour. Back in the darkroom, when the slides had been processed, the idea was to sandwich one sharp image and one out of focus image, align them, and print both of these at the same time. Of course, these days, this can be done much more quickly and efficiently with digital files. Some professional landscape photographers use this technique in their work today. 

We will apply this technique to enhance a lovely landscape image. 
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THE ORTON TECHNIQUE

The first step is to choose a relevant image that will work 1

If you are using Elements Organiser to locate your preferred 2

well once the Orton effect has been applied. Scenes with image, once you have selected the one you want to use, leaves, water, grass and strong skies work particularly well. For you can right-click the thumbnail image and choose Edit With our example we have a waterfall image with golden leaves and Photoshop Elements Editor from the list that appears. This will fish swimming in the turquoise waters. 

open the chosen image in the photo editor. 

Start by right-clicking on the main 'Background' layer and 3

Make sure the new 'screen' layer is active. It will be 4

choosing Duplicate Layer from the menu that appears. The highlighted in blue to let you know it is active. Then you will Duplicate Layer dialog panel will open and you can name the need to click on the Layer Blend Mode button at the top of the new layer. In this case, name the duplicate 'screen'. Click OK to Layer Palette menu. Select Screen as your blend mode from the create the new duplicate. 

list that appears. 

The first thing you will notice is that the overall effect of the 5

Keep the 'screen' layer active and right-click that layer 6

blend has made the image very bright. The brightness of again. Choose Duplicate Layer from the list that appears the 'screen' layer is being added to the background layer. There once more and name this new duplicate 'multiply' in the dialog is no need to worry about this as the next steps will take care of panel. Click OK to proceed and the new layer will be added to the issue. 

the top of the layer stack. 
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Next, you will need to change the new 'multiply' layer's 7

Keep the 'multiply' layer active and then go to the Layer 8

blend mode to Multiply. The image will become very dark Options panel directly above the layers stack and click on as if it is underexposed. That’s OK though as we can remedy the the Create New Fill Or Adjustment Layer icon. From the list that issue. We will need to add an adjustment layer to modify the appears, choose Levels as your adjustment type. This can be overall image brightness. 

used to alter the image brightness problem. 

An adjustment layer appears above your three current 9

Click on the Create New Fill Or Adjustment Layer icon 10

layers. With the Levels Adjustment active, its Properties tab again and this time select Hue/Saturation from the list. A will open and you can lighten the image by pulling the middle Hue/Saturation adjustment layer will appear above your previous slider to the left. Adjust until it roughly matches the original 

'Levels 1' layer. We took this example to +50 Saturation and image’s brightness. 

altered Hue to -5 to increase reds in the image. 

As we mentioned in the introduction to this piece, the Orton 11

Click on your 'multiply' layer to activate it. Go to the top 12

effect is created by one sharp image and one out of focus menu bar and select Filer > Blur > Gaussian Blur. The image combined in such a way as to produce the dreamy look we Gaussian Blur dialog box will open and here you can set your blur are after. At this point all the layers contain sharp images, so we value by altering the Radius value. This value is governed by the need to remedy that now. 

resolution of your image. 
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THE ORTON TECHNIQUE

The first thing to note is that very large values do not work 13

Now we have our ‘Ortonized’ image and we could call it 14

well at all for this effect. At 300 pixels, the image looks finished. However, we can take this a stage further and quite muddy. In fact, even for an image the size of our example, use masking to bring some areas back into sharper focus again. 

only 15 pixels was enough to generate the soft, dreamy effect we Areas like the foreground trees either side of the image can have were after. 

the effect removed, to draw the eye. 

Click your topmost layer to activate it then press Shift + 

15

Click on the Add Layer Mask button at the top of the layers 16

Alt + Cmd + E to create a new layer that is the merged palette to add a mask to the ‘merged’ layer. Make sure the version of all current layers. Name the new layer ‘merged’. Turn 

‘merged’ layer mask thumbnail is active. Go to the toolbar and off visibility of all layers except your original ‘Background’, Hue/

choose the Brush Tool. Select a brush of about 400 pixels and Saturation layer and this new ‘merged’ layer. 

100% opacity. Make sure the brush colour is black. 

Apply the black brush to the ‘merged’ layer mask (not 17

If you Alt + left-click on the layer mask thumbnail, you’ll be 18

the image itself) over the foreground trees and roots. As able to see the results of your brushwork on the mask. Alt you brush, the dark areas of the mask lets more and more of 

+ left-click on the layer mask thumbnail again to return to normal the sharp ’Background’ layer show through. Continue to brush view. You can now save your Orton image as a PSD to complete foreground areas until you are happy. 

the process. 
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GLOSSARY

Glossary

For your reference, we have listed many of the terms you'll encounter as you become more experienced with photo editing. 

Active layer

Bit depth

of Contrast and only alters contrast 

DNG (Digital Negative)

The layer currently selected in the 

The number of colours used to 

within the middle tones of your 

An open standard file format 

Layers panel. 

represent a pixel in an image. A 

image. 

developed by Adobe Systems that 

1-bit image is black and white, an 

provides an alternative to proprietary 

Adjustment layer

8-bit image can have 256 colours 

Clipboard

camera raw files. 

A layer that lets you apply colour 

or shades of grey and a 16-bit 

The temporary holding area for 

and tonal adjustments to your 

image can have 65,536 colours. 

data stored with the Cut or Copy 

Dodging

image without permanently 

commands. 

The selective lightening of any part 

changing pixel values. Use 

Bitmap image

of an image. 

adjustment layers to experiment 

An image consisting of rows and 

Clipping

with colour and colour tones. You 

columns of pixels in computer 

The loss of either highlight 

Dots per inch (dpi)

can think of an adjustment layer as 

memory; also called a raster image. 

or shadow details when tone 

A measure of printer resolution. High 

a veil through which the underlying 

Bitmap file formats include BMP, 

information is forced to pure white 

dpi settings produce prints with fine 

layers are seen. 

GIF, JPEG, PSD, PICT and TIFF. 

or black. 

detail. Used for monitors too. 

Adobe Bridge

Bits per channel

Clone

Duotone

Bridge is a browser application 

Determines how many tones each 

To paint with the Clone Stamp tool. 

A two colour greyscale file that uses 

produced by Adobe Systems as 

colour channel can contain. 

You must set a sampling point on 

two custom inks. 




part of the Creative Suite and 

the active layer before you paint with 

is usually installed alongside 

Black Point

the Clone Stamp tool. 

EPS

Photoshop. Its main function is as 

In image editing, the black point 

Encapsulated PostScript. A file 

the file management hub of the 

is a tonal adjustment that sets the 

CMYK

format used to save images that 

Creative Suite. It can be used to 

point at which the deepest shadow 

Cyan, magenta, yellow and black 

will be used in illustration and page 

open, manage, rate and rename 

detail in the histogram is clipped 

are the inks most printers use to 

layout programs. 

files as well as edit their metadata. 

to black. 

produce colour images. Photoshop 

includes full support for CMYK 

EXIF

Adobe RGB

Blending mode

mode. 

Exchangeable Image File Format. 

The RGB colour space profile by 

A feature that controls how pixels 

A standard for simplifying the 

Adobe Systems, Incorporated. It 

in an image are affected by a 

Colour cast

exchange of data between cameras 

provides a large gamut of colours. 

painting or editing tool. The blend 

An unwanted or unexpected colour 

and software. The data may include 

colour is applied to the base colour 

shift in a photo. For example, a 

camera model, date and time the 

Aliasing

to produce a new colour, the result 

photo taken indoors without a 

photo was taken, camera settings, 

The jagged effect seen at the 

colour. When applied to layers, a 

camera flash may have too much 

shutter speed and so on. 

edges of diagonal lines, arcs and so 

blending mode determines how the 

yellow. 

on, caused by pixels lining up in a 

pixels in a layer blend with pixels in 

Exposure

sawtooth pattern. 

layers beneath it. 

Colour channels

A measure of the amount of 

The component colours from which 

light in which a photo was taken. 

Alpha channels

Brush preset

all colours in an image are created. 

Underexposed digital photos are too 

These are masks which let you 

A brush with preset settings 

Usually refers to red, green and blue 

dark, overexposed ones, too light. 

manipulate, isolate and protect 

for size, thickness and so on. 

(RGB). 

specific parts of your images. 

Photoshop includes several brush 

Feathering

presets for you to choose from and 

Colour depth

The softening of an edge of a 

Anti-aliasing

you can create a large number of 

Measures how much colour 

selection. 

The smoothing of jagged edges 

your own presets as well. 

information is available to display or 

in digital images by averaging the 

print each pixel in an image. Greater 

File Format

colours of the pixels at a boundary. 

Burning

colour depth means more available 

The structure of how information 

The selective darkening of part of 

colours and more accurate colour 

is encoded in a computer file. File 

Artefact

an image. 

representation in the digital image. 

formats are designed to store 

Any unexpected and undesired 

specific types of information, such as 

change to a digital image caused 

Camera raw format

Colour management

JPEG and TIFF for image or raster 

by incorrect settings or faulty 

A format describing data exactly as 

A system used to achieve consistent 

data, AI for vector data and PDF for 

processing. Examples include 

it is captured by a camera sensor, 

colour as an image travels from one 

document exchange. 

blooming, moire, sharpening and 

with no in-camera processing 

device to another; for example, from 

noise. 

applied. 

camera to computer or computer to 

Fill layer

printer. 

A type of layer that contains a solid 

Aspect ratio

Canvas

colour, a pattern or a gradient as an 

The ratio of an image’s width to its 

The workspace around an existing 

Colour temperature

interchangeable attribute. 

height. It is used to determine how 

image, within the image window. 

The degree of heat, in degrees 

an image fits on a page or monitor. 

Layer data may lie outside the 

Kelvin, that an object would have to 

Filters

canvas but it will be clipped to the 

absorb before it glowed in a certain 

Use filters to clean up or retouch 

Background layer

canvas when the image is flattened. 

colour. Each colour is associated 

your photos and apply special 

The bottommost layer in an image, 

You can change the size and colour 

with a colour temperature, as are 

art effects that give your image a 

usually containing the image data. 

of the canvas. 

various kinds of light. 

different appearance

The Background layer is always 

locked. If you want to change its 

Channel

Compression

Flattening

stacking order, blending mode or 

A term for describing the colour 

A technique that reduces the file size 

Merging of all visible layers into the 

opacity, you must first convert it to 

data in an image. A black and white 

of bitmap images. 

Background layer to reduce file size. 

a regular layer. 

greyscale image has one channel, 

an RGB image has three and a 

Cropping

Font

Backlight

CMYK image has four. Ordinarily, 

Trimming a portion of an image to 

A set of letters, numbers

Light coming from a source behind 

a channel describes either red, 

improve its composition or to create 

the photographed subject. 

green or blue, which are blended to 

a frame around it. 

Gamut

create all colours. 

The range of colour that a device 

Batch processing

Dithering

can reproduce. 

Performing one or more automated 

Clarity

The approximation of an unavailable 

tasks to a selected group of files at 

Found in Adobe Camera Raw. It 

colour through the use of two or 

Gaussian blur

the same time. 

behaves like an intelligent version 

more available colours. 

A softening effect applied through 
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a bell-shaped distribution of tones 

Layer mask

shapes and sampled images on 

from a vertical or horizontal axis. 

and colours. 

A protected area in an adjustment 

printed or displayed pages. 

Skewing can be a camera effect or 

layer. Areas below the mask cannot 

an intentionally applied effect. 

Gradient

be edited. 

Preset

Any of several methods for 

A preset is an action that can be 

Smoothing

achieving a smooth transition 

Levels

applied to an image or group of 

A technique for averaging the values 

between two adjacent colours, 

Functionality for adjusting colour 

images. You save a group of editing 

of neighbouring pixels to reduce 

which also include black and white. 

and tone. With a Levels adjustment, 

settings such as colour balance, 

contrast and create a soft, blurry 

you can set shadow and highlight 

brightness, contrast and saturation, 

effect. 

Greyscale

values to use a full tonal range, 

which can then be applied to your 

A single channel image that 

adjust middle tones only, correct 

selected photos. 

Split Toning

includes only black, white and 

colour casts, and so on. 

This option lets you alter the colour 

shades of grey. Depending on the 

PSD

of the shadow and highlight areas of 

bit depth, greyscale images can 

Locked layer

The native uncompressed file format 

your images. For example, you can 

reproduce a number of shades of 

A layer in the Layers panel that has 

of Adobe Photoshop and Photoshop 

add a blue colour cast to the darkest 

grey. 

the lock icon applied. No changes 

Elements, based on the TIFF 

areas of your photo but make the 

can be made to a locked layer. A 

standard. 

brightest areas of the same image 

Halftone

Background layer is always locked. 

more orange. 

A monochrome image made up of 

Quick mask

variably sized dots simulating the 

Megapixel

A mask channel created in Quick 

Stroke

shades of grey in a photograph. It is 

A term used to describe digital 

Mask mode in Photoshop

An outline round an image or part 

used for reproducing photographs 

camera resolution, 1 megapixel 

of an image, or the characteristics 

on PostScript printers and printing 

equals one million pixels. 

Raw Files

of the lines created with one of the 

presses. 

A Raw file is the unprocessed data 

painting or drawing tools, especially 

Midtone

captured by a digital camera sensor. 

brushes. 

HDR (High Dynamic Range)

An area that falls between the 

In most cases, cameras write Raw 

A process that combines multiple 

brightest highlight and the darkest 

files using a proprietary file format. 

Swatches

exposure variations of an image to 

shadow. 

Raw files give the photographer 

Preset colours that you can choose 

achieve a dynamic range exceeding 

the advantage of managing image 

from in the Colour Swatches panel. 

that of a single exposure. 

Moire

processing during post-production 

A wavy striped pattern in an image, 

rather than letting the camera make 

Thumbnail Image

Highlight and shadow

resembling the pattern of watered 

the processing decisions, as happens 

A small, low resolution image 

The lightest and darkest colours in 

silk. Moire can be an artefact caused 

when shooting in JPEG format. 

preview used on the web to link to a 

an image. 

by a camera’s inability to capture the 

high resolution version of the file. 

detail in an image. 

Red eye

Histogram

The reflection of the camera flash 

TIFF

A bar chart showing the 

Noise

from the retina of a photographed 

Tagged Image File Format. A digital 

distribution of the pixel values in a 

An artefact caused by interference 

subject, resulting in a red dot in the 

image format widely used for images 

digital image. The horizontal axis 

or camera error. Noise is often seen 

subject’s eye. You can eliminate 

that are to be printed or published. 

represents levels from 0 (darkest) 

as stray pixels of unexpected colour 

it automatically when you import 

TIFF images can be compressed 

to lightest (255) and the vertical 

or a generally “grainy” appearance. 

images or by using the Red Eye 

losslessly. 

axis represents the numbers of 

Certain compression techniques can 

Removal tool. 

pixels at each level. 

amplify noise. 

Transform

Resample

To scale, shrink, enlarge, skew, 

Hue

Opacity

To change the resolution of an image 

distort, rotate or change the 

The colour reflected from or 

The amount something blocks 

by changing its pixel dimensions. 

perspective of a layer, selection or 

transmitted through an object. 

light. You can change the opacity 

Downsampling decreases the 

shape. 

In common use, hue is the 

of layers, filters and effects so that 

number of pixels and upsampling 

property that allows a colour to be 

more (or less) of the underlying 

increases the number of pixels. 

Transparency

distinguished as red, blue, yellow 

image shows through. 

In digital photography, the 

and so on. 

Resolution

functionality that supports 

Overexposure

A measure of the clarity and 

transparent areas in an image or 

ICC

An overexposed image results from 

sharpness of an image. In digital 

image layer. Certain image formats 

International Colour Consortium. 

too much light being allowed to fall 

images, it is measured in pixels per 

do not support transparency. 

ICC device profiles are the industry 

onto the camera sensor. 

inch. 

standard for reproducing colours 

Underexposure

accurately across devices such as 

Panorama

RGB

An underexposed image results from 

scanners, monitors and printers. 

A broad view of a subject, usually 

A model for representing colours on 

too little light being allowed to fall 

a landscape, made by overlapping 

a computer display. Red, green, and 

onto the camera sensor. 

Image cache

individual shots as they are taken 

blue (RGB) are combined in different 

A section of hard disk space used 

and then merging them to form one 

proportions to represent any colour. 

Unsharp mask

as virtual memory. The image cache 

wide image. 

A technique that sharpens details in 

speeds the on-screen redraw of 

Rule of Thirds

an image by increasing the contrast 

high-resolution images. 

Perspective

If you divide an image into three 

between light and dark areas. The 

The angle or level from which a 

equal sections both vertically and 

name originates from traditional 

Image mode

photograph is taken, the camera-eye 

horizontally, where the lines intersect 

photography, where contrast is 

The colour mode of an image, such 

view. 

is commonly regarded as good 

increased by adding a slightly 

as Greyscale or RGB. 

placement for the subjects in your 

blurred negative over the original. 

Pixel

photos. 

Indexed colour

The basic, rectangular unit of data 

Vibrance

A colour that is rendered by using a 

that a digital image consists of. 

Sample

Vibrance is a form of intelligent 

pixel value as an index to a panel of 

The edges of pixels can produce a 

To select a colour with the 

Saturation. As you increase the 

256 or fewer colours. 

sawtooth pattern unless anti-aliasing 

eyedropper in order to use it with a 

Vibrance in an image, only the 

is used. 

drawing or painting tool. 

middle tones of your image are 

JPEG

altered first. 

Joint Photographic Experts 

Pixel dimensions

Saturation

Group. A committee of experts 

The number of pixels along the 

The purity, or strength, of a colour. 

Vignetting

that develop algorithms for 

width and height of an image. This is 

A fully saturated colour contains no 

An effect where the edges of an 

compressing computer image files. 

a measure of the amount of image 

grey at all. 

image fade out. 

Can be any graphic file to which a 

data in the photo, not its physical 

JPEG algorithm is applied. JPEG is 

size when printed or displayed on a 

Selection

Warping

the format generally used to share 

monitor. 

A part of an image selected for 

A distortion of an image, often text, 

photographs over the web. 

manipulation of any kind, duplication 

to conform to a variety of shapes. 

Pixels per inch (ppi)

in a layer, colour correction, deletion, 

For instance, a line of text can be 

JPEG compression

A measure of image resolution 

rotation and so on. 

warped in the shape of an arc or 

A lossy compression technique that 

stored in a camera or computer 

wave. 

reduces image data and file size. 

file. High ppi settings produce 

Shadow Detail

photographs with fine detail and 

Refers to the amount of detail that 

White balance

Layer

large file size. 

can be seen in the darkest areas of a 

A function that compensates for 

A mechanism for overlaying and 

photograph. 

the different rendering of identical 

combining multiple images. Layers 

Plug-in

colours under different sources of 

are like transparent sheets of glass 

A software application or module 

Sharpening

light: incandescent, fluorescent, 

that you can stack and rearrange. 

that provides extended and specific 

In photo-editing programs, any 

sunlight and so on. 

In addition to ordinary image layers, 

functionality from within a larger 

functionality that enhances the 

there are special kinds of layers. 

host application. 

details at the edges of photographed 

White point

objects and people. 

A reference point used to represent 

Layer group

PostScript

white. This reference point is used 

A collection of layers saved with a 

A language by Adobe that describes 

Skewing

to calculate all other colours in the 

Photoshop image. 

the appearance of text, graphic 

Deviation of the content of an image 

image. 
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